
Network Computing Devices, Inc.

Network Computer User Manual
Version 3.2

May 1999

Printed in USA

Network Computing Devices, Inc.
350 North Bernardo Avenue
Mountain View, CA 94043 USA

1-800-800-9599 (USA and Canada)
1-503-641-2200

http://www.ncd.com

http://www.ncd.com




Certifications  – UL 1950, CAN/CSA C22.2 No. 950, IEC 950, FCC Class A, EN55022 (class A), EN50082-1,
EN60950, C-Tick, VCCI, MPR II (monitors only), CE, Energy Star Compliant (both monitor and logic unit).

Copyright  1999 Network Computing Devices, Inc., 350 North Bernardo Avenue, Mountain View, California  94043.

Copyright  1990, 1992, 1993, 1994, 1995, 1996 Tektronix, Inc. Wilsonville, Oregon.

Printed in the United States of America or the United Kingdom. All rights reserved. This document may not be copied
in whole or in part, or otherwise reproduced except as specifically permitted under U.S. copyright law, without the
prior written consent of Network Computing Devices, Inc., 350 North Bernardo Avenue, Mountain View, CA 94043
USA.

WinDD and NCBridge are trademarks of Network Computing Devices, Inc.

TEKTRONIX, TEK, UTek, Profile, TekColor, Serial Xpress, SXp, and ErgoCable are trademarks or registered
trademarks of Tektronix, Inc.

Portions of the network computer source code are copyrighted  1989 by Sun Microsystems, Inc. Sun design patents
pending in the U.S. and foreign countries. OPEN LOOK is a trademark of AT&T. Used by written permission of the
owners.

Portions of this NCBridge software  1984-95 Adobe Systems Incorporated. All rights reserved.

Some fonts are copyrighted  1986, 1985 by Bigelow & Holmes. Lucida is a registered trademark of Bigelow &
Holmes.

Ethernet is a trademark of Xerox Corporation; UNIX is a registered trademark of AT&T; DEC, DECnet, DECwindows,
ULTRIX, SCAMP, VMS, and VT are trademarks of Digital Equipment Corporation; SPARCstation is a registered
trademark of SPARC International, licensed exclusively to Sun Microsystems, Inc.; Sun Microsystems, SunOS, NFS,
Sun, Sun-3, Sun-4, and OpenWindows are trademarks of Sun Microsystems, Inc.; OSF, OSF/Motif, and Motif are
trademarks of Open Software Foundation, Inc.; X and X Window System are trademarks of the Massachusetts
Institute of Technology. Hewlett-Packard, HP, and vue are trademarks of the Hewlett-Packard company. IBM and
SMIT are trademarks of International Business Machines. Silicon Graphics and IRIS are registered trademarks and
IRIX is a trademark of Silicon Graphics, Inc. OpenConnect is a registered trademark of OpenConnect Systems, Inc.
Other trade names used in this document are trademarks or registered trademarks of the manufacturers or vendors
of the associated products.

Microsoft, Windows NT and Windows95 are registered trademarks of the Microsoft Corporation.

Adobe, Acrobat, Display PostScript, and ShowPS are trademarks of Adobe Systems Incorporated which may be
registered in certain jurisdictions.





Manual Revision Status 
Network Computer Users

Rev Date Description

July 1997 Original Issue.

February 1999 Document new features of NCBridge 3.2.
Network Computer Reference



Revision Status
Network Computer Reference



Contents 
Preface
Typographical Conventions ............................................................................................. v

Network Computer Package................................................................................................... vii
Related Documentation ................................................................................................. viii

Chapter 1 A New Piece of Hardware
What is a Business Network Computer? ...................................................................... 1-1
Why Use a Network Computer ..................................................................................... 1-3
How Do You Use a Network Computer ........................................................................ 1-4
Terminology .................................................................................................................. 1-5

Chapter 2 Operating the Network Computer
Powering on the Network Computer............................................................................. 2-1
The Network Computer Boot Process .......................................................................... 2-2
Logging in to the Network Computer ............................................................................ 2-3

Logging in from the Root Weave ...........................................................................................2-4
Logging in with Client Launcher ............................................................................................2-5
Logging in with TekHostMenu ...............................................................................................2-6
Logging in at a Login Prompt.................................................................................................2-9
Logging in with Telnet..........................................................................................................2-11
Closing a Telnet Window.....................................................................................................2-12
Logging in with Cterm..........................................................................................................2-13
Closing a Cterm Window .....................................................................................................2-14
Logging in with WinDD ICA Client .......................................................................................2-15
Closing a WinDD Session ...................................................................................................2-18
Logging in with Serial Port 0 or 1.........................................................................................2-19
Closing a Serial Port Window ..............................................................................................2-19
Logging in with LAT .............................................................................................................2-22
Closing a LAT Window ........................................................................................................2-23

Local browser support ................................................................................................ 2-24
Version 3.0 ..........................................................................................................................2-24
Version 4.0 ..........................................................................................................................2-24

Local browser kiosk support ....................................................................................... 2-25
New browser-related features .............................................................................................2-25
Starting Navio NC Navigator ...............................................................................................2-26
Configuring the browser for kiosks ......................................................................................2-27
Flashing the Navio browser into ROM.................................................................................2-32
Browser kiosk examples ......................................................................................................2-36
i



Contents

ii
Chapter 3 Using the Network Computer
X Window Software Components .................................................................................3-2

Getting Unstuck.....................................................................................................................3-3
Window Managers ........................................................................................................3-4

Determining if a Window Manager is Running ......................................................................3-4
Starting a Window Manager .................................................................................................. 3-5
Using a Window Manager .....................................................................................................3-5

Starting Sessions ........................................................................................................3-12
Running Clients...........................................................................................................3-13
Locking the Display .....................................................................................................3-14

Chapter 4 Using Advanced Features
Audio Player..................................................................................................................4-2

Starting the Audio Player ...................................................................................................... 4-3
Starting the Audio Player from the Remote Configuration File.............................................. 4-4
Starting the Audio Player with xpsh ...................................................................................... 4-4
Property command interface .................................................................................................4-6
Opening or Creating an Audio File ........................................................................................ 4-8
Using TFTP Access .............................................................................................................. 4-9
Using NFS Access ..............................................................................................................4-11
Using DAP Access ..............................................................................................................4-14
Connecting External Audio Devices .................................................................................... 4-17
Audio Accessory Specifications ..........................................................................................4-18
Recording an Audio File ......................................................................................................4-19
Playing an Audio File .......................................................................................................... 4-21
Audio File Information ......................................................................................................... 4-22
Closing the Audio Player .....................................................................................................4-22

The Audio Mixer ..........................................................................................................4-23
Starting the Audio Mixer ......................................................................................................4-23
Using the Audio Mixer .........................................................................................................4-24
Saving the Audio Mixer Level Settings................................................................................4-25
Closing the Audio Mixer ......................................................................................................4-25

Digital Video Player.....................................................................................................4-26
Starting the Video Player .................................................................................................... 4-27
Opening a Video File...........................................................................................................4-30
Using TFTP Access ............................................................................................................4-31
Using NFS Access ..............................................................................................................4-32
Using DAP Access ..............................................................................................................4-34
Playing a Video File ............................................................................................................4-36
Fast Forwarding and Rewinding ......................................................................................... 4-37
Multicast ..............................................................................................................................4-38
Closing the Video Player .....................................................................................................4-41



Contents
Analog Video Player ................................................................................................... 4-42
Starting the Analog Video Player.........................................................................................4-44
Connecting The Network Computer to an Analog Video Device .........................................4-45
Using the Analog Video Player ............................................................................................4-46
Closing the Analog Video Player .........................................................................................4-49

The XIE Viewer........................................................................................................... 4-50
Starting the XIE Viewer .......................................................................................................4-51
Opening and Displaying an Image File................................................................................4-53
Using TFTP Access .............................................................................................................4-54
Using NFS Access...............................................................................................................4-56
Using DAP Access ..............................................................................................................4-58
Viewing Options...................................................................................................................4-60
Closing the XIE Viewer ........................................................................................................4-60

WinDD ICA Client ....................................................................................................... 4-61
Starting Local WinDD ICA Client .........................................................................................4-61
xp.cnf compression commands ...........................................................................................4-65
Configuring your WinDD ICA Session from the Client Screen ............................................4-65

PSXpress.................................................................................................................... 4-69
Changing Execution Paths ..................................................................................................4-69
Integrating Icons into an OpenWindows Desktop................................................................4-69
Using Display PostScript NX with Sun AnswerBook ...........................................................4-70
X Resources and Application Defaults ................................................................................4-70
PostScript Resources ..........................................................................................................4-70
Launching Applications........................................................................................................4-71
Locating Acrobat Reader Preferences File..........................................................................4-72
Printing Documents with Acrobat Reader............................................................................4-74
Converting PDF Files to PostScript Files with Acrobat Reader ...........................................4-74
Using Display PostScript NX with Other Applications..........................................................4-75
Location of Documentation ..................................................................................................4-75

Font Caching .............................................................................................................. 4-76
Printing Color Hardcopies........................................................................................... 4-77

Printing from MWM..............................................................................................................4-77
Printing from the Command Line .........................................................................................4-78

Flash Control Console ................................................................................................ 4-79
Before Using the FCC ................................................................................................ 4-80
Starting the FCC......................................................................................................... 4-80

The File Bar .........................................................................................................................4-81
The Menu Bar......................................................................................................................4-82
The Menu Input Area...........................................................................................................4-82
The Message Box................................................................................................................4-84

The Flash Screen ....................................................................................................... 4-85
After Doing an Analysis .......................................................................................................4-86

TekLogin Local Client ................................................................................................. 4-87
iii



Contents

iv
Starting TekLogin ........................................................................................................4-87
xp.cnf commands for TekLogin ........................................................................................... 4-88
Configuring TekLogin settings............................................................................................. 4-89
Security between TekLogin and Setup ............................................................................... 4-90

PPP Support ...............................................................................................................4-91
Before you begin .................................................................................................................4-91
Configuring the network computer’s serial port ................................................................... 4-91
Configuring the network computer’s session/PPP settings ................................................. 4-95
Session identification ..........................................................................................................4-96
Session authentication ........................................................................................................4-96
Session connection ............................................................................................................. 4-98
Configuring the xp.cnf file for PPP .................................................................................... 4-100
Final network computer configuration considerations ....................................................... 4-101

PPP connections.......................................................................................................4-103
Connecting via TekLogin................................................................................................... 4-103
Connecting via Setup ........................................................................................................4-103
Connecting via xpsh..........................................................................................................4-106
Connecting via the xp.cnf file ............................................................................................ 4-106
Terminating PPP ...............................................................................................................4-106

Screen Saver Support...............................................................................................4-107
Starting the screen saver with the xp.cnf file..................................................................... 4-107

16-bit True Color Support (NC400 and NC200)........................................................4-109
Web-based Administrator..........................................................................................4-110

Implementation..................................................................................................................4-110

Chapter 5 Troubleshooting
Solving Power Problems ...............................................................................................5-1
Solving Boot Problems..................................................................................................5-1
Solving Log in Problems ...............................................................................................5-2
The Console Window ....................................................................................................5-3

Opening the Console Window............................................................................................... 5-3
Using the Console Window ...................................................................................................5-4
Closing the Console Window ................................................................................................ 5-4

Appendix A Special Keyboard Characters
Keyboard Charts .......................................................................................................... A-2
Entering North American Special Characters from International Keyboards ............... A-8

Eurokey Support .................................................................................................................A-20
Compose and Diacritical Sequences ......................................................................... A-20

Using the Diacritical Keys ...................................................................................................A-23
Using the Compose Key .....................................................................................................A-26

Glossary

Index



Preface
ar 
fic 

e, 

is 

y.

ay.

r.

ter.
Typographical Conventions
This manual uses the following typographical conventions:
• This symbol indicates additional or background information for the particul

section. For example, the symbol is used in Chapter 2 to refer to the speci
commands that were set by your system administrator.

• This symbol indicates a Launcher Menu selection. Depending on how your 
account is set up, the Launcher may already be on your screen. If that is the cas
simply use the mouse to select an option. If the Launcher is not present, press 
the Setup key or key sequence for your keyboard.

Table 1 Setup Key and Key Sequences.

Figure 2 on the next page illustrates the typographical conventions used in th
manual.

The following terminology is used to describe mouse operations.

Pointing:Using the mouse to position the pointer on an object on the displa

Moving:Using the mouse to change the location of the pointer on the displ

Clicking:Pressing and releasing a mouse button without moving the pointe

Dragging:Pressing and holding down a mouse button while moving the poin

Releasing:Releasing the mouse button to complete a dragging action.

Keyboard Type Press

101/102 with Setup Setup key

101/102 with Pause SHIFT-Pause

Sun keyboard ALT-GRAPH-HELP or ALT-GRAPH-SETUP

Windows 95 SHIFT-PAUSE

3270 keyboard Right ALT-ExSel (The left ALT key does not work)

LK401 F3 key

UNIX keyboard Alt-Graph-HELP

Launcher
v
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Figure 2 Typographical Conventions.
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Network Computer Package

This manual assumes you have installed your network computer according t
included pictorial instructions. Your network computer has the following 
components:
• The monitor is the screen where text and graphical information is displayed for 

viewing. You can position the monitor to a comfortable viewing angle by tilti
and turning the monitor on its base. You can adjust the brightness and con
controls according to your preference. The controls are typically located on the 
front or side of the monitor.

• The logic board is the controller inside your network computer that handles 
input and output communications and local processing. Depending on the
model of your network computer, the logic board is either located in a sepa
logic module (connected to your monitor with a special cable) or integrated i
the base of your network computer monitor.

• The keyboard is used as the primary method for entering alphanumeric dat
You can open the folding legs on the back of the keyboard to adjust the 
keyboard angle. There are several different keyboards available, in many
different languages.

• The mouse is a device used to position a pointer appearing on the display 
order to access or select information. It is used as the primary method to m
about in a window manager or X window application, access menus, and s
options. Information on using the mouse and the mouse buttons is in the n
section of this chapter. Trackballs, touchscreens, and tablets can also be u
pointing devices. Contact your system administrator for more information 
these devices.

• The communication port is a connector on the back of the cabinet housing yo
network computer logic board. You connect your existing network cable to 
connector. A network cable must be set up for you by your system admini
tor. This cable must be attached to your network computer in order to run

• The network computer software is the network computer operating system an
support files that your system administrator must load and configure on a 
computer so your network computer can start up. If your network compute
an optional ROM-based unit, the software may not be necessary.
The software is shipped on one or more CD-ROMs or magnetic tapes. The 
or tapes, a Network Computer Installation manual and the documentation 
CD-ROM with various manuals, including the Network Computer Reference 
manual, are shipped with the software in a separate package from the net
computer.
vii
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Related Documentation
The following manuals are included in the Documentation CD-ROM:
• Network Computer Reference

Provides detailed reference information about network computers. 
• 3270/3179G User

Provides operating information for the 3270/3179G terminal emulators.
• 3270E/5250 User 

Provides operating information for the 3270E/5250 terminal emulators.

The following manuals are available in paper:
• Network Computer Installation for UNIX — 9300845
• Network Computer Installation for VMS — 9300846
• Network Computer Installation for Windows NT — 9300847

Explains how to install a network computer in the specified environment.
• Serial Xpress User — 9300834

Provides information about Serial Xpress for using serial connections.

The following documentation is available from Prentice Hall:
• OSF/Motif User’s Guide ISBN 0-13-640509-6

Presents Motif fundamentals.
i
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A New Piece of Hardware

A box labeled network computer has been delivered to your desk. Maybe it is a 
replacement for your current personal computer, text-only (ASCII) terminal, or 
workstation. Or, maybe it is to be used with a new system or application. Eithe
way, what is a network computer, and how is this new piece of hardware goin
to make your job easier than the piece of hardware you already have?

What is a Business Network Computer?
The broad definition of a network computer is an internet-capable device tha
supports the following features and formats:

• Minimum screen resolution of 640x480

• Pointing device (such as a mouse)

• Text input, audio output

• TCP/IP, FTP, NFS, UDP, Telnet

• SMTP, IMAP4, POP3 (e-mail protocols)

• JPEG, GIF, WAV, AU (multimedia file formats)

• Bootp

• HTML, HTTP (web protocols)

• Java application access

This definition includes everything from internet appliances, such as set-top 
boxes that provide Internet access to your television, to powerful PC servers th
meet these requirements. Obviously, not every device that meets these 
minimum requirements will be useful in a business environment.
Network Computer User 1-1
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A network computer is a device-independent, network-transparent, 
multi-tasking device connected to a host computer in a distributed computing
environment. If that makes sense, skip to Chapter 2, Operating the Network 
Computer. Otherwise, please read this chapter to better understand what a 
network computer is and how it works when you consider the components us
in the definition.

• Distributed computing allows you, from a single network computer, to take 
advantage of all the resources available on multiple host computers. For 
example, from your network computer you can access multiple hosts at th
same time, perhaps to run a spreadsheet from one computer, create a 
document on a second, and receive mail from a third. A 
distributed-computing environment is composed of host computers joined
together by a network. Figure 1-1 shows a typical distributed-computing 
environment.

Figure 1-1 Typical Distributed-Computing Environment
Network Computer User
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• Device-independent means that your network computer can open a session
on any host computer accessible to you, regardless of the computer’s 
operating system. With your network computer, you can even have 
simultaneous sessions running on totally different operating systems.

• Network-transparent means that your network computer can log in and run
applications (called clients) on one or more host computers over the network 
just as if it were running locally on the computer itself. This requires a single
network connection cable, not one direct cable for each host you need to 
access.

• Multi-tasking means that a client you start up in one window continues to run
(in its window) even while you are using a different window. Also, a window
can receive output even if it is completely hidden from view. Each window
essentially functions like an individual terminal or personal computer. For 
you, the advantage is that you can have many different windows all on you
network computer display.

Why Use a Network Computer
To better understand your network computer’s capabilities and advantages, 
consider something possibly more familiar, such as a personal computer (PC

• The display, keyboard, and mouse serve the same function on your netwo
computer as they do on a PC.

• Both devices require software in order to boot up and run applications. Here 
are some differences:

– PC software is loaded onto a (local) disk right in the PC cabinet.

– Network computer software is loaded onto a (remote) disk on a central 
computer. 

The network computer advantage is that there is probably far more disk
space available to the central computer than to a PC. Also, there is 
typically a support staff to load software and perform back ups on a centr
system.

– PC software is typically licensed for a single user on a single PC.

– X applications run on a network and are licensed for multiple users.

Sharing software across the network is usually more cost effective than
buying and maintaining separate copies for each user.
Network Computer User 1-3
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• Both devices require logic boards and storage devices (disks) to handle 
information.

– For a PC, the boards and disk drives are within the cabinet. You can on
add a limited number of peripheral devices such as extra disks, printers
or modems.

– For your network computer, some of the boards are inside the logic 
module, but your network computer takes advantage of the main 
computing boards, disk drives, and peripherals located on one or more
remote computers.

This is one of the key advantages of a distributed-computing environmen
Computing power, storage, and access to peripheral devices like printe
can be shared to maximize their use, and provide users with more 
flexibility. It is also far easier to share information with other users.

How Do You Use a Network Computer
1. Unpack your network computer according to the pictorial instructions on th

network computer shipping box.

2. Connect the keyboard, mouse, cords, and cables as shown in the pictoria
physical installation guide included in the network computer box.

3. Verify with your system administrator that the software to support your 
network computer has been installed on a computer. Ask your administrato
if you need specific booting information.

4. Power on your network computer and log in.Chapter 2, Operating the 
Network Computer details these topics.

5. Run your applications. Chapter 3, Using the Network Computer describes 
what to do to get started.
Network Computer User
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Terminology
Like most new things, there are words and procedures that may need 
clarification. Before you continue, you may want to familiarize yourself with 
the terminology used throughout this manual. A more complete list of terms i
listed in the Glossary of this book.

Button (on the display) A small display box within the borders of a window, 
or inside a dialog box. Generally, clicking on a button 
activates a function or performs some action.

Button (on the mouse) The three buttons on the top of the mouse. Table 1-
shows the factory configuration of the buttons.

Table 1-1 Mouse Button Configuration.

Clicking Quickly pressing and releasing the Select mouse button 
without moving the pointer.

Dialog Box A box where you choose options and enter information. Use
the mouse to move from field to field, click on buttons and 
position the text cursor. Enter information with the 
keyboard.

Dragging Pressing and holding the Select mouse button while moving
the pointer.

Moving Changing the location of the pointer on the screen by moving 
the mouse.

Pointer An arrow on the screen indicating the current cursor position 
for selecting or clicking.

Pointing Positioning the pointer (such as the "x" or "↑" symbol 
appearing on the screen) on an object on the display by 
moving the mouse.

Button Name In Manual 3-button Mouse Selection

Select Left button

Menu Middle button

Custom Right button
Network Computer User 1-5
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Operating the Network Computer

Powering on the Network Computer
The first step is to power on your network computer. For network computer 
models with a separate logic module, power on both the display and the logi
module. Figure 2-1 illustrates the location of the power switches on various 
models.

Figure 2-1 Power Switch Locations for Different Components

If the network computer does not power on, refer to Chapter 5, Solving Power 
Problems for troubleshooting information.

8049-117

Power Switch

Power Switch

Monitors

Logic Modules
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The Network Computer Boot Process
When your network computer is powered on, it automatically begins booting. 
Booting means your network computer is locating and reading its start up files
The boot screen (Figure 2-2) appears on your display as the network computer 
is booting.

Figure 2-2 Network Computer Boot Screen

During a normal boot, the network computer successfully locates and begins
read the boot files and the Percent of File Loaded slide bar appears on the boot 
screen. During a boot, pressing any key on the keyboard halts the boot proces
Do not halt the boot unless directed by your system administrator.

If the slide bar does not appear, or, if your network computer displays a BOOT> 
prompt, the boot has halted. To try the boot again, type b and press Enter.

If the boot fails again, call your system administrator or refer to Chapter 5, 
Solving Power Problems for more information. To help troubleshoot the boot 
problem, write down any messages that were displayed.

[ ] 100%0%Percent of File Loaded:

Boot Monitor V7.8 

Attempting to boot with TFTP...

Requesting file ´/tftpboot/tekxp/boot/os.500´ from IP host 128.07.60.01

IADDR=
IHOST=
IMASK=
IGATE=
BPATH=

128.07.60.30
128.07.60.01
255.255.255.0
128.07.60.100
/tftpboot/XP330/os

DNODE=
BMETHOD=
BDELAY=
BAFROM=

22.10
TFTP
DISABLED
NVRAM

Ethernet     08:00:11:01:00:45 

8049-135

6144 Kbytes memory installed
Network Computer User
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Your network computer is attempting to boot from the network or from an 
optional Flash memory or ROM board (read only memory). You can tell how
your network computer is trying to boot by looking at the Boot Method  
(BMETHOD=) status line on the boot screen. Possible values are ROM, TFTP
NFS, or MOP.

Logging in to the Network Computer
The next step depends on the way your system administrator sets up the 
network computer software on the host computer. Each login method is 
illustrated and described in the following sections to help you identify your 
login method.

After your network computer completes the boot process, one of these shou
appear on your monitor:

• Gray pattern (called the root weave) with an X cursor (page 2-4)

• Client Launcher (page 2-5)

• TekHostMenu (page 2-6)

• Login window prompt (page 2-9)

• Telnet window (page 2-11)

• Cterm window (page 2-13)

• WinDD (page 2-15)

• Serial Port Window (page 2-19)

• LAT Window (page 2-22)

If you cannot log in, refer to Chapter 5, Solving Power Problems for 
troubleshooting information.

The login method is determined by the Host Connect Method  command. 
This command is set by the system administrator in the remote configuration
file or through Setup  on the network computer.
Network Computer User 2-3
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Logging in from the Root Weave

The root weave is a gray, patterned screen available on all network computers. 
When the network computer is ready for input, an X-shaped cursor appears 
the screen. A network computer with the root weave and cursor is illustrated 
Figure 2-3.

Figure 2-3 Root Weave with X Cursor

To log in from the root weave, you need to manually start the Client Launche

Press Setup to bring up Client Launcher. Refer to Logging in with Client 
Launcher on page 2-5.

✖

Launcher
Network Computer User
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Logging in with Client Launcher

Client Launcher starts the local client you select from a menu. An arrow to the 
right of an entry indicates a submenu. In Figure 2-4, selecting Host Connectio
displays a sub-menu listing available host connections, such as Telnet or Cterm. 

Your system administrator configures the Client Launcher to include the local 
clients you use most often. The Client Launcher on your network computer may 
list different clients and submenus than those that appear in Figure 2-4.

Figure 2-4 Client Launcher menu

Use one of these methods to start a client from the Client Launcher:

• Position the pointer on the client name and click the Select mouse button. 

• Position the pointer on the option to display the sub-menu. Position the 
pointer on the client name and click the Select mouse button.

If using Client Launcher to open a host connection, see the applicable section

• Logging in with TekHostMenu on page 2-6

• Logging in with Telnet on page 2-11

• Logging in with Cterm on page 2-13

• Logging in with WinDD ICA Client on page 2-15

• Logging in with LAT on page 2-22

The Client Launcher appears automatically if it is specified in the remote 
configuration file. The applicable command is start  (set to LAUNCHER).
Network Computer User 2-5
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Logging in with TekHostMenu

TekHostMenu is a window showing a list of host computer names and network
addresses. A sample TekHostMenu is illustrated in Figure 2-5.

Notice the list buttons across the top (for example, XDMCP and VMS TDEnet)
These buttons determine which type of log in list is displayed. The button 
pressed in indicates which list is currently displayed.

If there are more host names than can fit on one screen, use the mouse to sc
through the host names. If your host does not appear on the list, try clicking o
the Update button or click on one of the list choice buttons to display a different 
list. If it still does not appear, contact your system administrator.

Figure 2-5 Example TekHostMenu
Network Computer User
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To log in with TekHostMenu using either the mouse or the keyboard:

• Using the mouse, position the pointer on a host computer where you have a 
login account. If your host is not displayed, try the Update button or look for 
your host on one of the other lists (change lists by clicking one of the list 
buttons across the top).

• Click the Select button (left mouse button) to connect to the host

• Using the keyboard, enter the host’s name or address in the Host text box a
press Enter. If connecting to a LAT host, enter the Node’s name or addres
in the Node Name text box, and the Service name in the Service Name te
box. Use the keys listed in Table 3-1 to edit and move around the 
TekHostMenu.

Table 2-1 Keyboard interface for TekHostMenu

After selecting a log in host, some type of screen with a Login: prompt is 
displayed. If you selected the wrong host, press Ctrl–c to close the login box
without logging in to the specified host.

• At the Login:  prompt, type your user name and press Enter

• At the Password:  prompt, type your user password and press Enter

To: Press:

Clear the contents of a text box Control–u keys

Move among the text boxes Tab key

Move to the first host in the list of 
hosts

Home key

Move to the last host in the list of hosts End key

Move to a specific host in the list of 
hosts

The first few letters of the hostname, 
or if using LAT, the first few letters 
of the service name

Page up and down through the list of 
hosts

PgUp and PgDn keys
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For more information, see the applicable section:

• Logging in at a Login Prompt on page 2-9

• Logging in with Telnet on page 2-11

• Logging in with Cterm on page 2-13

• Logging in with WinDD ICA Client on page 2-15

• Logging in with Serial Port 0 or 1 on page 2-19

• Logging in with LAT on page 2-22

Continue with Chapter 3, Using the Network Computer.

TekHostMenu appears automatically if it is set up as the connection method 
through the remote configuration file or through Setup. The applicable 
commands are: Host Connect Method (set to TekHostMenu) and Default Host 
List which determines the list that is initially displayed.
Network Computer User



 

Logging in at a Login Prompt

If your system administrator has set up your network computer to directly log
in to a specific host, some type of welcome screen with a login prompt is 
displayed. A welcome screen is also displayed for programs like TekHostMenu 
after a connection is made. Sample login screens for the UNIX host oregon and 
the VMS host IDAHO are illustrated in Figure 2-6 and Figure 2-7.

Figure 2-6 Example UNIX Login Screen

Figure 2-7 Example VMS Login Screen

Welcome to oregon

Login:

Password:

Start Session on IDAHO

Username

ClearOK

Password
Network Computer User 2-9
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To log in:

• At the Login:  or Username:  prompt, type your user name and press 
Enter

• At the Password:  prompt, type your user password and press Enter

Continue with Chapter 3, Using the Network Computer.

Direct connections are specified by your system administrator through the 
remote configuration file or through Setup. The applicable commands for 
UNIX systems are: Host Connect Method (XDMCP Direct), and XDMCP 
Server (set to your host). The applicable commands for VMS systems are: Host 
Connect Method (set to VMS), VMS Autologin Transport (set to TDEnet), and 
VMS Autologin Tdenet Host (set to your host).
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Logging in with Telnet

There are two ways to log in through Telnet, depending on whether your syste
administrator specified a default Telnet host for your network computer. If you
network computer displays a Telnet>  prompt like Figure 2-8, a default host 
has not been specified. In this case, you must open a connection before you 
log in to the host.

Figure 2-8 Telnet Window Waiting for an Open Command

To open a connection to your host computer:

• Use the mouse to position the pointer in the Telnet window. You can type h 
and press Enter to see a list of Telnet commands.

• Type:

Telnet> open hostname

where hostname is the name or network address of the host.

Figure 2-9 Telnet Open Command

Telnet>

Telnet> open oregon
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Once a connection is made (Figure 2-10), either automatically or with the ope
command, you can log in:

• Type your user name at the login:  prompt and press Enter

• Type your password at the password: prompt and press Enter

Figure 2-10 Telnet Window With a Host Connection

Continue with Chapter 3, Using the Network Computer.

Telnet connection and default Telnet host are specified by the system 
administrator through the remote configuration file or through Setup. The 
applicable commands are: Host Connect Method (set to Telnet), and Default 
Telnet Host (set to your host name or address).

Closing a Telnet Window

Press Ctrl–d at the login: prompt to return to the Telnet>  prompt without 
logging in to the computer.

To close the Telnet window from the Telnet>  prompt, type quit  and press 
Enter.

Connected to 128.07.60.01.
Escape character is ‘^]’

login:

Trying...
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Logging in with Cterm

There are two ways to log in through Cterm, depending on whether your syste
administrator specified a default Cterm host for your network computer. If you
network computer displays an NSH> or CTERM> prompt like Figure 2-11, a 
default host has not been specified. In this case, you must specify a connect
before you can log in to the host.

Figure 2-11 Cterm Window Waiting for an Set Host Command

To open a connection to your computer:

• Use the mouse to position the pointer in the Cterm window. You can type
help and press Enter to see a list of Cterm commands.

• Type:

CTERM> sethost hostname

where hostname is the node address of the host.

Figure 2-12 Cterm Set Host Command

CTERM>

CTERM> sethost 11.10
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Once a connection is made (Figure 2-13), either automatically or with the 
sethost  command, you can log in:

• Type your user name at the Username:  prompt and press Enter

• Type your password at the Password:  prompt and press Enter

Figure 2-13 Cterm Window With a Host Connection

Continue with Chapter 3, Using the Network Computer.

Cterm connection and default Cterm host are specified by your system 
administrator through the remote configuration file or through Setup. The 
applicable commands are: Host Connect Method (set to Cterm), and Default 
Cterm Host (set to your host address).

Closing a Cterm Window

If you are at the Username:  prompt and do not want to log in to the host, wait 
until the network connection times out and closes. A message appears on th
screen when the connection closes. Typically it takes 60 seconds to time out.

To close the Cterm window from the NSH> or CTERM> prompt, type quit  or 
exit and press Enter.

Welcome to VAX/VMS V5.5

Username:

connected to host 11.10
4 Network Computer User



 

st 
Logging in with WinDD ICA Client

Two different WinDD screens can appear, depending on whether your system
administrator specified an automatic connection to a default server. If your 
network computer displays the client screen illustrated in Figure 2-14, you mu
connect to a server before you can log in. The log in screen is illustrated in 
Figure 2-16.

Figure 2-14 WinDD ICA Client Screen

Note: Additional WinDD information can be found in the section 
titled WinDD ICA Client on page 4-61 in Chapter 4, Using 
Advanced Features.

WinDD

Options

Application Server

Application Server:

Clear Console Configure Cancel Exit WinDD

Reconnect After Logoff

WinDD Message Console

Help

9210-1

Disk
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Selecting an Application Server

The WinDD ICA client screen (Figure 2-14) displays a list of application serv
your system administration defined for you. Use the mouse to select one of 
servers from the list. If the application server you want to access is not on the
enter the name or address in the Application Server: field and press Enter.

WinDD connection, default WinDD host, and Server entries are specified by
your system administrator through the remote configuration file or through 
Setup. The applicable commands are: Host Connect Method (set to WinDD), 
Default Windows NT Server Host (set to your default server address), WinDD 
Menu Entry (lists Windows NT servers for TekHostMenu), and WinDD Host 
Entry (lists additional Windows NT servers for the WinDD client screen).

Setting the WinDD Window Size

From the WinDD ICA client screen, you can easily change your session 
attributes before you connect to a server.

The Configure button brings up the WinDD Resolution dialog box illustrated 
in Figure 2-15. The resolution determines the size and number of colors of th
WinDD window. The resolution must be selected prior to making a connectio
to the application server and cannot be interactively changed until the 
connection has been closed. The Configure button performs the same function 
as the Options ⇒ Configure pulldown menu choice.

Figure 2-15 WinDD Resolution Dialog Box
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Logging in

Once you have made a connection, you are prompted to press Ctrl–Alt–Del 
bring up the log in screen. The log in screen is illustrated in Figure 2-16. If yo
want to specify a different server or return to the Client screen for any reaso
select Options ⇒ Log On. The Options ⇒ Log On function switches between 
the Client screen and the Log in screen after a server connection is made.

Figure 2-16 WinDD ICA Log In Screen

1. Enter your user name.

2. Use the mouse or Tab key to advance to the Password line.

3. Enter your password.

4. Press Enter or click on OK.
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Closing a WinDD Session

Close your Windows NT session as usual, by closing each of your application
then selecting File ⇒ Logoff from the Program Manager.

If auto reconnect is on, the system displays the WinDD log in screen. If auto
reconnect is off, the WinDD client screen appears. Select one of these metho
to close the WinDD session:

• Choose Options ⇒ Exit

• Click on the Exit WinDD  button on the client screen.

• Hold Shift and Ctrl then click the middle mouse button. Select Exit WinDD
from the menu.

Note: Additional WinDD information can be found in the section 
titled WinDD ICA Client on page 4-61 in Chapter 4, Using 
Advanced Features.
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Logging in with Serial Port 0 or 1

There are several ways to connect to a host through the Serial Port window 
(Figure 2-17). Check with your system administrator to find out which options
you can use on your particular network computer.

• Serial communications with no protocol

• Serial communications with Serial Xpress (SXp is an option, and is not 
supported on all network computer models.)

You use Serial Port 0 or 1 depending on which port your serial cable is plugge
into on the back of your network computer logic module.

If you have problems establishing communications, contact your system 
administrator.

Figure 2-17 Serial Port Window Waiting for Command

Closing a Serial Port Window

To close a Serial Port window without logging in, press Enter and then type˜.  
(tilde (̃ .) followed by a period).

Connected
Network Computer User 2-19



Chapter 2 Operating the Network Computer

2-2

n 

 

r 
Entering Serial Parameters with Setup

The parameters on the host computer must match the parameters of your 
network computer’s serial ports in order for serial communications to work. 
Your system administrator can set them up for you in the remote configuratio
file, or tell you what parameters need to be set so you can enter them in Setup.

To verify or change your serial parameters:

1. Select Setup from the Client Launcher. If you need a refresher on the 
terminology used in these procedures, refer back to Chapter 1, Terminology.

2. Drag on the Configuration Summaries menu and release on Peripheral Ports.

3. Determine if your cable is connected to Serial Port 0 or 1 by checking the
back of the integrated network computer or the separate logic module.

4. Verify the parameters for the port are set to the values obtained from you
system administrator. Change them if necessary.

5. Select the Return to Main Menu button.

6. Select the Save Current Settings button.

7. Select the Exit  Setup button.

Serial Communications with No Protocol

From the Serial Port window pictured in Figure 2-17:

• Position the mouse pointer in the Serial Port window

• If you are using a modem, type your dialing command, which is similar to 
this: (Refer to your modem manual.)

atdt  phone_number 

• Press Enter to bring up a Login:  prompt

• Type your user name and press Enter to bring up the Password:  prompt

• Type your password and press Enter

Continue with Chapter 3, Using the Network Computer.

Serial Port connection is specified by the system administrator through the 
remote configuration file or through Setup. The applicable command is: Host 
Connect Method (set to Serial Port 0 or 1).

Launcher
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Serial Communications with Serial Xpress (SXp)

A separate manual is available for Serial Xpress. Refer to the Related 
Documentation section in the Preface for more information.

From the Serial Port window pictured in Figure 2-17:

• Position the mouse pointer in the Serial Port window

• If you are using a modem, type your dialing command. Typically this is 
something like: atdt <phone_number> Refer to your modem manual.

• Press Enter to bring up a Login:  prompt

• Type your user name and press Enter to bring up the Password:  prompt

• Type your password and press Enter

• Start SXp on the host: type sxprocess and press Enter

Figure 2-18 Starting SXp on the Host (no modem)

The Serial Port window closes and a Serial Session window is opened for yo

Continue with Chapter 3, Using the Network Computer.

Serial Port connection can be specified by the system administrator through t
remote configuration file or through Setup. The applicable command is: Host 
Connect Method (set to Serial Port 0 or 1).

Serial Communication via PPP

For communication using Point-to-Point Protocol (PPP), see the PPP suppo
information in Chapter 4, page 91.

Connected

Login: username
Password: xxxxx
> sxprocess
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Logging in with LAT

If your network computer displays a LAT> prompt like Figure 2-19, you are set 
up to log in through a Local Area Transport supported in a DECnet 
environment. To login, you must connect to a LAT service.

Figure 2-19 LAT Window Waiting for an Connect Command

To connect to a service:

• Use the mouse to position the pointer in the LAT window. You can type help 
and press Enter to see a list of LAT commands.

• Type:

LAT> services

to see a list of available services.

• Type:

LAT> connect service

where service is the name of a valid service.

Figure 2-20 LAT Connect Command

LAT>

LAT> connect service
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If it is a password protected service, enter the password at the Password:  
prompt. You have up to three tries to enter the password before the connecti
attempt fails.

Once a connection is made (Figure 2-21) you can log in:

• Type your user name at the Username:  prompt and press Enter

• Type your password at the Password:  prompt and press Enter

Figure 2-21 LAT Window With a Service Connection

Continue with Chapter 3, Using the Network Computer.

LAT connection can be specified by the system administrator through the 
remote configuration file or through Setup. The applicable command is: Host 
Connect Method (set to LAT).

Closing a LAT Window

If you are at the Username:  prompt and do not want to log in to the host, wait 
until the network connection times out and closes. A message appears on th
screen when the connection closes. Typically it takes 60 seconds to time out.

To close the LAT window from the LAT> prompt, type quit  or exit and press 
Enter.

Welcome to VAX/VMS 5.5

Username:
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Local browser support
The NC Series network computer supports two different local versions of the
Netscape NC Navigator browser:

Netscape NC Navigator 3.0 (also known as Navio)

Netscape NC Navigator 4.x

Both binary versions of the browser are shipped on the NCBridge media. 
However, each version must be authorized to run. A minimum of one version
of the browser is authorized to run on each NC.

To identify which version of the browser may run on your NC, select from you
local setup screen, Statistics, followed by Options. Scroll to see what options
are available.

Version 3.0

Navio or Netscape NC Navigator 3.0 will run with a minimum of 24Mb of 
memory installed in your NC. Depending on the type of Web pages accesse
more memory may be required. A total of 40Mb of memory is recommended
when Navio is used with an NC.

Version 4.0

There are two versions of Netscape NC Navigator 4 provided on the NCBridg
media:

• netscape

• netscape_lite

The netscape  binary includes all features of the version 4 binary. It requires
a minimum of 40Mb of memory to run on the NC. A total of 50Mb is 
recommended for most Netscape Navigator 4 applications, especially when 
Java applets are executed.

The netscape_lite  binary version of the browser includes all of the 
Netscape 4 features except email and news. Netscape_Lite is offered so 
customers with XP200 products, which hold a maximum memory of 36Mb, 
may run version 4 of the browser.
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Local browser kiosk support
We have made several enhancements that relate directly to our browser, 
including:

• local browser kiosk support

• simpler methods of launching the browser

• browser support in VAX VMS boot host environments

• support for a 12MB flash memory option (NC200 and NC400 only)

Local browser kiosk support applies to all network computers that can run th
browser, including:

• XP100, XP200, XP300V, XP350, NC200, and NC400.

The browser is not available for:

• XP10, XP10T, XP20, XP100D, or XP330.

Although this section applies primarily to NC200 and NC400 network 
computers with 12MB flash, you can still take advantage of most of these ne
features with older network computer models. 

New browser-related features

In previous releases, the only way to launch the browser was to use the xpsh  
command from a host login account, using xpsh ’s file access mechanism to 
read and write browser preference settings and history data into the user’s home 
directory. While this might remain the preferred method for many users, ther
are some circumstances—for example, using a network computer as an 
information kiosk—where it is either impossible or undesirable to log in to 
launch a browser. To support using the browser in such an environment, we
have added two new methods of launching the browser.

Due to xpsh  limitations in VAX VMS environments, the browser would not 
run when the network computer booted from a VMS host. Now it is possible t
boot a network computer from a VMS host using the MOP boot protocol and
start the browser with the Launcher or the xp.cnf  file. When operating this 
way, the browser will use DAP file access to read the configuration files from
the navio  directory for Navio and .netscape  directory for Netscape or 
Netscape_Lite under the boot directory. 
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The 12MB flash memory option allows you to store all the Navio or 
Netscape_Lite browser files in flash memory so that the network computer ca
operate as a stand-alone kiosk. With the browser in flash, the network computer 
doesn’t need a boot host, and users don’t need login accounts. The network
computer can be configured to start the browser upon power-up and 
immediately connect to a web server home page.

Starting Navio NC Navigator

Prior to the NCBridge 3.1 release, the only way to start the local browser wa
with xpsh :

xpsh -access xpsh navio

With NCBridge 3.1 or 3.2, there are two new ways of starting the local browse
the simplest being through the Launcher, as shown in Figure 2-22. A default 
menu item for the Navio browser has been added at the top of Launcher’s Host 
Connections pull-down menu. 

Figure 2-22 Starting the Navio browser with a Launcher  pull-down menu
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Another way to start the browser is to add a start command to your xp.cnf  
file. The following are three example start commands that may be used to sta
the three different binary versions of the browser:

start NAVIO YES

start NETSCAPE YES

start NETSCAPE_LITE YES

Note: Only one version of the browser may be run at one time.

It is also possible to pass command line parameters and environment variab
settings with this command. The following examples start the browser with a
default geometry and override the proxy auto configuration URL with a 
different one:

start NAVIO YES -args “-geometry 860x900+80+60” -envs 
“AUTOCONF_URL=http://proxy.mydomain.com”

start NETSCAPE YES -args “-geometry 860x900+80+60” -envs 
“AUTOCONF_URL=http://proxy.mydomain.com”

start NETSCAPE_LITE YES -args “-geometry 860x900+80+60” 
-envs “AUTOCONF_URL=http://proxy.mydomain.com”

Note that all the parameters must be specified on the same line in the xp.cnf  
file. 

Configuring the browser for kiosks

An easy way to configure the browser for kiosk operation is to invoke it in 
non-kiosk mode (with the xpsh  command) and then make changes with the 
Preferences menu. Once the browser is configured, copy the essential 
configuration files from either the .navio  directory for Navio or the 
.netscape  for Netscape/Netscape_Lite created in your home directory to the 
navio  directory for Navio and netscape  directory for Netscape/Netscape_Lite
under the boot directory. (Use the configuration files listed in Table 2-2, Browser 
configuration files as a guide.) If you choose this method to configure the brows
be aware that you may have to modify some of the entries in the files, to rem
references to .signature , .mailcap,  or other personal files. Sometimes 
you can make the necessary changes by editing the configuration files direc
although these database files are not generally editable.

Note: Navio writes preferences to the file preferences . Netscape writes 
preferences to the file preferences.js , a Javascipt file.
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Table 2-2 presents a list of the browser configuration files and their purpose

Table 2-2 Navio Browser configuration files

File Description 

config/plugins.tbl list of plug-ins to support

navio/bookmarks.html defaults for the “Bookmarks” menu

navio/cert5.db default SSL certificates database

navio/cookies default cookie database 

navio/history.db default history menu database

navio/key.db default encryption key database

navio/mailcap default helper applications

navio/mime.type default mime file extension/application bindings 

navio/preferences default browser configuration preferences

navio/proxycon default proxy autoconfiguration script

navio/signature default signature for e-mail messages

usascii/app-defaults/Navio X resource defaults for Navio

Table 2-3 Netscape Browser configuration files

File Description 

config/plugins.tbl list of plug-ins to support

.netscape/bookmarks.html defaults for the “Bookmarks” menu

.netscape/cert7.db default SSL certificates database

.netscape/cookies default cookie database 

.netscape/history.db default history menu database

.netscape/key3.db default encryption key database

.netscape/mailcap default helper applications

.netscape/mime.types default mime file extension/application bindings 

.netscape/preferences.js default browser configuration preferences

.netscape/signature default signature for e-mail messages

usascii/app-defaults/Netscape X resource defaults for Netscape
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Because kiosk administrators don’t want their carefully configured browser 
environments altered by casual users, browser configuration files in kiosk 
mode, by default, are not writable. So users can change browser settings in 
Preferences menu, but the changes will not be saved. The same restriction 
applies to bookmarks and history data. While this behavior may be desirable
when operating a kiosk, it means you’ll have an extra step when setting up th
browser for kiosk operation.

Environment variables used by the browser

The Navio browser uses certain environment variables for setting certain 
parameters (see Table 2-4). The -envs parameter of the xp.cnf preload 
and start commands can be used to alter the value of environment variable
passed into the browser.

Navio and Netscape use the same type of environment variables but they ar
contained in different directories, .navio for Navio and .netscape for Netscap

Table 2-4 Browser environment variables

Environment variable Description 

AUTOCONF_URL Sets the URL for obtaining the proxy auto configuration 
file.

HOME Locates the .navio  or .netscape  config 
directory if NULL kiosk mode settings are used.

NNTPSERVER Sets the default news server.

WWW_HOME Sets the default web page.
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Preferences file entries

For Navio browsers, it is generally best to create a navio/preferences  
file by running the browser in non-kiosk mode and using the Preferences menu 
to make changes. The resulting .navio/preferences  in your home 
directory can then be copied to the navio  directory in the boot directory. 
Sometimes it is only necessary to make a minor change, in which case you 
might want to edit the preferences file directly. Table 2-5 explains a few 
commonly edited items in the preferences file.

Netscape browsers keep configuration information in a Javascript file called 
preferences.js. This file is modified by the Netscape browser preference menu, 
accessed after launching Netscape.

Proxy host configuration

By default, the Navio NC Navigator browser is configured to use the boot hos
as an HTTP server that provides the proxy autoconfiguration file. (This is the
same file format used to configure standard Netscape browsers.) If you recei
an error pop-up when the browser is started in kiosk mode, it will be necessa
to change the proxy autoconfiguration setting.

Table 2-5 Navigator preferences

Preference name Description 

HOME_DOCUMENT Sets the default document visited when the browser is started.

PROXY_MODE Determines how proxy info is configured:

0: Proxies are not used.

1: Proxies are manually configured (HTTP_PROXY, 
FTP_PROXY, etc. 

2: Proxy autoconfig script is loaded from an HTTP server.

PROXY_URL URL used for PROXY_MODE 2.

SHOW_MENUBAR Another item that can be used to limit what kiosk users can do. 
When set to False , kiosk users won’t be able to exit the 
browser.

SHOW_TOOLBAR When set to False , it turns off the icon buttons along the top of 
the browser. This is useful for restricting what users can do in a 
kiosk.
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When running in kiosk mode, the browser reads configuration files from the 
navio or .netscape directory under the boot directory. By default the 
navio  or .netscape directory contains a preferences file with entries 
configured to get proxy configuration information automatically from the boot
host using this URL:

http://xp_boothost

With this configuration, the browser expects an HTTP server on the boot hos
to return a proxy autoconfiguration file with an “application/
x-ns-proxy-autoconfig”  MIME type, which is typically found on 
Netscape HTTP servers.

The proxy host configuration can be changed by setting the AUTOCONF_URL 
environment variable in the preload or start command “-envs” 
parameter, or by editing the preferences file. (See Example 2-5, Navigator 
preferences, on page 2-30 for descriptions of the appropriate parameters.) 
Again, you may want to generate the preferences file first by using the browser 
in non-kiosk mode, then edit it directly with a text editor. 

Forcing kiosk mode operation

When started, the browser looks up the value of the HOME environment 
variable to determine the path to its .navio  directory for Navio or 
.netscape  directory for Netscape. If the HOME variable is not set, the 
browser assumes it has not been started with xpsh  and immediately enters 
kiosk mode, using the kiosk mode configuration parameters to determine whe
to find a navio  directory instead of a .navio  directory or a .netscape  
directory.

It is sometimes desirable to operate the browser in kiosk mode even when it
started with xpsh . Add this line to your xp.cnf  file to force the browser to 
operate in kiosk mode:

parameter browser_kiosk_enable YES

Replacing “YES” with “NO” does not force non-kiosk mode operation; rather, 
it tells the browser to check the HOME environment variable to determine 
kiosk mode operation.
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Flashing the Navio browser into ROM

To support the amount of memory required by the browser binaries, a 12MB
flash ROM option is now available (for the NC200 and NC400 series only) tha
allows the Navio or Netscape_Lite browser to be stored in a network 
computer’s flash memory. We have also added two new xp.cnf  commands 
to support flashing the browser (see information about the Flash Control 
Console in Chapter 4). Refer to the Network Computer Reference Manual for 
more information about xp.cnf flash commands.

To flash the Navio (Navigator 3.0) or Netscape executable files into a networ
computer’s 12Mb flash memory, uncomment the do_flash command in 
your xp.cnf  file along with this command:

flash_feature NAVIO (for Navio)
flash_feature NETSCAPE (for Netscape_Lite)

Note: Due to flash memory capacity limitations, only Netscape_Lite 
is loaded when Netscape is specified. Netscape_Lite is the 
same as Netscape minus email and news reader functions.

This will flash the browser executable flash files, listed in Table 2-6 (Navio) a
Table 2-7 (Netscape), into the network computer’s 12MB flash memory. For
Navio, the total approximate size of these binaries is 10.9MB uncompressed, 
compressed. For Netscape, the file size is approximately 19.4MB uncompre
9.1MB compressed.
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Table 2-6 Navio browser executable flash files

File Description 

java_301 Java class libraries

locale/compose.dir Internationalization config files

locale/iso8859-1/Compose

locale/iso8859-1/XLC_LOCALE

locale/ja/XLC_LOCALE

locale/locale.alias

locale/locale.dir

navio.300 Navio browser executable

plugins/advtguiplg.300 Spotlight video advertiser plug-in

plugins/bitmaps/begin.xbm Bitmaps for video plug-ins

plugins/bitmaps/fast_left.xbm

plugins/bitmaps/fast_right.xbm

plugins/bitmaps/right.xbm

plugins/bitmaps/sound.xbm

plugins/bitmaps/stop.xbm

plugins/videoplg.300 Digital Video plug-in

plugins/winddplg.300 WinDD client plug-in

XKeysymDB Key binding database file
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Table 2-7 Netscape browser executable flash files

File Description 

locale/locale.alias Internationalization config files

locale/compose.dir

locale/locale.dir

locale/iso8859-1/Compose

locale/iso8859-1/XLC_LOCALE

locale/ja/XLC_LOCALE

netscape_lite Netscape Lite browser executable

ifc11.jar Java-class archive file

iiop10.jar

jae40.jar

java40.jar

jio40.jar

jsd10.jar

ldap10.jar

marimb10.jar

XKeysymDB

plugins/advtguiplg.300 Spotlight video advertiser plugin

plugins/videoplg.300

plugins/winddplg.300

plugins/bitmaps/begin.xbm Bitmaps for video plugins

plugins/bitmaps/fast_right.xbm

plugins/bitmaps/fast_left.xbm

plugins/bitmaps/sound.xbm

plugins/bitmaps/right.xbm

plugins/bitmaps/stop.xbm
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The other new xp.cnf  command allows the user to flash kiosk mode 
configuration files (normally found in the boot/navio  directory for Navio 
or boot/netscape  directory for Netscape) into the flash ROM option: 

flash_feature NAVIO_CONFIG_FILES (Navio)

flash_feature NETSCAPE_CONFIG_FILES (Netscape_Lite)

This will flash the files listed in Example 2-2, Navio Browser configuration 
files, on page 2-28 for Navio and Example 2-3, Netscape Browser configuration 
files, on page 2-28 for Netscape, into the network computer’s flash memory.
Typically, you would only do this when there is no available host computer to
boot from and you want the browser operate solely from flash memory. The 
total approximate size of the Navio configuration files is 400K, 160K 
compressed. The size of the Netscape configuration files is 458K 
uncompressed, 84K compressed.

Make sure the configuration files contain the appropriate settings before 
flashing because, once flashed, the configuration cannot be changed withou
re-flashing. Furthermore, when the network computer is configured for a 
language other than usascii , the appropriate change to the app-defaults  
path is also made, so it is important to set the language too before flashing.

Setting browser file access

In kiosk mode for Navio, the browser’s default configuration location is a 
navio directory under the boot directory on the boot host using the boot file
access method. For Netscape, the default location is a .netscape  directory. If 
you want to set the location to something other than the boot directory or chan
the host or file path, the default kiosk mode file access parameters can be 
overridden with three commands in the xp.cnf  file:

parameter browser_default_file_access <access_method>

parameter browser_default_file_host <hostname>

parameter browser_default_file_path / <file_path>

The first of these commands sets the file access method to be used for read
browser configuration files when in kiosk mode. Valid values for 
<access_method> are NFS, ROM, DAP, TFTP, and NONE. When the 
access method is set to NONE, the browser will use the default boot access 
method.
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The second command sets the name or IP address of the host that will be 
providing configuration files when the browser runs in kiosk mode. If a name
is used, it should be one that can be resolved using DNS (Domain Name 
Service) or which appears in the network computer’s Internet Host table. Th
generic name xp_boothost  can be used in cases where the specific name o
the boot host is not known. If NFS or ROM file access is used, the host nam
does not have to be set, but an NFS mount must be set up in the NFS table, 
a hostname is required there.

The third command sets the path to a directory in which the browser expects
find either a navio  or .netscape  subdirectory. This directory is expected 
to contain the browser configuration files that are typically found in a user’s 
home .navio  directory or the boot/navio  directory for Navio or the 
.netscape  or boot/.netscape  directories for Netscape, supplied on the 
install media. 

Browser kiosk examples

In this example, you will make some changes to your xp.cnf  file and reboot 
the network computer to flash the new features into your 12MB flash memory 
board. Then you will make a few changes in the Boot Monitor. After that, you 
will reboot again to get the browser to launch automatically and run in 
stand-alone kiosk mode.

Note: Skip step one if flashing Netscape. Netscape preferences are made
via the preferences menu and stored in the preferences.js file.

1. On the host where the navio directory is found (tekxp/boot  by 
default), edit the preferences file: 

a. Set the value of PROXY_URL to the local proxy server. For example:
http://proxy.tek.com 

b. Set other values to configure Navigator, such as the home page, links, e

2. Use the xp.cnf  code in Example 2-1, Excerpted xp.cnf file for Navio browser
kiosk operation, on page 2-38 to configure your NCs for kiosk mode. 

3. Reboot your network computer to initiate the flash process. (see the sectio
Flash Control Console in Chapter 4 for more information).

4. After flashing, edit your xp.cnf  file and comment the do_flash 
command (place a # in front of do_flash ).
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5. Reboot the network computer and press any key before the progress bar 
reaches 100% to interrupt the boot process and enter the Boot Monitor. In the 
Boot Monitor, perform these steps:

a. Reset the network computer with an NVFactory.

b. Set IA ddr  to the network computer’s IP address.

c. Set IH ost to Local Router, or something so it will not try BOOTP or DHC

d. Set IM ask.

e. Set IGate to Local Router IP address.

f. Set BM ethod to ROM.

g. NVSave.

h. Boot.

6. When you reboot the network computer—this time from ROM—the Navio
NC Navigator browser will start in kiosk mode.

See the next two examples for typical kiosk applications.
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Example 2-1. Excerpted xp.cnf  file for Navio browser kiosk operation

##************************** Sample xp.cnf file 
**************************##

 enable_name_service YES
 preload LAUNCHER PERM
 preload NAVIO PERM -args "-geometry 860x900+80+60"
 preload MWM NO
 preload OLWM NO
 preload CDE NO
 preload SETUP NO
 preload AUDIO_SERVER PERM
 preload NETSCAPE NO
 preload NETSCAPE_LITE NO  

console_pages 15

 start NAVIO YES
 start NTP YES # [YES | NO]

 parameter time_gmt_offset -25200
 parameter time_dst_mode FOLLOW
 parameter time_dst_offset 3600

 do_flash
 flash_feature NAVIO
 flash_feature NAVIO_CONFIG_FILES
 flash_feature SYSTEM
 flash_feature XPWM
 flash_feature TEKSETUP
 flash_feature REMOTE_CNF
 flash_feature LAUNCHER
 flash_feature AUDIO_SERVER
 flash_feature FONTS # as specified in fonts.tbl
 flash_feature NTP
 #need to include 75dpi font in fonts.tbl
8 Network Computer User



Example 2-2. Excerpted xp.cnf  file for Netscape Lite browser kiosk operation using 
12MB flash card

##************************** Sample xp.cnf file 
**************************##

 enable_name_service YES
 preload LAUNCHER PERM
 preload NETSCAPE_LITE PERM -args "-geometry 860x900+80+60"
 preload MWM NO
 preload OLWM NO
 preload CDE NO
 preload SETUP NO
 preload AUDIO_SERVER PERM
 preload NAVIO NO
 preload NETSCAPE NO
 console_pages 15

 start NETSCAPE_LITE YES
 start NTP YES # [YES | NO]

 parameter time_gmt_offset -25200
 parameter time_dst_mode FOLLOW
 parameter time_dst_offset 3600

 do_flash
 flash_feature NETSCAPE #this will flash Netscape_Lite 

#since full Netscape won’t fit into 12MB flash RAM
 flash_feature NETSCAPE_CONFIG_FILES
 flash_feature SYSTEM
 flash_feature XPWM
 flash_feature TEKSETUP
 flash_feature TELNET
 flash_feature REMOTE_CNF
 flash_feature LAUNCHER
 flash_feature AUDIO_SERVER
 flash_feature FONTS # as specified in fonts.tbl
 flash_feature NTP
 #need to include 75dpi font in fonts.tbl
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Using the Network Computer

What Next? might be a more appropriate title for this chapter. There really is no
single answer to the What next? question. Your network computer is designed 
to be as flexible as possible so it can be tailored to fit your needs and your 
computing environment. This tailoring process is performed by your system 
administrator, with help from the installation and reference manuals that are 
included with the network computer software.

This chapter cannot tell you step-by-step how to get started, but it does provid
general information to help you figure out What next? Typically, one of the 
following scenarios occurs:

• A window manager starts automatically

• A client starts automatically

• Both a window manager and client start automatically

• Nothing starts (leaving you to initiate an action)

The sections in this chapter contain information on identifying what is 
happening on your network computer, and what choices you can make. The
following topics are discussed:

• X Window Software Components

• Getting Unstuck

• Window Managers

• Sessions

• Running Clients

• Locking the Display

• TekLogin

• PPP

• Screen Saver

• 16-Bit True Color
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X Window Software Components
Before diving into the details of the possible scenarios, it is a good idea to 
understand some of the common software components and terminology.

The X Window System is a windowing system developed to enhance the 
usability of a host computer by utilizing an X server as a device independent 
interface between the host computer and your network computer. This mean
that you can run clients on computers made by different manufacturers, freeing 
you to focus on your applications without worrying about computer differences. 
Another advantage is that X is multi-tasking, so multiple applications can run 
simultaneously in different windows.

The X server is the interface that translates client requests from your network
computer to the host computer. It also accepts input data from your mouse a
keyboard and generates the appropriate actions.

Windows are bounded areas displayed on your network computer screen th
organize the presenting of information on the screen. They can contain text 
(letters, numbers) or graphics (pictures, graphs, animated sequences) genera
by your application programs, such as word processors, or transaction 
processing software. The X server controls what gets displayed inside each 
window. Information does not spill over from one window to the next.

A Window Manager is a special program that runs on top of the X server and 
provides an easy to use interface for you to run and work with your clients. 
These items include (among others):

• Window title bars
• Scroll bars
• Manipulating windows (sizing, moving, iconifying, closing)

Those are the visible results of using a window manager. The invisible portion
may be even more important to you. These items include:

• Managing window communications to make sure the correct window 
receives the correct information

• Determining where your mouse pointer is positioned, so it knows where to 
read any input you generate

Session Windows are various types of communication protocols to establish 
communications between your NC and one or more host computers.

Clients are applications that run on an X server in a session window. Client 
means that the application is typically subordinate to the window. If the window
is closed, the client also closes.
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Getting Unstuck

Occasionally something may go wrong and your network computer or a clien
may get stuck or hang. Hang means the network computer or the client is not 
responding to any input coming from you or being transmitted from the host.
Often times, this is due to a busy network. There are three recommended wa
to try and restore communications: resetting the X Server, rebooting the 
network computer, or, if the keyboard is also locked up, turn off the power on
the network computer.

Resetting the X Server

This is the first method to try.

1. Select Setup from the Client Launcher.

2. Click on the Reset Server button.

3. When prompted that this closes existing connections, click on the OK  
button.

The screen is blanked when the reset occurs. It may take a minute or two for t
server to reset. Be patient and wait. When the root weave or your login metho
appears, log back in as usual. Refer to Chapter 2: Operating the Network 
Computer if you need information on logging in to the computer.

Rebooting the Network Computer

Sometimes rebooting is necessary, even though it adds to the network load. T
Resetting the X server before you reboot.

If Setup does not come up, or if resetting the server did not work, try rebooting
the network computer. Press the key sequence: Ctrl-Alt-Delete to try and rebo
the network computer. If the reboot is successful, the boot screen is displayed 
while your network computer boots. Refer to Chapter 2, The Network Computer 
Boot Process for more information on booting.

Powering off the Logic Module

Note: Turning off the power is the last-resort method. Try the other 
methods first, or call your system administrator for 
assistance.

If neither resetting the server nor rebooting the network computer works, tur
the power off then on with the power switch on your network computer logic 
module.

Launcher
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Window Managers
There are many different window managers available, but the concepts are 
similar. Here is a list of the more popular window managers:

• Motif (also called MWM)

• OPEN LOOK Window Manager (OLWM) (Sun hosts)

• HP VUE (for Hewlett-Packard hosts)

• DECWindows (DEC hosts)

• XpressWare Window Manager

• Tom’s Window Manager (twm)

Your system administrator sets up and configures your window manager.

Determining if a Window Manager is Running

You can tell if a window manager is running by looking at the borders on an 
open window. If you do not have an open window, select Setup from the Clien
Launcher to display the Setup window. If a window manager is running, there 
is a border around the window, along with a title bar and usually some 
command buttons. Figure 3-1 illustrates a Telnet window with and without a 
window manager running.

Figure 3-1 Determining if a Window Manager is Running

telnet>
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Starting a Window Manager
If your system administrator configured your environment to automatically 
start a window manager, skip to the next section, Using a Window Manager.

Your system administrator must configure the window manager on your hos
computer before it can be used. If your network computer has either the loca
MWM or OLWM options, you can start it from Client Launcher. If the option 
does not appear, your network computer does not have it. Contact your syste
administrator.

To start local MWM, OLWM, or XP window manager from the default Client 
Launcher:

1. Open the Window Managers submenu.

2. Select MWM or OLWM or XPWM.

Note: If MWM, OLWM, or XPWM is not available, or if you use 
another window manager, call your system administrator. 
The command to start a window manager is specific to your 
host and configuration.

Using a Window Manager
The examples in this section are based on Motif, a host independent window 
manager included with your network computer software. Host independent 
means that it runs on hosts from different operating systems, rather than a 
proprietary manager such as HPvue that is intended for only Hewlett-Packar
systems. Your windows may look and operate differently from those describe
here. It may be because your system administrator customized your MWM 
settings, or you may be using a different window manager. Refer to your 
window manager documentation for more information.

Figure 3-2 shows a typical window and its standard elements. A window 
usually has command buttons for menu access, and to minimize and maximi
the window. Try the various buttons displayed with your windows.

In addition to the window menu and buttons, there are typically pop-up menu
that can be accessed outside of a window. These menus are controlled by 
various system files. To see if you have these pop-up menus:

1. Position the pointer outside of all windows.

2. Try pressing either the Select or Custom mouse buttons to see if a menu 
appears. Information on the menu choices would be included in your window
manager or host documentation.

Launcher
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Figure 3-2 Elements of a Window

These window manipulations are described in this section:

• Moving a window

• Resizing a window

• Raising a window

• Lowering a window

• Maximizing a window

• Iconifying a window

• Restoring an icon

• Moving an icon

Sample Window

Icon

Title BarWindow Menu Button

Maximize
Button

Minimize
Button

Window
Border

8049-126

Setup

Root Window
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Moving a Window

Figure 3-3 How to move a window

Windows can be moved from one location to another on the display.

1. Position the pointer within the title bar or border of the window. 

2. Drag the pointer. When you begin moving the window, the pointer change
to a cross-arrow pointer and a window outline appears. As you move the 
pointer, the outline tracks the movement. A small rectangle appears in the
center of the screen and displays the x and y coordinates of the window a
the window moves.

3. Once the window is in the desired location, release the mouse button. Th
window appears in the new location and becomes the active window.

Alternate method: Drag on the Window Menu, release on Move, position the 
window outline (by moving the mouse), and click a mouse button.

Resizing a Window

Figure 3-4 How to resize a window
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Many windows can be resized. The corners of the window border let you resiz
the window in two directions, while the horizontal borders and vertical border
let you resize the window in a single direction. 

1. Position the pointer on the window border or resize corner controlling the 
window side(s) you want to resize. The pointer changes to either an arrow 
with a corner (for resizing two sides) or to an arrow with a perpendicular bar 
(for resizing in one direction).

2. Drag the corner or window border in the direction desired. As you resize th
window, an image of the moving border(s) tracks the pointer movement.

3. Release the mouse button. The window appears in the new size.

Alternate method: Drag on the Window Menu, release on Size, position the 
window outline (by moving the mouse), and click a mouse button.

Raising a Window

Figure 3-5 How to display a window in the foreground

When you want to raise a window; that is, display the window in front of othe
overlapping windows so you can see the entire window, follow these steps:

1. Position the pointer (cursor) anywhere in the window (except on a comman
button).

2. Click the Select mouse button. Raising a window automatically makes tha
window active. Windows cannot be raised from the Window Menu.

Note: There is an X feature called autoraise. If this feature is 
configured for your window manager, windows are 
automatically raised as soon as you position your mouse 
pointer in the window.

Icons

X

Sample Window 1

Sample Window

Icons

X

Sample Window

Sample Window 1
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Lowering a Window

Figure 3-6 How to lower a window

To place a window behind overlapping windows:

1. Drag on the Window Menu in the window to lower.

2. Release on Lower.

Maximizing a Window

Figure 3-7 How to maximize a window

A window can be maximized to take up the entire size of the display. Some cl
do not support maximized windows.

1. Click on the Maximize button in the window you want to maximize.

2. To return the window to its original size, click the Maximize button again.

Alternate method: Drag on the Window Menu and release on Maximize.

Icons

X

Sample Window 1

Sample Window

Icons

X

Sample Window

Sample Window 1

Sample WindowIcons

X

Sample Window
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Iconifying a Window

Figure 3-8 How to iconify a window

Iconifying a window means to collapse it down to an icon, a small graphic 
representation of the window. This helps you keep multiple windows organize
and easy to access. To iconify a window:

Click on the Minimize button in the window you want to iconify.

Alternate method: Drag the Window Menu and release on Minimize.

MWM has a client called Icons. If this client is available, it provides a box to 
hold and sort all of your icons.

Restoring an Icon

Figure 3-9 How to restore an icon

You can change an icon into a window whenever you want to view the window
contents or work in the window. To restore an icon:

Double-click the Select button on the icon you want to restore.

Alternate method: Click the icon once to display a pull-down menu, and th
click on Restore.

Icons

X

Sample Window

Icons

X

Icons

X

Sample Window

Icons

X
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Moving an Icon

Figure 3-10 How to move an icon

To move an icon from one location on the display to another:

1. Drag the pointer on the icon you want to move. When you begin moving th
icon, the pointer changes to a cross-arrow and an icon outline appears.

As you move the pointer, the outline tracks the movement.

2. Once the icon is in the desired location, release the mouse button. The ic
appears in the new location. 

Alternate method: Click the icon once to display a pull-down menu, click on
Move, position the icon outline (by moving the mouse), and click a mouse
button.

Icons

X

Icons

X
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Starting Sessions
As presented in Logging in to the Network Computer in Chapter 2, there are 
many different ways to establish communications with one or more host 
computers. With a network computer you can have multiple sessions open a
running simultaneously. For example, you might open a word processor, cut
some text out of file, and paste it into window where you are composing som
electronic mail. Or, you might open a session into another host to check if a 
customer order has been shipped. All without having to exit your  application

Before you start a session, you typically need to know the name, or address
the remote host. You can find this out by calling your system administrator.

There are different types of addresses based on the network protocol used a
your site. Internet protocol (IP) addresses (128.06.70.01 for example) are used
for networks running a protocol called TCP/IP. This is the most common 
network for hosts running a UNIX operating system. Node numbers (11.10:: for 
example) are used for networks running a protocol called DECnet. This is the 
most common network for hosts running a VMS operating system.

There are two easy ways to start a new session from Client Launcher. If you 
need a refresher on the terminology used in these procedures, refer back to 
Chapter 1, Terminology. Use one of these methods:

1. Select TekHostMenu. When the TekHostMenu client appears, use the mouse 
to select your host. Refer to Logging in to the Network Computer on page 2-3 
for details.

Note: If you logged in with XDMCP, the XDMCP list is not 
available on TekHostMenu. Only one XDMCP session can be 
running.

2. Select a session from the Host Connections submenu:

Telnet (refer to Logging in with Telnet on page 2-11)
Console (refer to The Console Window on page 5-4)
Cterm (refer to Logging in with Cterm on page 2-13)
WinDD (refer to Logging in with WinDD ICA Client on page 2-15)
Serial Port 0 or 1(refer to Logging in with Serial Port 0 or 1 on page 2-19)
LAT (refer to Logging in with LAT on page 2-22)

Note: Grayed text indicates an option that is not enabled for your 
particular network computer. If an option is not listed, it is not 
available for your network computer model.
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Running Clients
Clients refer to applications that your network computer accesses across the 
network, such as a desktop publishing system, a computer-aided design 
program, or an on-line transaction processing system. Your network comput
can access multiple clients simultaneously.

Your system administrator can set up your login files to automatically start on
or more clients each time you login. The other alternative is for you to start th
clients you need.

Typically you start clients either of two ways:

• From a session window, type the command to start your particular client an
press Enter. Instructions for starting clients are included with your 
application documentation.

• If your host computer or window manager has command menus available
there may be menu choices available to automatically start your application

– Position the pointer outside of a window.

– For MWM, you would press the Select mouse button and click on your 
client. For other window managers, follow the instructions for menu and
item selection and select the client you want to run.

Refer to the documentation that came with your application for 
application-specific operation and information.
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Locking the Display
You can lock your display and all open windows so that while away from you
desk, an unauthorized user cannot access the information on your display. T
xlock local client locks the keyboard only, or the keyboard and the display. 

1. xlock can be started from the Client Launcher (select Lock Screen) or with 
xpsh from the command prompt:

xpsh -display nc_address:0 xlock -mode n 

To determine the network computer address, select Setup from the Client 
Launcher. Drag on Configuration Summaries and release on TCP/IP (for a
UNIX host) or TDEnet (for a VMS host). The address displays as the 
network computer IP Address or the TDEnet Address.

The -mode n setting is optional. If set to –mode 1, xlock locks the keyboard 
only. If set to -mode 0, xlock locks the keyboard and the screen. If a –mode 
setting is not given, xlock locks the keyboard and the screen by default. If you
receive a Command not found  message, have your system administrator 
add xpsh to your path environment variable and try the xpsh command 
again.

When xlock is started, the xlock window appears, asking for a password and 
confirmation. Upon entering the password, a blank screen with a floating 
lock will appear. Pressing a key will prompt for a password. The correct 
password will re-activate the screen and an incorrect one will not.
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2. At the Password prompt, enter a password and press Enter. 

3. At the Retype prompt, enter the password again and press Enter. This verifie
you have entered the password correctly. Xlock remains in effect until you 
re-enter the password. The password is valid until you reboot the network
computer or reset the server.

4. To unlock the display or keyboard, press any key for the xlock window. At 
the Password prompt, enter the password.

Note: If you forget your password, you must reboot the network 
computer or reset the server to unlock the display or 
keyboard.
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Using Advanced Features

This chapter provides information about these advanced NCBridge software
features:

• Audio Player for recording and playing audio files on the network computer

• Audio Mixer for controlling the audio volume for the line in and microphone 
on the network computer

• Digital Video Player for playing NTSC or PAL video sources on the network 
computer

• Analog Video Player for playing analog video sources on the network 
computer

• XIE Viewer for viewing image files on the network computer

• WinDD to run Windows NT applications on a PC server

• PSXpress for using the Display PostScript NX and Acrobat software

• Font Caching for storing fonts in your network computer’s memory

• Printing Color Hardcopies from your network computer

• Flash Control Console for flashing multiple network computers from a 
single location.

• TekLogin Local Client to simplify login and application access

• PPP Support for network connections via serial lines (phone lines)

• Screen Saver Support that enables you to display .gif images

• 16-Bitplane True Color Support for better visual effects
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Audio Player
The Audio Player plays and records digital audio files. When started, the
Audio Player displays as shown in Figure 4-1.

Figure 4-1 Audio Player

The player can play files that have these extensions:

.au — Sun file type

.wav — Microsoft file type

.voc — Sound Blaster file type (play only)

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

File
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If a file does not have an extension, the player attempts to read its header 
information. If there is no header information, the player plays it as a headerle
file (.raw).

The Audio Player supports the file formats 8-bit linear, 8-bit uLaw, 8-bit aLaw,
and 16-bit linear (LSB & MSB).

The following topics present information about using the Audio Player:

• Starting the Audio Player on page 4-3 provides information about the 
various ways to start the Audio Player

• Opening or Creating an Audio File on page 4-8 provides information about 
opening and creating audio files

• Connecting External Audio Devices on page 4-17 provides information 
about the types of external devices that can be used with recording audio fi

• Recording an Audio File on page 4-19 provides the steps for recording an 
audio file

• Playing an Audio File on page 4-21 provides the steps for playing an existing
audio file

• Audio File Information on page 4-22 provides information about obtaining 
original audio file recording information

Starting the Audio Player

The Audio Player can be started from the Client Launcher, from the remote 
configuration file, or with xpsh.

>>> CAUTION Before connecting any audio device to the network computer 
(such as microphones or headsets), close all clients, remote connections, an
power down the network computer. Connecting devices to the network 
computer’s audio connectors with power applied could result in a loss of data.
After the devices are connected, start the Audio Player.

Starting the Audio Player from the Client Launcher

From the Multimedia submenu, select Audio Player. Figure 4-1 shows the 
Audio Player.
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Starting the Audio Player from the Remote Configuration File

The start AUDIO_PLAYER command in the remote configuration file (xp.cnf) 
automatically downloads and starts the Audio Player when the network 
computer boots. Refer to the start command in Chapter 2 of the Network 
Computer Reference manual for details.

Starting the Audio Player with xpsh

xpsh can start the Audio Player client, shown in Figure 4-1, or can simply play
an audio file without opening the Audio Player. To start the Audio Player with
xpsh, enter:

xpsh –display nc_name:0 aplay

The following options can be set on the xpsh command line:

–h host — specifies the host name or address on which the audio file resides
The host must be entered in the network computer’s Internet Host Table 
Setup. This host displays in the Audio Player’s File Information area.

–f filename and path — specifies the audio file name and its entire path. This
file displays in the Audio Player’s File Information area.

–a access method — specifies the access method used to access the audio fil
Available access methods are tftp , nfs, and dap.

–v volume level — specifies the volume level to use when playing the audio 
file. Specify a number between 0 and 100, with 0 indicating no volume, an
100 indicating the loudest volume setting.

–p when used with the –h, –f, –a, and –v options, the specified file plays 
without opening the Audio Player. The entire file plays and cannot be 
interrupted.

–propcmd — enables the “property command” interface, which allows other 
clients to send command strings to control the aplay client remotely. (See 
Examples on page 4-5.)

–title “string”  — assigns a title for the aplay window.
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Examples

This example starts the Audio Player on the network computer named sierra:

xpsh  –display sierra:0 aplay

This example starts the Audio Player with the host portland and the audio file 
/usr/adam/story.au preloaded in the Audio Player’s File Information Area:

xpsh  –display sierra:0 aplay –h portland  –f /usr/adam/story.au

This example plays the audio file /usr/adam/story.au (located on the host 
portland) on the network computer without opening the Audio Player:

xpsh –display sierra:0 aplay –h portland –f /usr/adam/story.au –a tftp –p

Example 1-1. Aplay examples

xpsh -display sierra:0 aplay

xpsh -display sierra:0 aplay -h eugene -f /usr/adam/
story.au

xpsh -display sierra:0 aplay -h eugene -f /usr/adam/
story.au -a tftp -p

The first xpsh example above starts the aplay client on a network computer 
named sierra; the second starts the Audio Player with the host eugene and the 
audio file /usr/adam/story.au preloaded in the Audio Player’s File Information 
Area; and the third example plays the audio file /usr/adam/story.au (located on 
the host eugene) on the network computer without opening the Audio Player.
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Property command interface

The property command interface lets other clients remotely control the 
command line version of the aplay client by allowing these other clients access 
to four “properties” created by the aplay client on the X server. (See Table 4-1, 
Audio Player Properties.) If the aplay client is executed with the -propcmd 
option, atoms (which uniquely identify each property) are created and becom
associated with these character strings. The client aplay’s shell window ID is 
then assigned to the _TEK_APLAY_WID property. 

To use these properties to control the aplay client, get the value of 
_TEK_APLAY_WID. You will need to know the client’s window ID when 
setting the value of _TEK_APLAY_CMD, getting the value of 
_TEK_APLAY_REPLY, and finding the status of _TEK_APLAY_STATUS.

Commands that can be sent to the aplay client via the _TEK_APLAY_CMD ar
of two types: value-free and valued.

Value-free commands. A value-free command is simply a request for an 
action to be performed. Value-free commands include: PLAY, STOP, PAUSE, 
REWIND, and MUTE.

Valued commands. A valued command sends a command and a value to be
used in the performance of that command. Valued commands include: FILE
VOLUME, ACCESS, and HOST. Valued commands can be used to set a valu
or to query the client for a value. 

The format for setting a value is:

<command>:<value> 

Table 4-1 Audio Player Properties

Property name Description

_TEK_APLAY_WID gets the ID of the aplay shell window

_TEK_APLAY_CMD passes commands to the aplay client

_TEK_APLAY_REPLY sends replies to the client issuing the commands

_TEK_APLAY_STATUS returns the status of the aplay client
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There is no white space separating the command, colon, or value. The value
different depending on the command. The FILE command requires a full 
absolute path to a file.

FILE:/usr/audio/speech.au

Valued commands can also be used to query a particular value. This is done
sending the command and getting the string associated with the 
_TEK_APLAY_REPLY property. If the command string FILE is loaded into 
the _TEK_APLAY_CMD property, the current filename is stored in the 
_TEK_APLAY_REPLY property. If the command string VOLUME is loaded 
into the _TEK_APLAY_CMD property, the current volume level is stored into 
the reply property.

• user puts FILE in _TEK_APLAY_CMD

• aplay puts /usr/audio/speech.au into _TEK_APLAY_REPLY

Once the aplay client gets notification that the _TEK_APLAY_CMD property 
has changed, it gets the command string associated with it and deletes the 
property value. This is an acknowledgment that the aplay client has handled the 
property command.

To find the status of the aplay client, simply check the string associated with th
_TEK_APLAY_STATUS property. The value of status is either STARTED, 
PAUSED, or EOF.
Network Computer User 4-7



Chapter 4 Using Advanced Features

4-8

n 

S 
, 
Opening or Creating an Audio File

The Open command on the File menu creates a new file to record, or opens a
existing file.

1. Select the Open command from the File menu. The File Selection window 
appears as shown in Figure 4-2.

2. To select the access method to use, position the mouse pointer on the NF
button and click. A drop down menu displays the available methods: TFTP
NFS, or DAP. The File Selection window changes to reflect the chosen 
access method.

Figure 4-2 File Selection

File Selection

Filter

NFS

Directories

Selection

Apply Filter

OK CANCEL

Files
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Using TFTP Access

The TFTP File Selection window shown in Figure 4-3 displays when tftp is the
access method:

Figure 4-3 TFTP File Selection Window

Note: Use tftp as the access method only if NFS is not available. 
NFS provides better and more accurate data transfer rates 
required to maintain continuous audio stream.

If using tftp as the access method, the Audio Player cannot 
play a file that is greater than 16MB. If you attempt to play a 
file larger than 16MB, the player will ignore the file.

File Selection

Host

TFTP

Path

OK CANCEL

134.62.18.81

/u8/paul/Temp/au.au
Network Computer User 4-9



Chapter 4 Using Advanced Features

4-1

t 
In 

t 

 

st 

e 
Creating a New Audio File Using TFTP Access

When creating a new audio file using tftp as the file access, the file must exis
and have world write permissions before the audio data can be written to it. 
addition, only the .au, and .raw file extensions can be used with tftp.

1. Create the new audio file and give it world read and write permissions.

2. Enter the Host name or address on which the file will be stored in the Hos
field.

3. Enter the filename, path, and extension in the Path field. Use only the .au
(Sun file type) or .raw (no header) file extensions.

4. Click on OK to open the file. The host and file names display in the File 
Information Area.

Opening an Existing Audio File Using TFTP Access

1. Enter the name or address of the host on which the file is located in the Ho
field.

2. Enter the file’s path, filename, and extension in the Path field. Files with th
following extensions can be played on the Audio Player:

.au — Sun file type

.wav — Microsoft file type

.voc — Sound Blaster file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

If no extension is given, the player attempts to read the file’s header 
information. If the file does not have a header, the player plays it as a 
headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the 
file’s original recording information. Refer to the Info command later in this 
chapter for more information.
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Using NFS Access

Figure 4-4 displays the NFS File Selection Window when NFS is the access
method.

Figure 4-4 NFS File Selection Window
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Creating a New Audio File Using NFS Access

When using NFS as the file access, an NFS mount must be established to th
host on which the file resides and must have world read and write access.

1. Enter the local NFS mount point to the network computer in the Filter field

2. Enter the full path, filename, and extension in the Selection field. The 
following file extensions are available:

.au — Sun file type

.wav — Microsoft file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

If no extension is given, the file is recorded as a headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.
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Opening an Existing Audio File Using NFS Access

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

3. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

4. Select the file you want in the Files area. The full path and filename prefills 
in the Selection field. Enter one of the following file extensions:

.au — Sun file type

.wav — Microsoft file type

.voc — Sound Blaster file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

If no extension is given, the player attempts to read the file’s header 
information. If the file does not have a header, the player plays it as a 
headerless file (.raw).

5. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the 
file’s original recording information. Refer to the Info command later in this 
chapter for more information.
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Using DAP Access

The following File Selection window displays when DAP is the access meth

Figure 4-5 DAP File Selection Window

File Selection

Node

DAP

Filter

Selection

Apply Filter

OK CANCEL

Directories Files
4 Network Computer User



ch 
Creating a New Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on whi
the file will be stored.

2. Enter the full path, filename, and extension in the Selection field. The 
following file extensions are available:

.au — Sun file type

.wav — Microsoft file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

If no extension is given, the file is recorded as a headerless file (.raw).

3. Click OK. The host and file names display in the File Information Area.
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Opening an Existing Audio File Using DAP Access

1. Enter the node name or address in the Node field. This is the node on whi
the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas. 

4. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that
directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename prefills 
in the Selection field. Enter one of the following file extensions:

.au — Sun file type

.wav — Microsoft file type

.voc — Sound Blaster file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

If no extension is given, the player attempts to read the file’s header 
information. If the file does not have a header, the player plays it as a 
headerless file (.raw).

6. Click OK. The host and file names display in the File Information Area.

When opening an existing file, you can choose the Info command to see the 
file’s original recording information. Refer to the Info command later in this 
chapter for more information.
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Connecting External Audio Devices

Figure 4-6 shows the audio input and output connectors on the rear of the logic 
module. All of the jacks accept a 3.5 mm stereo phone plug.

>>> CAUTION Before connecting any audio device to the network computer, 
close all clients, remote connections, and power down the network computer
Connecting devices to the network computer’s audio connectors with power
applied could result in a loss of data.

• If you are using a microphone for audio input, plug it into the Mic input jack

• A line level signal from a stereo audio source such as an audio mixer, 
pre-amplifier, compact disc player, or tape player, plugs into the line-in jack,
which is marked with the  symbol.

• The line-out jack is marked with the   symbol and provides a line-level 
stereo signal for use by a mixer, pre-amplifier, tape player, or other 
equipment that can accept a line level input. This output provides the highe
quality audio.

• The headphone jack is for use with stereo headphones, 8Ω stereo speakers 
(unpowered), and powered speaker sets that connect to personal listening
players (e.g. Discman). Plugging in to this jack disables the internal 
monitor speaker.

Figure 4-6 Input and Output Jacks

Mic Line
In

Line
Out

Head-
phones
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Audio Accessory Specifications

The following specifications can assist you when choosing accessories to us
with the Audio board.

Microphone Specifications

Microphone Type Dynamic 
Electret (or condenser) with integrated battery

Impedance Medium to High (600 to 1000 Ω at 1 kHz)

Sensitivity –55 to –70 db (at 1 kHz)

Frequency Range 50 Hz to 16 kHz

Cord Length 6 feet or longer

Plug 3.5 mm monaural phone plug

Line Input Specifications

Signal Level 0.775 Vrms nominal

Input Impedance High (greater than 20 KΩ)

Plug 3.5 mm stereo phone plug

Line Output Specifications

Signal Level 0.775 Vrms into a 600 Ω load

Plug 3.5 mm stereo phone plug

Speaker/Headphone Specifications

Impedance 8 Ω (min)

Plug 3.5 mm stereo phone plug
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Recording an Audio File

The Audio Player works much like a home stereo. It has a record button, a stop 
button, and a play button. It also has a number of recording settings you can
adjust so that the audio file is recorded for the type of device on which it will 
be played. Audio files can be played on almost any computer that has audio
capabilities, including network computers, Personal Computers, and 
workstations.

When a new file is created, the default file settings reflect the device on whic
it will be recorded, in this case, the network computer.

If an existing file is opened, the settings displayed in the Audio Player reflect
the settings at which the file was recorded if the network computer can suppo
the settings. If not, the Audio Player adjusts the settings to best match the 
network computer’s capabilities. To see the exact settings at which the audio 
file was recorded, select the Info command from the File menu.

Before recording, attach any external audio devices. Refer to the Connecting 
External Audio Devices topic on page 4-17.

Before recording, set the recording options as shown here:

Frequency Select a sampling frequency. The higher the frequency, th
clearer the recording. The available frequency settings are 
limited to the network computer hardware. You cannot 
record at a frequency higher than the network computer 
supports. If you try to record at an unsupported frequency, 
a warning displays.

File Format Select a file format. The File Format determines how the 
audio file is stored.

Input Source Select the input source of the audio data: microphone, 
stereo line, video line, or a mix of multiple sources. Refer to 
the Audio Mixer for information about mixing input 
sources. Refer to the Audio Mixer section later in this 
chapter for details about the Audio Mixer.

Stereo This option toggles the stereo option. Select this option to
record in Stereo, or de-select it to record in mono.

Mic Boost This option toggles the Microphone boost option. Select 
this option to increase the sensitivity of the microphone.
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Recording Levels Sets and shows the recording level. Slide the recording lev
indicator to the right to increase the levels. The Left and 
Right feedback area shows the decibel levels during 
recording. If the levels reach the "red area", indicated by red
bars, the recording may be at too high a level. Slide the 
recording indicator to the left to reduce the recording level.

Recording Length Sets a maximum recording time limit (up to 999999 
seconds). Use this option if you want to control the length 
of the recording. When the recording reaches the time limit, 
the player automatically stops recording.

After setting the recording options, you are ready to record:

1. Use the Open command to open an existing file, or to create a new file.

2. Click on the Record button. The recorder starts and continues to record un
you click on the Stop button.

3. To stop recording, click on the Stop button.

4. To rewind to the audio file, click on the Rewind button. The file rewinds to
the beginning.

5. To play the audio file, click on the Play button.

6. To adjust the volume, slide the volume controller to the right to increase the 
volume, or to the left to decrease the volume. Be sure the Sound button is on, 
or pushed in. The Sound button acts as a mute toggle; when it is pushed 
you can hear the sound, when it is off, the sound is muted.

To make recording adjustments, change any of the recording options and go
back to Step 2. Repeat this procedure as needed.

Note: When you use TFTP to access files, some versions of TFTP 
overwrite the file’s contents after the file is recorded when the 
file’s header information is added. If this occurs, use NFS as 
the file access method.
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Playing an Audio File

The Audio Player can play files that have these extensions:

.au — Sun file type

.wav — Microsoft file type

.voc — Sound Blaster file type

.aiff — Macintosh file type

.snd — Macintosh file type

.raw — no file header

Files that do not have an extension are played as raw files.

To play an audio file:

1. Use the Open command on the File menu to open the audio file. When the 
file is opened, use the Info command on the File menu to view the recording 
settings. These settings may differ from the settings displayed on the Aud
Player. The Audio Player settings reflect the current hardware capabilities
The original recording settings may not be available on the hardware, so th
Audio Player automatically adjusts the settings to best match those that a
available with the hardware.

2. Click on the Play button. 

3. To adjust the volume, slide the volume controller to the right to increase the 
volume, or to the left to decrease the volume. Be sure the Sound button is o
or pushed in. The Sound button acts as a mute toggle; when it is pushed 
you can hear the sound, when it is off, the sound is muted.

4. To stop playing the file, click on the Stop button. To restart the file from 
where it stopped, click on the Play button.

5. To rewind the audio file to the beginning, click on the Rewind button.
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Audio File Information

After opening a file that already exists, use the Info command on the File 
menu to display a window with the file’s original recording information. 
Figure 4-7 shows how the filename, frequency, format, channel, and duratio
information are displayed.

Figure 4-7 File Information Window

When opening an existing file, the options displayed on the Audio Playe
reflect the current hardware capabilities. The original recording settings ma
not be available on the hardware, so the Audio Player automatically adjus
the settings to best match those that are available with the hardware.

To close the File Information window, click the CANCEL button.

Closing the Audio Player

To close the Audio Player, select the Quit command from the File menu. Any 
open file information is saved and the player exits.

CANCEL

Filename: /u8/paul/Temp/au.au
Frequency: 8000 Hz
Format: 8-bit u-law
Channels: 1
Duration: 60 seconds
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The Audio Mixer

The Audio Mixer allows you to control the hardware volume for line in
microphone, and prerecorded (digital) sources. You are not required to
the Audio Mixer when recording or playing audio or video files. When 
started, the Audio Mixer displays as shown below:

Figure 4-8 Audio Mixer

The Audio Mixer is like a master volume control, much like the volume control
on a home stereo receiver. The volume control on the stereo receiver contro
the output volume for all the stereo components, such as the tape player and 
CD player. Likewise, the mixer controls the input and output gain for the Line
In, Digital, and Microphone sources.

Each volume control has a toggle Sound button. When clicked on, the sound
heard. When off, the sound is muted until it is selected again. This allows yo
to quickly mute the sound and then to resume.

Starting the Audio Mixer

The Audio Mixer can be started from the Client Launcher, from the remote 
configuration file, or with xpsh.

Starting the Audio Mixer from the Client Launcher

From the Multimedia submenu, select Audio Mixer. The software displays th
Audio Mixer as shown in Figure 4-8.

File

Mixer

Line In Gain: 0 dB

Digital Gain: 0 dB

Microphone Gain: 0 dB
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Starting the Audio Mixer from the Remote Configuration File

The start AUDIO_MIXER command in the remote configuration file (xp.cnf) 
can be used to automatically download and start the Audio Mixer when the 
network computer boots. Refer to the start command in Chapter 2 of the NCD 
NC200/NC400 Network Computer Reference manual for details.

Starting the Audio Mixer with xpsh

xpsh can open the Audio Mixer client, as shown in Figure 4-8. To open the 
Audio Mixer with xpsh, enter this command:

xpsh –display nc_name:0 mixer

Using the Audio Mixer

To use the Audio Mixer to monitor input, adjust the volume levels of the Line
In Gain, Digital Gain, and the Microphone Gain, depending on what you are 
using as the input source(s).

• When playing an audio file, the Audio Mixer sets the output levels for each
of the input sources relative to each other.

• When recording an audio file, the Audio Mixer sets the recording levels of 
the input sources relative to all of the input sources. The combined input 
sources are then recorded as a single source (mixed).

Examples of Using the Audio Mixer

Below are some common examples of using the Audio Mixer.

• You can play a compact disc through the network computer’s speaker (Lin
In) and use the Audio Mixer to control the volume.

• When recording an audio file using the Audio Player, you can open the 
Audio Mixer client and adjust the Line In Gain volume so that you can 
monitor the file as it records. (You are not required to use the Audio Mixer 
when recording an audio file.)

• To selectively record specific segments of an audio source, adjust the Aud
Player so that it is ready to record, open the Audio Mixer, and begin playin
the audio source. When a segment plays that you want, start recording. When 
finished, stop the recording while still listening to the audio source. When 
another segment starts that you want to record, begin recording again. Th
allows you to selectively record only what you want without having to start
and stop the audio source.
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• To record multiple inputs, set the input source on the Audio Player to Mixed
The Audio Mixer now controls the recording volume of each of the input 
sources. For example, to record a presentation with background music an
your voice, set the Line In Gain to a lower level than the Microphone Gain
(The Line In Gain controls the music volume, and the Microphone Gain 
controls the recording volume of your voice through the microphone.) Set
the recording settings on the Audio Player, start recording the music and 
begin speaking into the microphone. When finished, stop the recording an
play back the audio file. Readjust the levels on the Audio Mixer and 
re-record until the relative gains are correctly set.

Keep in mind that after the relative gains for the input sources are set with the 
Audio Mixer, you can then use the Recording Level feature on the Audio Playe
to adjust the multiple sources as a single source at a higher or lower level.

Saving the Audio Mixer Level Settings

To save the level settings from one Audio Mixer session to another, note the d
values for the Line In Gain, Digital Gain, and Microphone Gain and add them
to the start AUDIO_SERVER command in the remote configuration file 
(xp.cnf). The next time the Audio Mixer starts, the dB values are preset.

Closing the Audio Mixer

To close the Audio Mixer, select the Quit command from the File menu.
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Digital Video Player
The Digital Video player allows you to play video files in a video window on 
your network computer. The video file must be in MPEG1 file format. When 
started, the Video Player displays as shown in Figure 4-9.

Figure 4-9 Video Player

The following information about the Video Player is available:

• Starting the Video Player provides information about the various ways of 
starting the Video Player

• Opening a Video File provides information about opening video files

• Using the Video Player provides the steps for playing video files

• Multicast provides information about sending packets from a single point to
multiple receivers
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Starting the Video Player

The video player can be started from the Client Launcher, from the remote 
configuration file, or with xpsh.

Starting the Video Player from the Client Launcher

From the Multimedia submenu, select Digital Video. The Video Player display
as shown in Figure 4-9.

Starting the Video Player from the Remote Configuration File

The start DIGITAL_VIDEO command in the remote configuration file (xp.cnf) 
can be used to automatically download and start the Video Player when the 
network computer boots. Refer to the start command in Chapter 2 of the NCD 
NC200/NC400 Network Computer Reference manual for details.

Starting the Video Player with xpsh

xpsh can start the Video Player client, as shown in Figure 4-9. To open the 
Video Player with xpsh, enter this command:

xpsh –display nc_name:0 vplay

The following vplay options can be set on the xpsh command line:

–h host — specifies the host name or address on which the video file reside
The host must be entered in the network computer’s Internet Host Tabl
in Setup. This host displays in the Video Player’s File Information area.

–f filename and path — specifies the video file name and its entire path. This
file displays in the Video Player’s File Information area.

–a access method — specifies the access method used to access the video
file. Available access methods are tftp , nfs, dap and multicast. NFS is the 
preferred file access method for faster and more accurate data transfer 
rates required by the player. In addition, there is a 16MB limit on files 
transferred with TFTP.

–v volume level — specifies the volume level to use when playing the video
file. Specify a number between 0 and 100, with 0 indicating no volume,
and 100 indicating the loudest volume setting.

–m (Mute) — specifies that the video file plays with no sound.

–c (Color) — specifies that the video file displays in color (used only if the 
video was recorded in color).

–nc (No Color) — specifies that the video file displays in greyscale images.
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–b (Big) — specifies that the video file displays in a frame four times the size
of the original file.

–p  (Play only) — when used with the –h, –f, –a, and –v options, the 
specified file plays without showing the Video Player. The entire file 
plays and cannot be interrupted.

–all (Play All; software player only) — plays all frames in a video file. 
Frame scheduling is ignored and the audio will not be in sync.

–title “string” — assigns a title for the vplay windows.

–propcmd — creates properties that allow other clients to send command 
strings to the Video Player. These properties can be used to control th
Video Player from another client. For details about the properties, se
the vplay man page.

–brightness n — sets the brightness level of the video file. Specify a number
between –50 and +50.

–contrast n — sets the contrast level of the video file. Specify a number 
between –50 and +50.

–BUFSIZE n — (hardware player only) specifies the size of the Video 
Player’s memory buffer (in kilobytes). The value defaults to 1024 and 
can not be set lower than 1kilobyte. If the value specified is greater 
than available memory when trying to play a file, the Video Player 
reduces its buffer to the available memory.

– CHKSIZE  n — (hardware player only) specifies that the Video Player’s 
memory buffer is divided into “chunks”, measured in kilobytes. The 
network fills the chunks, and the Video Player empties them as they
are accessed. The default is 32, which divides the buffer into 32 
kilobyte chunks. If the chunk size is set to a number larger than the
buffer size, the chunk size will be truncated to one half the buffer size. 
The chunk size cannot be set less than 1 kilobyte.

– CHKDELAY n — (hardware player only) specifies the time delay (in 
milliseconds) that the Video Player waits following each read reques
that fills a chunk.
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Examples

This example opens the Video Player on the network computer named sierra:

xpsh  –display sierra:0 vplay

This example opens the Video Player with the host portland and the video file 
/usr/adam/scene.mpg preloaded in the Video Player’s File Information Area:

xpsh  –display sierra:0 vplay –h portland –f /usr/adam/scene.mpg –a 
tftp

This example plays the video file /usr/adam/scene.mpg (located on the host 
portland) in color and with no sound on the network computer without showing
the Video Player:

xpsh –display sierra:0 vplay –h portland –f /usr/adam/scene.mpg –a 
tftp  \ –c  –m –p 
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Opening a Video File

The Open command on the File menu opens and displays an existing video file
Video files must be in MPEG file format only.

1. Select the Open command from the File menu. The File Selection window 
appears as shown in Figure 4-10 

Figure 4-10 File Selection Window

2. To select the access method to use, position the mouse pointer on the NF
button and click. A drop down menu displays the available methods: TFTP
NFS, or DAP. The File Selection window changes to reflect the chosen 
access method.
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Using TFTP Access

The File Selection window in Figure 4-11displays when tftp is the access met

Figure 4-11 TFTP File Selection Window

Note: Use tftp as the access method only if NFS is not available. NFS 
provides better and more accurate data transfer rates required 
to maintain continuous audio and video stream. 

If using tftp as the access method, and you attempt to play a file 
that is greater than 16MB of MPEG data, the Digital Video Player 
ignores the remaining data after 16MB has been reached.

In addition, inherent limitations in tftp prevent fast forward 
and fast rewind from being supported.
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Host

TFTP

Path

OK CANCEL

134.62.18.81

/u8/paul/Temp/au.au
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1. Enter the name or address of the host on which the file is located in the Ho
field.

2. Enter the file’s path, filename, and extension in the Path field. The file mus
be an MPEG file.

3. Click OK. The host and file names display in the File Information Area.

Using NFS Access
The File Selection window displays when NFS is the access method.

Figure 4-12 File Selection window when NFS is the access method
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NFS
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To use the File Selection window when NFS is the access method:

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

3. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that 
directory are listed in the Files area.

4. Select the file you want in the Files area. The full path and filename prefills 
in the Selection field. The file must be an MPEG file.

5. Click OK. The host and file names display in the File Information Area.
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Using DAP Access

The File Selection window shown here displays when DAP is the acces
method.

Figure 4-13 File Selection window when DAP is the access method

1. Enter the node name or address in the Node field. This is the node on whi
the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas. 
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DAP

Filter

Selection

Apply Filter

OK CANCEL

Directories Files
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4. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that 
directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename prefills 
in the Selection field. The file must be an MPEG file.

6. Click OK. The host and file names display in the File Information Area.
Network Computer User 4-35



Chapter 4 Using Advanced Features

4-3

r 

n, 
in, 
Playing a Video File

After opening the video file using the Open command, use the Control Buttons 
to play the file:

1. Click on the Play button to start playing the specified file. The video playe
plays MPEG files only. 

Note: If the file does not play, check the Console for messages. If the 
file is not an MPEG file format, the console displays the 
following message: <FileName> is not an mpeg file!

If the video file includes audio, the Audio Player must be set 
to a sample frequency rate of 8000Hz. Otherwise, the audio 
will not play.

2. To stop playing the file, click on the Stop button.

3. To rewind the video file to the beginning of the file, click on the Rewind 
button.

4. To advance one frame at a time, click on the Forward button. This button is 
not available if using TFTP as the file access method.

5. To fast forward through the file, click and hold the Fast Forward button. 
Release the button when you want to stop. Refer to the Fast Forwarding and 
Rewinding topic on page 4-37 for more information.

6. To fast rewind through the file, click and hold the Fast Rewind button. 
Release the button when you want to stop. Refer to the Fast Forwarding and 
Rewinding topic on page 4-37 for more information.

7. To adjust the volume, slide the volume controller to the right to increase the 
volume, or to the left to decrease the volume. Be sure the Sound button is o
or pushed in. The Sound button acts as a mute toggle; when it is pushed 
you can hear the sound, when it is off, the sound is muted.
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While playing the video file, use the following controls to adjust the size and
color of the video file.

Size Plays the video in the size it was recorded (1X), or in a video
window four times the size it was recorded (4X).

Black/White Plays the video in color, or in greyscale. Turn this option on
to play the file in black and white, or off to play the file in 
color.

Contrast Sets the contrast level. Slide the level indicator to the left to
decrease contrast levels, or to the right to increase the 
contrast levels.

Brightness Sets brightness level. Slide the level indicator to the left to
decrease brightness levels, or to the right to increase the 
brightness levels.

Fast Forwarding and Rewinding

The Fast Forward and Fast Rewind functions allow you directly access any part 
of a video file. By using the Video Player’s Fast Forward and Fast Rewind 
buttons or position slider, you can start playback from any location in a file, o
replay a portion of a file any number of times, without having to start at the 
beginning.

Note: The Fast Forward, Fast Rewind, and Position Slider are not 
available if using TFTP as the file access method.

The slider (NFS only) and time-code window let you see how much of a file ha
already played. The slider represents a time index corresponding to the time
code embedded in the MPEG stream. If the stream begins at zero, the time co
acts as a simple timer of how long the video is. Whether you use the buttons 
slider, the time-code window displays the time code of the current frame 
location in hours, minutes, and seconds. Both the slider and window are 
updated dynamically during playback.

To fast forward or fast rewind using the position slider, do the following:

1. Using any mouse button, grab and drag the slider to the right to fast forwa
or to the left to rewind.

2. Release the button when you reach the desired location.
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To fast forward or rewind using the Video Player’s buttons, do the following:

1. Using any mouse button, press and hold the fast forward or fast rewind 
button.

2. Release the button when you reach the desired location.

As you drag the slider or press the fast forward or fast rewind button, the vide
window is updated, displaying intermediate video portions. When you releas
the slider or button, the video player returns to its previous state. For exampl
if a video was playing when you repositioned the slider or pressed the button
the video restarts when you release it. If a video was on pause, it remains on
pause.

As mentioned, you can use any mouse button to drag the slider. However, if y
click on the first mouse button when the mouse is within the position slider track 
(but not on the slider button), the slider moves a tiny bit to that side of the slide
button, no matter where in the track you place it. Essentially, the video is 
repositioned to the nearest MPEG Group of Pictures (GOP) boundary 
(generally about 1/2 second). If you press the second mouse button when it’s in 
the slider track, the file is positioned at that location.

Multicast

Multicast is a way to send packets from a single point to multiple receivers. Th
receivers can determine when and if they receive the Multicasted packets. 
Multicast video takes advantage of networks that support Multicasting to 
decrease network bandwidth and provide a means of easily accessing video
information.

The Digital Video player allows you to play video files in a video window on 
your network computer using Multicast. The video file must be in MPEG file 
format.

Note: Multicast is only available on XP400, NC200, and NC400 
network computers.

Channels

Channel changing is an interface that maps “channel” numbers to Multicast 
addresses. This mapping is made in the remote configuration file (xp.cnf) and 
remains fixed until the network computer is rebooted.
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Selection of a channel causes the client to cease reception on any current 
channel and attempt to join a transmission in progress on the selected chann
The client begins reading data from the Multicast IP address. When it reads 
sufficient data to properly set up the window size, the view window resets its
size. A default sized window is started before this happens.

Choosing Multicast Channels

1. Edit the video_multicast_entry command line in the remote configuration 
file (xp.cnf) to set your Multicast channel options. (Refer to the 
video_multicast_entry command in Chapter 2 of the Reference Manual.) 
These channels display on the Video Player’s Multicast menu option. If you
omit this step, the Video Player does not display the Multicast menu.

2. In the Video Player, click on the Multicast menu to display the available 
channels.

3. Select the channel from the Multicast menu. The Video Player starts as so
as something is received on that channel.

The example below has two parts. The first part sets up the channels “Blu
Channel”, “Rock Channel”, and “News Channel” using the 
video_multicast_entry command in the xp.cnf file.

video_multicast_entry “224.200.50.10” “3000” “Blues Channel”

video_multicast_entry “224.200.50.11” “3000” “Rock Channel”

video_multicast_entry “224.200.50.11” “3001” “News Channel”

The second part of the example starts a Multicast session and plays the s
Multicast channel in the Multicast channel array (in this example, “Rock 
Channel”) set in the remote configuration file (xp.cnf).

xpsh –display twinkle:0 vplay –chan 2
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Multicast Options

The following Multicast options can be added to the xpsh command line when 
starting the Digital Video Player:

Note: Where indicated, the following vplay options apply to both 
broadcast and Multicast, though in different ways. Only 
information relevant to Multicasting is included below.

–h host — specifies the Multicast IP address. This address must be the same
the address being used by the Multicast server. See your system 
administrator for valid choices.The address displays in the Video Player’
Addr/Port Information Area.

–f filename — specifies the Multicast port number. This port number must be
the same as the port number being used by the Multicast server. See yo
system administrator for valid choices. The port number displays in the 
Video Player’s Addr/Port Information Area.

–chan n — specifies an index into an array of available Multicast channels. 
(Refer to the Channels topic on page 4-38 and video_multicast_entry in 
Chapter 2 of the Reference manual.) Do not use with the –h, –f, –a, or –text 
options.

–text “string” — specifies the channel string displayed by the Video Player. Do
not use with the –chan option.

–a access method — specifies the access method used to access the video file. 
Use Multicast when Multicasting.

Example

This example starts the Video Player and plays the video being Multicast on I
address 224.200.50.1, port 3000. The Video Player displays the text “The Blu
Channel”.

xpsh –display  twinkle:0 vplay  –h 224.200.50.1 –f 3000
\–a MULTICAST –text “The Blues Channel”
0 Network Computer User
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The Video Player opens displaying the Multicast menu as shown in Figure 
4-14.

Figure 4-14 Video Player with Multicast Menu

When viewing a Multicast video, the Forward, Fast Forward, Rewind, and Fas
Rewind buttons are not operational. However, the time index (displayed in th
Time Code Window) shows the current time code within the current video 
segment of the Multicast video. You can note the video segment number an
load it at a later time as a file, reposition to a specific location, and review a 
segment of the video previously seen during a Multicast session.

Closing the Video Player

To close the Video Player, select the Quit command from the File menu. Any 
open file information is saved and the player exits.
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Analog Video Player
The Analog Video Player enables you to view NTSC (National Television 
System Committee) or PAL (Phase Alternation Line-rate) sources in a window
on the network computer’s display (XP300V). Common NTSC and PAL video
sources are VCR’s, video disc players, video cameras, and television tuners. 
When viewing a video on the network computer, you can control the volume
window size and placement, and color settings. When started the Analog Vide
Player displays as shown in Figure 4-17.

Figure 4-15 Analog Video Player

The Analog Video player requires the analog hardware. Not all network 
computer models have the analog hardware. 

Before using the Analog Video Player, the xv server extension must be enable
If the analog hardware is present, the xv server downloads automatically whe
the network computer boots. If for some reason the xv server extension is 
disabled, use the enable_xv command in the remote configuration file to enable 
it. Refer to Chapter 2 Remote Configuration in the Network Computer 
Reference Manual for details.
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The following information about the Analog Video Player is available:

• The Starting the Analog Video Player topic on page 4-44 provides 
information about the various ways of starting the Analog Video Player.

• The Connecting The Network Computer to an Analog Video Device topic on 
page 4-45 provides information about the ports on the network computer an
connecting the video device.

• The Using the Analog Video Player topic on page 4-46 provides the steps for 
viewing analog video sources.
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Starting the Analog Video Player

The Analog Video Player can be started from the Client Launcher, from the 
remote configuration file, or with xpsh.

Starting the Analog Video Player from the Client Launcher

From the Multimedia submenu, select Analog Video. The Analog Video 
Player displays as shown in Figure 4-17.

Starting the Analog Video Player from the Remote Configuration File

The start ANALOG_VIDEO command in the remote configuration file 
(xp.cnf) can be used to automatically download and start the Analog Video
Player when the network computer boots. Refer to the start command in 
Chapter 2 of the Network Computer Reference manual for details.

Starting the Analog Video Player with xpsh

xpsh can start the Analog Video Player client, as shown in Figure 4-17. To
open the Video Player with xpsh, enter the following:

xpsh –display nc_name:0 xpvideo 

The following options can be set on the xpsh command line:

–encode specifies the encoding format. Specify either NTSC, which is 
commonly used in the United States; or PAL, commonly used in
Europe.

–source specifies the video source to which the video device is connected
Specify either COMPOSITE_1, COMPOSITE_2 or SVIDEO1.

–color specifies the color intensity of the video being played. Specify a
number from –1000 to 1000. 0 is the default.

–bright specifies the color brightness intensity of the video being played
Specify a number from –1000 to 1000. 0 is the default.

–contrast specifies the color contrast intensity of the video being played. 
Specify a number from –1000 to 1000. 0 is the default.

–tint specifies the color tint of the video being player. Specify a 
number from –1000 to 1000. 0 is the default.
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Connecting The Network Computer to an Analog Video Device

To use the Analog Video Player, first connect the video device to the networ
computer. The Analog Video Player plays NTSC and PAL video encoded 
sources.

Note: Refer to your video source user manual for cabling and 
encoding information.

There are several ports on the back panel of the network computer used for
analog video. Connect composite sources to the Port 1 Composite, Port 2 
Composite, or Port 1 SVideo ports. Refer to Figure 4-16 for the location of the 
video ports.

Figure 4-16 Back Panel Showing Audio and Video Ports

Note: You cannot have two video devices connected to Port 1 
Composite and Port 1 SVideo at the same time.

Right and Left 
audio ports

SVIDEO port

Composite 1 and 2 video ports 
(1 is on the bottom)
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Using the Analog Video Player

When the audio device is connected, you are ready to view the video on the
network computer. When started, the Analog Video Player displays the vide
options as shown in Figure 4-17. (The Video button on the player is depresse

Figure 4-17 Analog Video Player Video Options

To play a video on the network computer:

1. Connect the video source to the network computer. Refer to the Connecting 
The Network Computer to an Analog Video Device topic on page 4-45 
section.

2. Click on the Play button. A separate XPVIDEO window displays which is 
used to view the video. (This does not affect the video source. You must start 
the video source with its own play function.) The icon below the File menu 
changes to include a viewer window. If the viewer window is obstructed by
other windows, clicking on this icon brings the viewer window to the top.

3. To adjust the volume, slide the volume controller to the right to increase the 
volume, or to the left to decrease the volume. Be sure the Sound button is o
or pushed in. The Sound button acts as a mute toggle; when it is pushed 
you can hear the sound, when it is off, the sound is muted.
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4. To freeze a frame, click on the Pause button. This displays the frame in the 
viewer window, however, has no effect on the video source and it continues 
to play. Click on the Play button to resume viewing the video source.

5. To stop viewing the video, click on the Stop button. This has no effect on the 
video source and it continues to play. 

While viewing a video, you can control the following window attributes:

Brightness Sets the brightness level. Slide the level indicator to the le
to decrease brightness levels, or to the right to increase the 
brightness levels.

Color Sets the color level, or intensity. Slide the level indicator to
the left to decrease color intensity, or to the right to increase
the color intensity.

Contrast Sets the contrast level. Slide the level indicator to the left to
decrease contrast levels, or to the right to increase the 
contrast levels.

Tint/Hue Sets the tint, or hue, levels. Slide the level indicator to the 
left to decrease the tint/hue levels, or to the right to increase 
the tint/hue levels.

Restore Restores the video player options to the default settings.

View Menu The View Menu contains the ResetSize command. This 
command returns the viewer window to its default size.
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Clicking on the Settings button displays the Settings options as shown in Figu
4-18.

Figure 4-18 Analog Video Player Settings Options

You can change these settings:

Source Specifies the video source to use: Port 1 Composite, 
Port 2 Composite, or Port 1 SVideo.

Encoding Specifies the encoding format. Specify either NTSC, 
which is commonly used in the United States; or PAL, 
commonly used in Europe.

Black/White Specifies whether the image in the viewing window 
displays in color or in black and white. 

Auto Gain Control Specifies the Automatic Gain Control setting. When 
turned ON, the video signal is automatically 
amplified for best picture quality.

Note: The Tuner options are not available at this time. 
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Aspect Ratio Specifies the window sizing attributes. Aspect ratio is 
when the relative proportion of the video window’s width 
and height is preserved when resizing the window. When
ON, the window size is automatically adjusted to 
preserve the aspect ratio. If OFF, you can resize the 
window to any size and the aspect ratio will not be 
maintained.

Overscan Specifies whether the image in the viewer window is in
overscan mode. If ON, the full image displays. If OFF, 
the image is reduced by 10% to match the viewing area 
of typical consumer television screens.

Field Duplicate Specifies whether the Analog Video Player uses field 
duplication. Field duplication is used primarily to 
eliminate blurred images when viewing fast motion 
videos or images generated by graphics systems such as 
video games. AUTO specifies that the player determines
whether to use field duplication based on the video 
window size.

Horizontal Positions the contents of the view window horizontally. 
Slide the indicator to the left or right to move the contents 
of the viewer window left and right.

Vertical Positions the contents of the view window vertically. 
Slide the indicator to the left or right to move the contents 
of the viewer window up and down.

View Menu The View Menu contains the ResetSize command. This
command returns the viewer window to its default size.

Closing the Analog Video Player

To close the Analog Video Player, select the Quit command from the File 
menu.
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The XIE viewer displays an image file using the XIE protocol. The viewer 
allows you to manipulate a displayed image in the following ways:

• Select pages when a multiple page file is loaded

• Rotate the image window by 0, 90, 180 and 270 degrees

• Zoom (enlarge) an area of an image

When started, the XIE Viewer displays as shown in Figure 4-19.

Figure 4-19 XIE Viewer
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The XIE Viewer supports these formats:

tif — TIFF image file0 pgm — Portable Graymap format
tiff — TIFF image file ppm — Portable Pixmap format

gif — GIF87a format bpcm — bitonal pcm
jpg — MPEG file interchange format bg31 — bitonal G31D compressed

gjpg — MPEG file interchange format bg32 — bitonal G32D compressed
cjpg — MPEG file interchange format bg42 — bitonal G42D compressed

jfif — MPEG file interchange format gpcm — greyscale pcm
bmp — Bitmap format cpcm — color (rgb) pcm

pbm — Portable Bitmap format fax — raw G3 fax with no headers

Starting the XIE Viewer

The XIE Viewer can be started from the Client Launcher, from the remote 
configuration file, or with xpsh.

Note: XIE requires an authorization key. XIE must also be enabled 
before using the XIE viewer.

Starting the XIE Viewer from the Client Launcher

From the Multimedia submenu, select XIE Viewer. The XIE Viewer displays
as shown in Figure 4-19.

Starting the XIE Viewer from the Remote Configuration File

The start XIEVIEW command in the remote configuration file (xp.cnf) can be 
used to automatically download and start the XIE Viewer when the network
computer boots. Refer to the start command in Chapter 2 of the NC200/
NC400 Network Computer Reference manual for details.
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Starting the XIE Viewer with xpsh

xpsh can open the XIE Viewer client (shown in Figure 4-19). To open the
XIE Viewer with xpsh, enter the following:

xpsh –display nc_name:0 xieview

The following options can be set on the xpsh command line:

–ifg colorspecifies the color used as the foreground on bitonal images. Th
color specified must be in the network computer’s rgb.txt file.

–ibg colorspecifies the color used as the background on bitonal images. Th
color specified must be in the network computer’s rgb.txt file.

–cc colorspecifies the background color for the image window. The color 
specified must be in the network computer’s rgb.txt file.

–f filename and path
specifies the XIE file name and its entire path. This file displays
when the XIE Viewer is started. The file name and path is 
displayed in the File Information Area on the XIE Viewer client.

–fullpan True or False
If True, the image uses less memory when zoomed. If False, th
image uses more memory when zoomed. When set to False
panning the image is faster. If there is not enough memory to
view the entire zoomed image, only part of the image will be 
available when panning. The default is True.
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Opening and Displaying an Image File

The Open command on the File menu opens and displays an existing XIE file
in a separate viewing window.

1. Select the Open command from the File menu. The File Selection window in 
Figure 4-20 appears.

Figure 4-20 File Selection window

2. To select the access method to use, position the mouse pointer on the NF
button and click. A drop down menu displays the available methods: TFTP
NFS, or DAP. The File Selection window changes to reflect the chosen 
access method.

File Selection

Filter

NFS

Directories

Selection

Apply Filter

OK CANCEL

Files
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Using TFTP Access

The File Selection window in Figure 4-21 displays when tftp is the access 
method.

Figure 4-21 File Selection window for TFTP access

Note: If using tftp as the access method to display an image file, the 
XIE Viewer cannot display a file that is greater than 16MB. 
If you attempt to view a file larger than 16MB, the viewer will 
ignore the file.

Use tftp as the access method only if NFS is not available. 
NFS provides better and more accurate data transfer rates 
required to maintain continuous data stream.

File Selection

Host

TFTP

Path

OK CANCEL

134.62.18.81

/u8/paul/Temp/au.au
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1. Enter the name or address of the host on which the file is located in the Ho
field.

2. Enter the file’s path, filename, and extension in the Path field. Files with th
following extensions can be viewed on the XIE Viewer:

gif — GIF87a format ppm — Portable Pixmap format

jpg — JPEG file interchange format bpcm — bitonal pcm

gjpg — JPEG file interchange format bg31 — bitonal G31D compressed

cjpg — JPEG file interchange format bg32 — bitonal G32D compressed

jfif — JPEG file interchange format bg42 — bitonal G42D compressed

bmp — Bitmap format gpcm — greyscale pcm

pbm — Portable Bitmap format cpcm — color (rgb) pcm

pgm — Portable Graymap format fax — raw G3 fax with no headers

Note: TIFF and TIF images require random access capability and 
tftp does not support random access. To view TIFF or TIF 
files, use NFS as the access method.

3. Click OK. The host and file names display in the File Information Area, and
the image displays in a separate view window. If the file does not appear,
look in the Console for status messages.
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Using NFS Access

The File Selection window shown in Figure 4-22 displays when NFS is the
access method.

Figure 4-22 File Selection window for NFS access

1. Enter the NFS mount point in the Filter field.

2. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

3. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that 
directory are listed in the Files area.

File Selection

Filter

NFS

Directories

Selection

Apply Filter

OK CANCEL

Files
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4. Select the file you want in the Files area. The full path and filename prefills 
in the Selection field. You can view files with these extensions on the XIE
Viewer:

tif — TIFF image file pgm — Portable Graymap format

tiff — TIFF image file ppm — Portable Pixmap format

gif — GIF87a format bpcm — bitonal pcm

jpg — JPEG file interchange format bg31 — bitonal G31D compressed

gjpg — JPEG file interchange format bg32 — bitonal G32D compressed

cjpg — JPEG file interchange format bg42 — bitonal G42D compressed

jfif — JPEG file interchange format gpcm — greyscale pcm

bmp — Bitmap format cpcm — color (rgb) pcm

pbm — Portable Bitmap format fax — raw G3 fax with no headers

5. Click OK. The host and file names display in the File Information Area, and
the image displays in a separate view window. If the file does not appear,
look in the Console for status messages.
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Using DAP Access

The File Selection window shown in Figure 4-23 displays when DAP is the
access method.

Figure 4-23 File Selection window for DAP access

1. Enter the node name or address in the Node field. This is the node on whi
the file is located.

2. Enter the file’s path and directory in the Filter field.

3. Click on the Apply Filter button. All subdirectories and files are listed in the
Directories and Files areas.

File Selection

Node

DAP

Filter

Selection

Apply Filter

OK CANCEL

Directories Files
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4. To view files in a different directory, click on the directory name in the 
Directories area, and then click on the Apply Filter button. The files in that 
directory are listed in the Files area.

5. Select the file you want in the Files area. The full path and filename appea
in the Selection field. You can view files with these extensions on the XIE
Viewer:

tif — TIFF image file pgm — Portable Graymap format

tiff — TIFF image file ppm — Portable Pixmap format

gif — GIF87a format bpcm — bitonal pcm

jpg — JPEG file interchange format bg31 — bitonal G31D compressed

gjpg — JPEG file interchange format bg32 — bitonal G32D compressed

cjpg — JPEG file interchange format bg42 — bitonal G42D compressed

jfif — JPEG file interchange format gpcm — greyscale pcm

bmp — Bitmap format cpcm — color (rgb) pcm

pbm — Portable Bitmap format fax — raw G3 fax with no headers

6. Click OK. The host and file names display in the File Information Area, and
the image displays in a separate view window. If the file does not appear,
look in the Console for status messages. 
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Viewing Options

The image from the file is displayed in a separate XIE Viewer window. Use th
following XIE Viewer options when viewing an image:

1. To display the first page in a multi-image file, click on the First Page button

2. To display the last page in a multi-image file, click on the Last Page butto

3. To display the next page in a multi-image file, click on the Next Page butto

4. To display the previous page in a multi-image file, click on the Previous Pag
button.

5. To rotate the image, click on the Rotation button, either 90, 180, 270, or 0
Rotation of the image will not resize the XIE Viewer window. When an 
image is rotated, zoomed images are returned to normal size.

Enhanced Enables anti-aliasing of the image. This may result in improved
readability of the image.

100% This button removes the effect of zooming.

Page Displays other pages in a multi-image file. Move the slider to the
right and left to view other pages in the file. The current page 
number displays in the Page field.

Zooming To zoom the image, position the mouse pointer at some point in
the image, then click and drag over the desired area. A rectangl
appears over the image to indicate the selected area. When you 
release the mouse button, the selected area is scaled up to fit th
window. You can zoom an image any number of times. Scroll 
bars on both the right and bottom of image display window allow
you to pan the enlarged image.

Closing the XIE Viewer

To close the XIE Viewer, select the Quit command from the File menu. Any 
open file information is saved and the player exits.
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WinDD ICA Client
The WinDD ICA client provides access to PC servers running Microsoft’s
Windows NT Terminal Server Edition and Citrix Metaframe software. Once
you are logged in to the PC server, you can run Windows NT and DOS base
applications.

Note: DOS graphics applications are not supported (even if started 
from the DOS Command Prompt in the Main  folder). DOS 
applications can only be run in character (text) mode. Refer 
to each application for startup options to invoke the 
application in this mode. If you try to run a DOS graphics 
application, an error is generated and the application 
terminates.

Starting Local WinDD ICA Client

The WinDD ICA client can be started using the Client Launcher, TekHostMenu, 
the remote configuration file or from the command line with xpsh.

Starting WinDD from the Client Launcher

From the Host Connections submenu, select WinDD. The WinDD local clien
is illustrated in Figure 2-14.

Starting WinDD from TekHostMenu

Click the WinDD button (if necessary) to access the WinDD list. Click on a 
server, or enter the server name or address in the Application Server box.

Starting WinDD with xp.cnf

The start WINDD command in the remote configuration file (xp.cnf) 
automatically downloads and starts WinDD when the network computer boot
Refer to the start command in Chapter 2 of the Network Computer Reference 
manual for details. Related WinDD remote configuration commands include:

host_connect_method default_host_list
windd_menu_entry windd_auto_connect
windd_auto_reconnect windd_size
default_windd_host windd_host_entry
windd_menubar windd_entrybox
start preload
flash_feature windd_auto_numlock
windd_keysym_only windd_exit_on_logout
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Starting WinDD with xpsh

xpsh starts the local WinDD client as needed. Enter the following (where 
nc_name is the name or address of your network computer):

xpsh –display nc_name:0 windd [options]

The following options can be set on the xpsh command line. If an option is not 
specified, the default setting is used.

–display nc:0
Specifies the network computer (nc) name or address to display the 
WinDD local client.

–c Auto-connect to the first application server in the application server list
If there are no application servers in the list, this option is ignored and
the client window is displayed.

–nc Do not auto-connect to an application server. (Default)

–d Displays the menu bar and the internal borders. (Default)

–nd Does not display the menu bar or the internal borders. For example, th
allows a 1280x1024 WinDD window to fully display on a 1280x1024 
monitor (minus windows manager decorations).

–e Enables the Application Server edit field window so that users can add 
application servers to the application server list. (Default)

–ne Disables the Application Server edit field window so that users are not 
allowed to add application servers to the application server list.

–floppy
Allows supported host versions of WinDD to use its local floppy drive 
as a network connected drive for the application server. Only the first
host client to specify this option will be allowed to use the floppy 
device. NOTE: For host clients (with local floppy drive) only.

–no_floppy_cache
Disables use of local floppy write cache. This is a fail-safe option to 
ensure the entire file has been updated in the event a user suddenly 
ejects a disk mechanically (when disks are ejected via the GUI button
that process flushes the cache so no information is lost).

–geometry <geometry>
Standard X11 geometry option, <WidthxHeight+X+Y>.
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–h <application server>
Adds the named application server(s) to the application server list. 
Multiple application servers can be added to the list by listing them 
separated by spaces.

–help
Displays a brief help list on the available WinDD command line 
options.

–initprog  <prog> [–initdir  <dir> ]
Specifies the application to execute upon application server login. Th
login session is terminated when the application is terminated.

Prog specifies the application and can also specify its path (up to 259
characters) and parameters. The program path and name are written
consecutively (and not separated by a space) when they are both 
specified in prog. A space separates the program name and its 
parameters. These parameters are program specific and can specify 
program settings or data files to invoke on execution.

Dir  specifies the path of the executable program.

–keysym_only
Specifies that all NCD network computer keyboards are supported with
keysym translations within WinDD.

–local_numlock
Specifies that WinDD manages the state of the Num_Lock independen
of any Xserver support.

–no_auto_numlock
Specifies that WinDD does not control the Num_Lock setting.

–login <username> [pass <passwd>] [–domain <domainname>]
Specifies the application server user account login name, login 
password, and domain. These values will be used for user account 
verification.

When using a WinDD client and connecting to an application server, 
your username, password, domain, initial program, and initial directory
are encrypted as they are sent across the network.

Username, password, domainname, dir, and prog are not viewable or 
changeable from the WinDD configuration window.
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–r Reconnect to the application server after log off.

–nr Does not reconnect to the application server after log off. (Default)

–version
Displays the WinDD version in use. (If the license is 8019, this option
also prints For evaluation purposes only.)

–x Exits the WinDD client upon logging out of, or disconnecting from, the 
application server.

–nx Does not exit the WinDD client upon logging out of, or disconnecting 
from, the application server. (Default)

–force_xcursor
Specifies that monochrome pointers within the WinDD desktop are to
be implemented using X cursors. Some monochrome pointers are xor’d 
with the underlying desktop. When this switch is specified, it is no 
longer xor’d, as X cursors do not support that mode.

Note: The force_xcursor feature is intended to compensate for 
workstations that do not have a particularly high 
performance X server. Consider using this option if the 
pointer flashes when move, or poor performance is observed 
entering text in dialog boxes. Using this switch improves user 
interactivity. The only side effect is the pointer is displayed in 
a single color.

–compress
Enables compression of ICA network data to and from the WinDD 
client.

–no_compress
Disables compression of ICA network data to and from the WinDD 
client.

–max_compress_disable
Disables compression for n number of outgoing ICA commands from 
the WinDD client. The default is 0, which enables all compression. 
Count setting of 0 might “compress” client data larger than its original
size during start of login session. Settings larger than 0 restrict 
expansion of the client data.
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–a published_app
This allows an ICA session to connect to any published application on
a WinFrame/MetaFrame-based server. The argument published_app is 
the name of the published application. 

xp.cnf compression commands
windd_compress ““ #ENABLED | DISABLED

windd_max_compress_disable 0#[<ICA command count>]

Configuring your WinDD ICA Session from the Client Screen

From the WinDD ICA client screen (Figure 4-24), you can easily change you
session attributes before you log in to a server.

WinDD

Options

Application Server

Application Server:

Clear Console Configure Cancel Exit WinDD

Reconnect After Logoff

WinDD Message Console

Help

9210-1

Disk
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Figure 4-24 WinDD Client Screen

The Configure button brings up the WinDD Resolution dialog illustrated in 
Figure 4-25. The resolution determines the size of the WinDD window. The 
resolution must be selected prior to making a connection to the application 
server and cannot be interactively changed until the connection has been clos
The Configure button performs the same function as the Options ⇒ Configure 
pull down menu choice.

Figure 4-25 WinDD Configuration Dialog

The Reconnect After Logoff button enables automatic reconnection to the 
application server after you have logged off of a WinDD session. If this button
is on, then the WinDD log in screen (Figure 2-16) appears when you select 
File ⇒ Logoff from a Windows NT session. If this button is off, the WinDD 
client screen is displayed when you log off a session.

WinDD messages about connection status, error conditions, or other necess
user feedback appear in the message console area. All message are also se
the network computer system console so that the information is available eve
if WinDD has been terminated. Use the Clear Console button to clear 
messages.

When configuration is complete, select the application server for your sessio
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Selecting an Application Server

The WinDD ICA client screen displays a list of application servers your system
administration defined for you. Use the mouse to select one of the servers fro
the list. If the application server you want to access is not on the list, enter th
name or address in the Application Server: field and press Enter. WinDD log in 
information is in Chapter 2, Operating the Network Computer.

WinDD Local Client Options Menu

There are two ways to access the local client Options menu:

1. Select Options from the local client menu bar (Figure 4-26).

Figure 4-26 Local Client Options Pull Down Menu

2. Hold down Shift and Ctrl and click the middle mouse button (Figure 4-27)
This method is only available after you have a server connection.

Figure 4-27 Local Client Options Menu

Options Help

Log On

Send Ctl+Alt+Del

Configure

Disk

Exit

OK

Log On

WinDD Options Menu

Exit WinDD

Ctrl+Alt+Del
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Log On

• Toggles between the WinDD session window and the WinDD ICA client 
screen. This is only available after you have a server connection. The Cancel 
button on the client screen returns you to the session window.

Configure

• Brings up the WinDD Resolution dialog (Figure 4-25). This is only available
before you have a server connection.

Exit

• Closes the WinDD client.

WinDD Help Menu

The WinDD Help Menu presents WinDD copyright and version information.

Figure 4-28 WinDD Help Menu

Options Help

About WinDD

9210-4
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PSXpress
After installing the Adobe software, add the following configuration 
information to the users’ environments (typically in their.login or .cshrc files). 
The contents of this section can also be found in the file user.adobe.

Note: Users’ execution path, X resources, and PostScript resources 
must be defined correctly for all of the Adobe software demos 
to work. 

Changing Execution Paths

Add the following directory to the execution paths or PATH variables: /tekxp/
bin/<host>, where <host> is sun, solaris, or hp.

For example, assuming that the installation location at your site is /export /
tekxp, the following commands change a user’s execution path to run Adobe
software on a SunOS 4.1.3 system:

# setenv PATH /export /tekxp/bin/sun4:”$PATH”
# rehash

Integrating Icons into an OpenWindows Desktop

To integrate Acrobat Reader icons into an OpenWindows desktop, run the 
olwm.deskinstall script. You can run this script as root, or from your login 
account. 

If you are root, the binder rules are defined on a system-wide basis in /etc /
cetables/cetables. If you run the script as a normal user, the binder rules are 
installed in $HOME/.cetables/cetables.

Follow these steps for system-wide installation:

1. In a UNIX shell window, as root, locate the olwm.deskinstall script:

# cd /tekxp/AcroRead_2.1 /desktop

2. Run the olwm.deskinstall script:

# ./olwm.deskinstall

After the script has been installed, a message appears, indicating that you
have successfully installed the software:

3. For the changes to take effect, log off of the OpenWindows window 
manager, and log back on. 
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Using Display PostScript NX with Sun AnswerBook

To run AnswerBook on Solaris systems, first verify that:

• The Sun Patch version 101654-02 or later is present on your Solaris syste

• The DpsNx group was installed from the XpressWare media.

To run AnswerBook:

1. Add the following to the LD_LIBRARY_PATH environment variable:

<install_directory>/tekxp/dpsnx_2.1/common/ lib

Add this line before the /usr/openwin/lib entry.

2. Set the display variable, where nc_name is the network computer’s name:

# setenv DISPLAY nc_name:0

3. Run the execnx command:

# execnx &

4. Run AnswerBook:

# answerbook

X Resources and Application Defaults

Add the following template to the value of the user’s XFILESEARCHPATH 
variables: 

/tekxp/dpsnx_2.1/common/app-defaults /%N.ad

PostScript Resources

Add the following directory to the user’s PSRESOURCEPATH environment 
variables. The PSRESOURCEPATH definitions should end with two colons 
(::):

 /tekxp/dpsnx_2.1/common/psres

For example, if you want to use the applications in the PSXpress option and
PSRESOURCEPATH has not been set, use this command:

# setenv PSRESOURCEPATH /tekxp/dpsnx_2.1/common/psres::

It correctly sets the PSRESOURCEPATH variable.
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Launching Applications

By default, Adobe Acrobat Reader and other applications are installed in /
tekxp/bin/{ sun4|solaris|hp}. Make sure this directory has been added to user’s
execution search paths.

Table 4-1 lists the commands used to launch Adobe applications.

Table 4-2 Commands to Launch Adobe Applications.

Application Command Description

Adobe ShowPS showps A viewer for PostScript documents and 
files.

Adobe Acrobat Reader acroread A viewer for Portable Document 
Format (PDF) files.

Display PostScript Executive dpsexec An interface that provides direct user 
interaction with the PostScript 
interpreter.

Motif Draw Demo draw A simple drawing editor with text, 
ellipses, and rectangles.

Motif Font Viewing Demo fontview A viewer for fonts available on the 
system.

Motif Graphical Text Demo scratchpad A graphical editor for manipulating text.

Display PostScript Text Game texteroids A game similar to asteroids, with 
rotating text.

Display PostScript Imaging Demo wonderland A demo that illustrates Display 
PostScript imaging capabilities.

EPSF Viewing Demo xepsf Viewer for Encapsulated PostScript 
Format files.
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Launching Acrobat Reader

If you have configured OpenWindows as described in the Integrating Icons into 
an OpenWindows Desktop section, you will see the Acrobat Reader icon on 
your desktop. Click on the icon (or on a PDF document icon) to start Acroba
Reader.

To view one or more files while starting Acrobat Reader, give the file names a
command line parameters. For example, to view /tekxp/AcroRead_2.1/sun/
doc/Tour.pdf and /tekxp/AcroRead_2.1/sun/doc/Samples/Backgrndr.pdf, 
enter:

# acroread /tekxp/AcroRead_2.1/sun/doc/Tour.pdf \ /
tekxp/AcroRead_2.1/sun/doc/Samples/Backgrndr.pdf

The acroread launch script and the acroread_frontend program ensure that 
only one version of Reader runs on your desktop. If you issue the command
acroread filename.pdf when Reader is already running, the currently running 
version of Reader loads and displays filename.pdf. 

If you want a new version of Reader each time you issue the acroread 
command, /tekxp/AcroRead_2.1/custom/USEFRONTENDPROGRAM or 
launch acroread as follows:

# acroread –e USEFRONTENDPROGRAM=0

Locating Acrobat Reader Preferences File

The preferences that are specified by the user through the Preferences Dialog 
are stored in a preferences file. Acrobat Reader reads this file at startup and
writes this file every time the user clicks the OK button in the Preferences 
dialog.

The specific preferences file used by Acrobat Reader is determined by selecti
the first non-directory file that can be located from a list of candidates. The 
candidate list is specified as a colon-separated list of path names. The path 
names may contain the special sequence%N to denote Acrobat Reader’s class 
name, which is Acroread. For example,

/user /joe/app-defaults/%N:/user/ joe/%N 

specifies two candidate preferences files, namely /user/joe/app-defaults/
Acroread and /user/joe/Acroread.
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If this candidate list was used by Acrobat Reader to locate the preferences file, 
then if /user/ joe/app-defaults/Acroread exists as a plain file, it will be used as 
the preferences file. Otherwise, if /user/joe/Acroread exists as a plain file, then 
it will be used. 

If neither file exists, then the file /user/ joe/app-defaults/Acroread, being the 
first candidate specified, will be created when Acrobat Reader writes the 
preferences file.

The content of the candidate list depends on two environment variables, 
XAPPLRESDIR and XUSERFILESEARCHPATH.

1. If neither XAPPLRESDIR nor XUSERFILESEARCHPATH is set in the 
user’s environment, then the candidate list is $HOME/%N, where $HOME 
denotes the user’s home directory.

2. Otherwise, if XUSERFILESEARCHPATH is set, then the value of 
XUSERFILESEARCHPATH is used as the candidate list. For example, the
user could get the candidate list specified in the example above by enterin
the following C-shell command:

# setenv XUSERFILESEARCHPATH \ /user/ joe/app-defaults /
%N:/user/ joe/%N

3. Otherwise the candidate list will be $XAPPLRESDIR/%N:$HOME/%N, 
where $XAPPLRESDIR denotes the value of the XAPPLRESDIR 
environment variable.

If users have a file named Acroread in their home directories, then they need
not specify an XAPPLRESDIR or XUSERFILESEARCHPATH environment 
variable.

The following single entry in a user’s .cshrc file will cause applications to look 
for the appropriate preferences files in the app-defaults subdirectory of the 
user’s home directory:

# setenv XUSERFILESEARCHPATH $HOME/app-defaults /%N

The complete set of rules for determining the candidate list can be found in 
The X Window System Toolkit, published by Digital Press.
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Printing Documents with Acrobat Reader

You can print PDF files from within Acrobat Reader by choosing Print from the
File menu. You can also print PDF files using Acrobat Reader from the 
command line. For example, to print the file sample.pdf to the default printer 
from the command line, enter:

# acroread –print sample.pdf

To print the file sample.pdf to the printer named laserprinter, enter:

# acroread –print sample.pdf –Plaserprinter

You can pipe a PDF file into acroread for printing using the –print  option:

# cat sample.pdf | acroread –print

Converting PDF Files to PostScript Files with Acrobat Reader

You can convert PDF files to PostScript documents from the command line 
with Acrobat Reader. The following command converts the PDF file 
sample.pdf to a PostScript file stored as sample.ps:

# acroread –toPostScript sample.pdf 

You can convert one or more PDF files and put the PostScript results into a 
directory. For example, to convert sample.1.pdf and sample.2.pdf (in the current 
directory) into PostScript files stored in the subdirectory samples_PS_dir, enter 
the following command:

# acroread –toPostScript sample.1.pdf sample.2.pdf
samples_PS_dir

To specify a series of PDF files to be converted and specify an individual nam
for each converted PostScript file, use the –pairs option:

# acroread –toPostScript –pairs file_1.pdf file_1.ps …
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Using Display PostScript NX with Other Applications

The applications bundled with XpressWare are capable of automatically 
launching a Display PostScript NX agent if one is not available. However, som
third-party Display PostScript applications, such as Sun AnswerBook, do no
have this capability. Users can start an agent manually for use by these 
third-party applications with the following command:

# execnx &

Users only need to run execnx once per login session; the agent that it starts will 
be shared by all Display PostScript programs and applications that use the X
display. See NCBridge Installation, Appendix A for information about Display 
PostScript agents.

Users can use the listnx utility to see if there are any agents already servicing 
their X displays:

# listnx

For details, see the execnx and listnx man pages located in /tekxp/man/catn by 
default.

Location of Documentation

PostScript language documents are installed in the /tekxp/doc directory by 
default. The documents themselves come from the directory /tekxp/dpsnx_2.1/
common/doc and include:

ShowPSUserGuide.ps ShowPSReferenceCard.ps

Adobe Acrobat Reader PDF documentation is located in /tekxp/AcroRead_2.1/
Help and include:

Help.pdf Tour.pdf

The man pages are installed in the /tekxp/man/catn directory.

Sample documents and example applications are located in /tekxp/
AcroRead_2.1/Help and include:

AcrBroch.pdf ShowPSUserGuide.pdf
Backgrdr.pdf ShowPSReferenceCard.pdf
FeatBene.pdf AeFables.pdf
SFO.pdf Claim.pdf
FoneAndMap.pdf ncaa1.pdf
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Font Caching
The font caching feature stores fonts in memory for later use. This eliminate
the need to download a font each time the application using the font is execute
For example, if you open and close your word processor, then open it again, t
fonts are still available if your network computer’s memory. This is a more 
efficient use of resources, since fonts are cached once, instead of duplicated
each occurrence or downloaded over a busy network.

You can specify the amount of memory to allocate or you can flush cached fon
at any time. It is recommended that cache be flushed whenever new fonts (with 
a font path change) are added, to insure that the proper paths are cached. 
Flushing does not affect the current applications.

To set a Font Cache Limit:

1. Select Setup from the Client Launcher.

2. Check the amount of memory in your network computer by, dragging on 
Statistics and releasing on Memory.

3. Drag on Configuration Summaries and release on X Environment.

4. Set Font Cache Limit to the amount of memory in kilobytes to allow for font
caching. Do not exceed the total memory for your network computer.

To empty the Font Cache and free up network computer memory:

1. Select Setup from the Client Launcher.

2. Drag on Configuration Summaries Menu and release on X Environment.

3. Click the Empty Font Cache button.

Launcher

Launcher
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Printing Color Hardcopies
This section explains how to print a hardcopy by using the MWM pop-up menu 
item or by entering a command on the command line. Information in this 
section is specific to MWM. If you are using another window manager, refer to 
the documentation you received with that window manager for more 
information about printing a hardcopy.

Note: The host computer must have the appropriate software 
installed before you can use these hardcopy commands. If you 
cannot print a hardcopy, contact your system administrator.

Printing from MWM

You can use a pop-up menu to make a hardcopy of a window or a hardcopy
the entire screen.

Making a Hardcopy of a Window

1. Move the pointer outside of all windows and drag the Custom mouse butto
to display the pull-down menu.

2. Release on Hardcopy to display another pull-down menu.

3. Click the Custom mouse button on Window to change the pointer shape into 
a cross.

4. Move the pointer into the window you want to copy.

5. Click the Select mouse button. A single beep indicates the window is bein
copied. A double beep indicates the copying process is complete.

Making a Hardcopy of the Screen

1. Move the pointer outside of all windows and drag the custom mouse butto
to display the pull-down menu.

2. Release on Hardcopy to display another pull-down menu.

3. Click the custom mouse button on Screen. A single beep indicates the screen 
is being copied. A double beep indicates the copying process is complete
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Printing from the Command Line

Here is a general procedure for printing a hardcopy of a window:

1. Move the pointer into an X window and click the Select mouse button to 
activate the window.

2. Press the PrintScreen key. This key must be defined by your system 
administrator. Contact your administrator to find out which key to press and
which printer your network computer is configured to use.
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Flash Control Console

Note: The information in this section is written for system and 
network administrators responsible for installing and 
administering one or more network computers in a 
distributed-computing environment.

This section describes the Flash Control Console (FCC), a graphical user 
interface that allows the flashing of multiple network computers from a single
central terminal. The FCC offers a convenient alternative to flashing by use of 
configuration commands in the xp.cnf file. For more information about 
configuring flash memory by use of configuration commands, refer to 
Configuring Flash Memory in the Network Computer Reference Manual.

Capabilities controlled by the FCC include:

• Handling a network of over 100 network computers. 

• Interactively selecting terminals, network computer features, fonts and use
files for flashing.

• Selecting fonts from multiple hosts.

• Supporting only TCP/IP.

• Displaying online status of a flash operation.

• Creating flash image of network computer features, fonts and user files 
selected for flashing.

• Flashing multiple network computers either on a file-by-file basis or from a
created image.

• Simultaneous flashing of multiple network computers.

• Loading or saving settings from/to a user-specified file.

• Providing a log facility.
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• Make sure that the flash.rel file is in your config directory.

• Add flash_auth_xp to the xp.cnf file in the config directory for each terminal 
you want to flash.

Starting the FCC
To bring up the Main menu of the Flash Control Console, type:

>xpsh [–display displayname:0] fcc &

where displayname is the name of the display where the FCC will appear. If you 
do not enter displayname, the $DISPLAY environment variable is used as the 
default.

Note: You can also set displayname by changing the $DISPLAY 
environment variable.

Figure 4-29 The Flash Control Console Main Menu
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The Main menu of the FCC has four areas: The File Menu, the Menu Bar, the 
Menu Input Area and the Message Box. Let’s look at each of those areas in 
detail.

The File Bar

The File Bar offers the following options on the File pull-down menu:

• Load Settings uses settings that have been previously saved (assumed not to 
be empty). Choosing this option brings up the Load New Configuration 
screen where you specify the access method, host and path of the 
configuration file you want to load.

• Save Settings uses the parameters selected on the FCC to update the settings 
file (see the following note). Using this option brings up the Save Current 
Configuration screen where you specify the access, host and path where y
want to store the configuration file.

Note: You must create the Save Settings file before using the Save 
Settings option. To do this, type the following at the shell of 
the specified host: > touch <savesettings filename>

• Log File takes only the flash information that appears on the network 
computer console window and saves it in a file (see the following NOTE). 
Selecting Log File brings up the Set Logfile Attributes screen where you 
specify the access, host and path that is used to store the file.

Note: You must create the Log File before using the Log File 
option. To do this, type the following at the shell of the 
specified host: > touch <log file filename>

• Exit ends the program.
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The Menu Bar

The Menu Bar is where you select the activity you want to perform using FCC. 

Note: These activities are not activated until after you click the 
Proceed for Flashing button (discussed shortly).

• Flash Settings flashes all the settings you select on the FCC.

• Flash Image uses a source image file to flash selected network computers

• Create Image creates an image file using the current settings. If you select
this activity, the Image Destination heading appears on the Main menu with 
the following choices: 

Access — TFTP, NFS or DAP (not currently supported).

Host — The host name or address where you want to store the image file.

Path — The name and full path of the image file. TFTP requires a 
publicly-writable file and NFS must have the file system mounted.

Image Type — The network computer family used for image creation. Choices 
include: XP10, XP10T, XP330, XP330PEX and XP350.

• Query Image queries an image file.

The Menu Input Area

The area of the FCC where you select the options you want to flash is called the
Menu Input Area and contains the following:

Access

Specifies which file access method to use. The options are: TFTP, NFS or DA
(not currently supported).

Host

The field you use to specify the host name or address where files to be flash
are read. For example: 128.123.186.67.

Note: The host name must be specified in the Internet Host Table of Set
2 Network Computer User
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Path

The text field you use to specify the source directory of the files you want to 
flash. For example, /vol/Boot.

Selection

Specifies the parameters available for flashing. The options are: Target netwo
computers, Tek Features, User Files or User Fonts.

Compress

Selecting this option causes the files to be flashed in compressed format. It 
recommended that you use Compress to save space; however, compression
affect system performance.

Note: This button does not appear if you select Flash Image or 
Query Image.

Available List

Lists the items that are currently available for flashing.

Selected List

Lists the items that have been selected for flashing.

Note: To move an individual item between the Available List and the 
Selected List, highlight the item you want to move and then 
click the appropriate “arrow” located between the lists.

Entry

A text field where you enter a parameter that can then be added to the Availab
List for flashing. This can include:

• A network computer address or name (if your network provides a name 
service).

• User file names.

• User fonts.
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Add

Adds information to the Available List that currently appears in the Entry field

Note: Items appearing in the Selected List also appear in the 
Available List enclosed in brackets.

Delete

Deletes highlighted names and addresses from the Available List.

Note: When you use this feature, the brackets around the items in 
the Available List (see “Add,” above) disappear.

Add all

Copies all the items from the Available List to the Selected List. 

Del all

Deletes all the items in the Selected List. 

Proceed for Flashing

Takes you to the Flash screen (discussed shortly).

The Message Box

The area at the bottom of the screen where a brief message displays whenever 
the cursor passes over a field on an FCC menu.
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The Flash Screen
After selecting the features you want to flash and clicking the Proceed for 
Flashing button on the Main menu, the Flash screen appears (Figure 4-30).

Figure 4-30 The Flash Screen

The central part of the Flash screen is called the Overview. It is here that a l
of the individual features you want flashed are listed, as well as current 
information about the status of any analysis being performed.

There are four buttons at the bottom of this menu:

• Start: This button starts the actual flashing.

• Abort : Stops the flash process.

• Analyze: Determines the available memory of the target network compute
and compares that with the amount of memory required by the options to b
flashed.

• Return to Selection: This button returns you to the Main menu of the Flash 
Control Console.
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Note: If you do an analysis or flash and then click on the Return to 
Selection button, a warning box appears, letting you know 
that all flash information will be lost if you return to the Main 
menu.

After Doing an Analysis

Once you have completed an analysis, the Status line in the Overview area 
shows Analysis Complete . Double-clicking on a network computer name at 
this point brings up the Network Computer Status box, which displays the 
network computer name, status of the analysis, flash memory available, and
total memory size required by the network computer. You can view the 
statistics for any groups listed by doubled-clicking on their name to bring up th
Group Status box. Click on the Return to Network Computer button and then 
the Return to Overview button to go back to the Flash Screen.
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TekLogin Local Client
Many customers want to present their end-users a simplified environment wi
simple login methods and easy access to applications. The new TekLogin local 
client adds one more piece to that end, streamlining the login process and 
allowing system administrators to decide how much or how little control over
to offer their end-users.

The TekLogin local client is commonly used with the PPP support feature (refer 
to the PPP Support topic on page 4-91) to provide remote users access to hos
servers.

Starting TekLogin
There are several ways to launch the TekLogin client. You can launch it with:

• the Setup client

• the Launcher

• the xpsh command

• the xp.cnf file

As noted in the previous section, you can choose TekLogin as your Host 
Connect Method in Setup’s Configuration Summaries | X Environment 
menu. After a successful boot, the network computer will display the TekLogin 
client, as seen in Figure 4-31 on page 4-88.

Another method is to set Launcher to display and launch the TekLogin client. 
You can manually edit your system.launcher file to do this or set this line in 
your xp.cnf file to “YES”:

teklogin_show_sessions_in_launcher YES

This will automatically display all eight of your pre-configured sessions in a 
pull-down menu in the Launcher.

A third way to start TekLogin is with the xpsh command:

xpsh -display <displayname> :0 teklogin &

Finally, you can have TekLogin start automatically with the xp.cnf file by 
un-commenting and altering this line in your xp.cnf:

START TEKLOGIN NO #[YES|NO]
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Change the value for this line to “YES”.

Figure 4-31 TekLogin client

xp.cnf  commands for TekLogin
You can add these commands to your xp.cnf file to affect the TekLogin client. 
Refer to your Network Computer Reference Manual for details about these 
commands.

teklogin_show_sessions_in_launcher [YES|NO]

teklogin_force_fullscreen_windd [YES|NO]

teklogin_timeout [SECONDS]

teklogin_require_login [YES|NO]

teklogin_save_passwords [YES|NO]

teklogin_default_session [1–8]

teklogin_close_on_connect [YES|NO]
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The first two listed are notable in that they are not configurable with the 
TekLogin client itself, as most of the others are. The 

teklogin_show_sessions_in_launcher command will display the configured 
sessions in the Launcher client as pull-down selections. The 

teklogin_force_fullscreen_windd  command forces the WinDD ICA client 
launched by TekLogin to take up the whole screen (rather than a 640x480 
window, the default).

Configuring TekLogin  settings

In the File pull-down menu, you can select Save Settings, Restore Settings, or 
Exit. 

Save Settings This saves the current user name, password, phone numbe
and session settings such that the next time the TekLogin 
client is launched, these settings will display. 

Restore Settings Restores the last saved settings.

In the View pull-down menu, you can select Setup or Options. Both of these 
selections will require a password if you set password restriction in the Setup 
main menu.

Setup This launches the Setup client. Sys-admins can disable this feature, 
however, if they do not wish end-users to have access to the Setup 
client. (See Security between TekLogin and Setup on page 4-90 for 
details.)

Options Autologin Timeout. The default timeout is 30 seconds, after 
which, if the user does not click the Cancel button, TekLogin will 
attempt to make the connection described by the session name. 
the user cancels the autologin, he can then choose one of the oth
configured sessions in TekLogin by its session name. The 
autologin defaults to the last session connected to via TekLogin. 

Interactive Login Required. This requires the user to enter his 
username and password after the PPP authentication has occurr
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Close on Connect. If TekLogin is not configured to close on 
connect (default), it will remain on the user’s screen, allowing the 
user a simple method of disconnecting from one session and 
reconnecting to another. Some system administrators, however, 
may wish to disable this functionality, forcing the network 
computer to connect using only session configuration.

Figure 4-32 TekLogin options

Security between TekLogin  and Setup
System administrators can set the security mechanism for a network compu
in Setup’s main menu so that no user can tamper with the network computer’
configuration without the password. The security is activated whenever a us
enters something in Setup or presses some button. Some of the fields, 
however—such as username and password for both authentication and acco
login purposes—need to be alterable to end-users. With security activated o
the Setup client, users will be able to enter their own user names and password
but will not be able to change the session names or other configuration 
parameters.

If security is enabled, the TekLogin client will not launch the Setup client, so 
system administrators can effectively “hide” Setup from novice users.
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PPP Support
PPP is a reliable transparent Internet Protocol (IP) that allows network 
computers to make network connections via serial lines to remote devices. 
NCBridge’s PPP passes TCP/IP information over the phone line in such a wa
that it appears as though your network computer has an Ethernet connection

PPP support is available for these former Tektronix network computers:

• XP100, XP200, XP300V, XP350, NC200, and NC400.

It is not available for:

• XP10, XP10T, XP20, XP100D, or XP330.

Before you begin

To run PPP successfully, you will need both the local PPP client process tha
runs on the network computer and the PPP server that runs on the remote h
computer. NCBridge version 3.1 or higher software provides the PPP client;
you will need to get the appropriate PPP server software from your host vendo

There are several different ways you can connect your network computer via
PPP to a remote host, but before you begin, you must first configure:

• the network computer’s serial port

• the network computer’s PPP settings

• the xp.cnf file (if you want PPP to start automatically after boot)

• several other settings

Configuring the network computer’s serial port

Before you can connect via PPP, you must configure one of your network 
computer’s serial ports for your modem.

First, select a port on the rear panel of your network computer. Since many 
users may already have tablets or other peripheral devices connected to por
and since port 1 allows higher transmission rates (115.2K), we recommend yo
use port 1 for your modem connection, especially if you are using ISDN lines. 
Network Computer User 4-91



Chapter 4 Using Advanced Features

4-9

 

 

On the NCD network computers, port 1 is the upper port; port 0 is the lower.
Connect your modem’s 9-pin female cable to the desired port. (All examples in 
this section assume port 1 has been configured for PPP.) 

Figure 4-33 RS-232 serial ports on an NC200

After you have connected the modem cable to your serial port, you must 
configure the serial port for modem transmission. In Setup, go to 
Configuration Summaries | Peripheral Ports. (See Figure 4-34 on page 
4-93.)

The fields in the lower half of this menu (from Network-to-Port Process 
down) do not affect your modem, so we will ignore them here. We are 
concerned with one of the two columns at the top, depending on the port you
have chosen. For our example, this is Serial Port 1, on the right.

serial port 0 (up to 57.6K baud rate)

serial port 1 (up to 115.2K baud rate)
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The “8”, “1”, and “None” default settings for the first three fields (Data Bits, Stop 
Bits, and Parity ) will be correct for virtually all current production modems. (Check
your modem user documentation to be sure.) The Flow Control  and Baud Rate 
settings are really the only two you will need to configure.

Figure 4-34 Peripheral Ports Configuration Menu
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Flow Control. This field determines what kind of PPP “handshake” passes 
between the network computer and the server: None, XON/XOFF, or CTS/
RTS.

– “None” tells the network computer to pass data through the modem 
without acknowledging transmission or reception of the data packets; 

– “XON/XOFF” is a software handshake; and 

– “CTS/RTS” (recommended) is a hardware handshake. (Check your 
modem user documentation for the best handshake method.) 

Baud Rate. This refers to your modem’s transmission speed. We recommen
setting this field to at least 57,600 to avoid starving the modem of data. Port
supports a maximum of 57,600 baud rate; Port 1 supports up to 115,200. 

Note: Due to the complexity of the baud rate programming, port 0 is 
totally unusable if port 1 is in use at 115,200 baud. If port 1 is 
in use at lower baud rates, port 0 is available for use with any 
appropriate device.
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Configuring the network computer’s session/PPP settings

Next, you will have to configure your network computer’s session and/or PPP
settings. In Setup, go to Configuration Summaries | Session. This menu 
allows you to configure the network computer for PPP sessions and for Ethern
sessions.

Figure 4-35 Session Manager Configuration Menu

As you can see in Figure 4-35, the Session Manager Configuration Menu is 
divided into four areas, known as identification, authentication, connection, and
status.
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Session identification

In this area, identify each of up to eight session configurations.

Session. You can specify one of eight sessions in this field. For each session
you will configure the settings in the other fields listed below. When you selec
one of the eight sessions with this button, the settings you configure in the oth
fields described below will appear. 

Session Name. Give each of your eight sessions a distinguishing name that wil
help users identify the correct session for their needs.

Session authentication

The session authentication area is for authentication purposes. Each sessio
requires some form of authentication to make the session connection. 

User Name. You must provide a valid user name. 

Password. You must provide a valid password. Your password will appear as
asterisks as you type it in; the field itself will appear blank after you press Ente
These two authentication parameters (User Name and Password) are saved
NVRAM when you click the “Save Settings to NVRAM” button.

Connection Method. There are four choices: Dial Out, Direct, Manual, Script. 

Dial Out The dial out method—probably the most common—
can only be used to connect to RAS servers (or servers
emulating the RAS interface). Dial Out assumes PPP 
is already running on the host.

Direct This refers to a true direct serial cable connection from 
one device (your network computer) to another (an NT 
server, for example), in which the baud rate on the two
devices’ serial ports must be the same. We recommend
you use this method only when you have a 
null-modem serial cable connecting your network 
computer directly to a server.

Manual This selection automatically brings up a TIP window 
and forces the user to enter his/her username and 
password. If the PPP daemon is not running on the 
host, the user will also have to start it manually.
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Script This allows you to specify a script to automate the 
authentication process.

Port Select Serial Port 0 (PPP), Serial Port 1 (PPP), or 
Ethernet.

Serial Port 0 (PPP) Select this if you have configured Serial Port 0 for PPP
(up to a maximum of 57,600 baud rate).

Serial Port 1 (PPP) Select this if you have configured Serial Port 1 for PPP
(up to a maximum of 115,200 baud rate).

Ethernet This selection disables all the PPP settings you may 
have configured in the Session Configuration Menu 
and connects directly through the network computer’s 
Ethernet cable.

Local IP. By default, this field is disabled. Any attempt by the user to add an
IP address or other string will be ignored. In the rare case when you wish to use 
this field, you will have to uncomment this line in your xp.cnf file and add an 
IP address value:

ppp_local_ip_addr [IP_ADDRESS]

If you do this, be sure to enter a valid unassigned IP address on the same sub
as your server in the Local IP field; if you enter an invalid address, the host will 
not allow you to log in. 

The remaining fields in the session authentication area may or may not appear, 
depending on the Connection Method you select. For example, if you choos
Direct, you will not need to provide values for the next four fields.

– Phone Number. You must provide a valid phone number for the network 
computer to dial out to if you select Dial Out, Script, or Manual. This field 
will not appear if you select Direct as your connection method. 

– Script. If you leave this field empty, it will remain blank but will default 
to one of the supplied scripts. You can also specify another script or on
of your own. Enter the name of the script in this field. This field will not 
appear if you select Direct, Dial Out, or Manual as your connection 
method. 
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– Connect String. You must provide a connect string only if you select 
Dial Out. This field will not appear if you select Direct, Script, or Manual 
as your connection method. This string is modem vendor-dependent. Th
default value (shown in Figure 4-35 on page 4-95) will work with all 
Hayes-compatible modems. If you wish to alter the default string, or if it
conflicts with your modem, consult your modem user manual for details

– Disconnect String. (Same information as for the Connect String above.) 

Session connection

The session connection area is for your login connection after you have 
successfully passed PPP authentication. 

Connection Type. There are several connection types you can choose from.

None (Default.) None means that after the network computer 
has made the connection and been authenticated, the
user will have to start his own session, launch clients 
manually, etc. 

ICA Host This selection will connect you to a WinDD/Windows 
NT host over an ICA connection. If you select ICA 
Host, you must specify a WinDD/Windows NT host 
(name or IP address) in the Host/Application field. 
Unless you specify an alternate configuration in your 
xp.cnf file, the default WinDD window (640x480, 16 
colors) will appear. (Also, see note below.)

ICA Application This yields a result similar to the ICA Host connection 
type, except that the user, instead of getting an entire
Windows NT session, will only get access to the 
specified application. If you select ICA Application, 
you must specify a (case-sensitive) application name 
in the Host/Application field. This application name 
is the name a master ICA browser broadcasts over the
network to ICA clients. When you select ICA 
Application, the master ICA browser will connect you 
to the Windows NT host that can best serve you that 
application, based on the server’s resources, number 
of users currently logged in, etc. (Also, see note 
below.)
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TekHostMenu This will launch the TekHostMenu client, allowing the 
user to choose amongst the various protocol/host 
combinations to make a post-authentication 
connection.

XDM Direct This sends an XDMCP login from a specific host to 
the user’s display immediately after PPP 
authentication. 

Telnet This will launch a Telnet session to the selected host.

Navio This selection is not supported at this time.

Note: ICA (WinDD) connections will not work in 16-bit TrueColor 
environments. If you choose ICA Host or ICA Application as a 
connection type, be sure that your Default Visual and Root 
Depth settings are set to “PseudoColor” and “8” respectively. 
(See the PPP Support topic on page 4-91 for more details.)

Host/Application. This field is for one of two values: You can enter the IP 
address (or server name) of the ICA host to which the user will login; or the 
specific published application name. The published application name defaul
to the local subnet, but you can optionally prepend the published name with 
Windows NT server name or IP address, or with the subnet mask that points
a specific Application Master Browser location as shown, for example, in this
entry:

192.168.15.255 notepad

This points to an Application Master Browser on the subnet 192.168.15.255. In 
such a case, the Application Master Browser selects the Notepad application
from among the hosts on the subnet based on server load. 

User Name. Optional. This user name differs from the user name required in
the session authentication area of this menu. This user name refers to the ac
account the user must have on the server on which he wishes to login; the 
former user name is for authentication only. If this field is left empty, the use
will have to manually login to the server after the session has been authentica
and established.

Password. Optional. This too differs from the password required in the session
authentication area. If this field is left empty, the user will have to manually 
enter his/her password to login.
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Domain. Optional. This is only for Windows NT environments. If you have 
entered a user name and password in the two previous fields, you might als
want to specify a Windows NT domain on the login host. Otherwise, the use
will have to manually select a domain at the Windows NT login prompt.

Session status

The session status area is where you make and break session connections.
also displays information about your connection. 

Connect/Disconnect. Use this button to make and break your session 
connections. (See the PPP connections topic on page 4-103.)

Status. This gives PPP connection status information (terminated, connecting
connected, etc.). If you have selected Ethernet as your Port, Status will display 
“Connection Down.”

Local IP. Local IP refers to the IP address the PPP server allocates to your 
network computer after the PPP connection has been established. If you ha
selected Ethernet as your Port, Local IP will display “Not Connected.”

Remote IP. Remote IP refers to the IP address of the PPP server you are 
connected to. If you have selected Ethernet as your Port, Remote IP will 
display “Not Connected.”

Configuring the xp.cnf  file for PPP

Configuring the xp.cnf file will allow remote users to make PPP connections 
automatically, after they boot their network computers. You will need to 
complete the previous Setup configurations for each network computer you 
want to connect automatically. You will also need to uncomment and alter thi
line in your xp.cnf:

START PPP NO #[YES | NO]

Change the value for this line to “YES”.
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Final network computer configuration considerations

There are three other menu items in Setup that you should check before you are 
ready to make a PPP connection.

First, verify that your network computer has an Internet host name. In Setup, go 
to Configuration Summaries | TCP/IP. If the first field on this menu is blank, 
enter a network computer name. If your network computer does not have a 
name, PPP will generate a unique name for you—based on your network 
computer’s Ethernet address—so it is not critical that you enter one here; it i
merely good practice. 

Second, there are a few settings in 
Configuration Summaries | X Environment you should check. If you plan to 
use either the ICA Host or ICA Application connection type described in the 
previous section, make sure the Default Visual is set to “PseudoColor” and the 
Root Depth is set to “8”. Also, with NCBridge 3.2, you now have an additional 
choice of methods (under Host Connect Method) by which to connect to a host 
computer (see Figure 4-36 on page 4-102).
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TekLogin, a new local client which allows a simple connection automatically or
with a single button-click, is explained in more detail in the TekLogin Local 
Client topic on page 4-87. You may want to change this setting for your 
network computer(s).

Figure 4-36 X Environment Configuration

Finally, you might want to save your settings so that you won’t have to go 
through these procedures again the next time you reboot. To do this, click th
“Return to Main Menu” button, then click the “Save Settings to NVRAM” 
button on the bottom left of the Setup main menu. 
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PPP connections
After you have configured your network computer’s serial port, PPP, and othe
settings, and have attached a modem to one of your network computer’s ser
ports, you can connect to a remote host via PPP using one of these method

• by using the TekLogin client;

• by using the “Connect/Disconnect” button in Setup’s Session Manager 
Configuration Menu ; 

• by using xpsh on a command line; or 

• by booting the network computer and automatically connecting via PPP wit
the remote configuration file, xp.cnf.

Connecting via TekLogin

TekLogin is a new local client that simplifies the connection process, not just 
for PPP connections, but for other host connections as well. This method is 
recommended, especially in environments where the system administrator 
wishes to simplify the login procedure for inexperienced users. See the 
TekLogin Local Client topic on page 4-87 for more information.

Connecting via Setup

Another way to start PPP is from Setup where the user can see the PPP status 
and, in case PPP exits, the reason for the connection failure. When PPP com
up, the user will see the IP address for the connection on the network compu
(if the remote is assigning IP addresses) and the remote IP address.

For each of the following methods, in Setup, go to Configuration Summaries 
| PPP and click the “Connect/Disconnect” button to make your PPP 
authentication connection, then follow the rest of these procedures below.

Dial out and Direct

For a properly configured Dial Out or Direct session, no other steps are 
necessary to connect. 
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Manual

When you click the “Connect” button for a Manual session, one of the provided 
scripts (start_man) will start, launching a TIP window and dialing the number 
specified in the Session Manager Configuration Menu. The start_man script 
prompts you for your username and password. If the PPP daemon is not running 
on the host, you will have to start it manually. The TIP window will close 
automatically as soon as the script detects that PPP is running on the host. T
TIP window will remain open for thirty minutes otherwise before closing.

Figure 4-37 Connecting manually via a TIP window

When your connection has been fully established, the remote device will assig
you a remote IP address and display it in the Remote IP field in Setup’s Session 
Manager Configuration Menu.
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Script

When you choose to connect via a script, the value you enter in the Script field 
names the parameter listed in Setup’s Network Tables and Utilities | Script 
Parameters. (See Figure 4-38 on page 4-105.) NCBridge 3.2 ships with three
sample scripts (start_ppp, start_man, and start_isp) found in the /tekxp/boot/
config/script directory. The first of these is the default script when you select 
Script as your connection method in the Session Manager Configuration 
Menu; the second starts when you select Manual; the third is included only as 
an example. You may use these scripts or create your own.

Figure 4-38 Script Parameters Configuration Table
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Connecting via xpsh

While it might not make sense to connect via PPP through the xpsh command 
(which requires you to be connected to another server in the first place), it is st
possible to do so with this command:

xpsh -display <display_name> :0 pppd <parameters>

Connecting via the xp.cnf  file

If the sys-admin has set up the PPP parameters in the xp.cnf file for remote 
network computer users, the PPP session will start automatically after netwo
computer boot. 

Terminating PPP

With TekLogin, click the “Disconnect” button on the main menu. In Setup, go 
to Configuration Summaries | PPP and click the “Disconnect” button. 

Note: When clicking the “Disconnect” button, PPP does not send 
the disconnect string to the serial port to reset the modem. If 
this occurs, turn off/on your modem to reset the modem. 
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Screen Saver Support
Kiosk administrators can use the screen saver support feature. NCBridge ve
3.1 or later, provides a new local client ssadvt that allows a customer to display a
series of gif images as a screen saver on the network computer. Rather than h
the network computer screen simply blank after a specified period of inactivi
system administrators can now display advertisements, corporate-endorsed
images, and other images of general interest on inactive network computers
non-kiosk systems, system administrators can implement the screen saver o
entire network, so that all network computers display the same images.

Note: “Screen savers” do not prolong the life of a monitor. At best, 
a screen saver turns off the video information; this prevents 
images from being burned into the phosphor. Screen savers 
do not turn off the filaments that heat the cathode, which is 
what generally wears out in a monitor first. A better way to 
“save” your screen is to select “PowerSave” in the Screen 
Saver field in Setup’s main menu. This automatically saves 
the screen, the cathode, the CRT, and electrical energy. 

You can use xp.cnf or xpsh to start the screen saver local client ssadvt. Once 
started for a network computer, you cannot kill or override the process withou
rebooting the network computer.

Starting the screen saver with the xp.cnf  file

To start the ssadvt client using xp.cnf, add a line similar to this one to your 
xp.cnf file:

start SSADVT YES –args " –t 600 –c 60 –f /home/
ssadvt.list" #<[ON | OFF]> 

...where –t indicates the timeout in seconds, –c indicates the cycle time in 
seconds, and –f indicates the NFS-mounted file with the list of gif images to be 
displayed.

In this example, when the network computer has been inactive for a period 
equal to ten minutes (600 seconds), the screen saver displays the first image in 
the file /home/ssadvt.list. After a minute, the next image in the file is displayed, 
and so on until the end of the file is reached, then it loops to the beginning and 
starts over. If a user “interrupts” the stream of screen saver images, for examp
by moving the mouse, the screen saver resumes with the next image in the 
during a subsequent ten-minute period of inactivity.
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Example 1-2. Screen saver list of GIFs (ssadvt.list)

!Do not delete this line.
/local/GIFS/dilbert11.gif
/local/GIFS/subliminal3.gif
/local/GIFS/csun.gif
/local/GIFS/xena17.gif
/local/GIFS/brainwash.gif
/local/GIFS/pointy-hair.gif

The images in the ssadvt.list file must be gifs; no other image format is 
supported. If you include a non-gif image in the file, that image does not 
display. The console should mention the status of opening the file ssadvt.list 
and start displaying a different gif every minute.

Starting the screen saver with the xpsh command

To start the ssadvt client using xpsh, enter this command:

xpsh –access <method>  ssadvt –t <timeout> –c <cycle>  –f 
<filename>

The default method value is nfs, and since no other method is available at this 
time, the –access argument can be omitted entirely; the default timeout value is 
ten minutes (–t 600) with a minimum value of 20 seconds; the default cycle time 
is one minute (–c 60).

Note: The local screen saver client works in a CDE or 
multiple-workspace window environment such as TED; 
however, the images on the screen do not cycle at the specified 
interval. The images cycle only at the default time interval of 
10 minutes (600 seconds) and only if the CDE screen saver is 
on. Turning off the CDE screen saver also turns off ssadvt.
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16-bit True Color Support (NC400 and NC200)
NC400 and NC200 network computers with option V2 (or field kit NCFV2) 
can now take advantage of NCBridge’s 16-bitplane true color support.

When a network computer is configured to operate in 16-bitplane mode, its X
server exports a 16-bitplane TrueColor or DirectColor visual, so you will see 
65,536 colors instead of only 256 colors in 8-bitplane mode. That means you
will see markedly better visual effects on applications that can take advantage 
of 16-bit color depth. Running your network computer in 16-bitplane mode will
also eliminate irksome color flashes that occur when multiple color-intensive
applications run simultaneously. 

Configuration

You can configure your NC200 or NC400 to operate in this mode either throug
the Setup client or through the remote configuration file xp.cnf. 

In the Setup client, go to the Configuration Summaries | X Environment 
menu and select “16” for the Root Depth field. Then go back to the main menu 
and reset the X server by clicking on the “Reset Server” button. Once the serv
is reset, it will operate in16-bitplane mode. If you decide to go back to the 
8-bitplane mode, reset the Root Depth field to “8” and click the “Reset Server” 
button again for 8-bitplane PseudoColor. If you want the network computer t
retain the new root depth settings the next time it is booted, click the “Save 
Settings to NVRAM” button in Setup’s main menu.

To configure the X server to operate either in 8-bitplane or 16-bitplane mode
remotely, add this line to your xp.cnf file:

root_depth 16 # [8 | 16]

Limitations

There are some limitations with 16-bitplane mode. For one, the WinDD ICA 
client requires 8-bit PseudoColor and cannot be used in 16-bitplane mode. I
you try to launch a WinDD ICA client in 16-bitplane mode, the ICA client will 
write a message to the console stating that it “cannot find the PseudoColor 
visual” and will exit. (WinDD X Support works fine in 16-bitplane mode.) 

Also the digital video player vplay cannot be used in 16-bit mode, due to the 
fact that current software reserves a color index from the PseudoColor table f
the chromakey that makes vplay work. 
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Web-based Administrator
The Web-based Administrator allows a system administrator the ability to view
an NC’s setup parameters using a standard Internet browser, like Netscape 
Navigator. If an NC’s parameter is set incorrectly, the administrator can 
identify the problem from his own desktop and change the NC parameter to th
appropriate value without having to visit the user’s desk.

Implementation

Using the start command in the xp.cnf file, start the NC local HTTP server. 
Here is an example:

start http

When a browser points to the NC’s IP address, the NC provides its setup 
parameters. 

Note: A password may be defined for security reasons in the xp.cnf file, so
that other users may not view or change an NC’s setup parameters
10 Network Computer User



Figure 4-39 NC parameters viewed with Web-based Administrator
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Troubleshooting

Solving Power Problems
If you press the power button(s) and nothing happens:

• Check the back of the network computer and separate logic module (if you
have one) to verify the power cord is firmly attached.

• Check the electrical outlet to make sure the power cord is firmly plugged in

• Try a different electrical outlet, or try plugging something else into the outlet 
to verify the outlet has power.

If keyboard lights flash or if a bell sounds but nothing is displayed on the scree

• On the network computer, check that the video cable is connected to the 
video port.

• On the monitor, check that the video cable is connected to the correct vide
inputs (video in).

Solving Boot Problems
If the network computer powers up, but the boot fails, there are various options 
to try. After each option, try to boot the network computer from the BOOT> 
prompt by typing b or boot and then pressing Enter.

• Verify the network computer keyboard, mouse and network cables are all 
firmly attached. 

For advanced users who have access to the NCD NC200/NC400 Network 
Computer Reference manual, refer to the Boot Monitor chapter:

• Verify the boot method. It typically is TFTP or NFS for UNIX computers, 
MOP for DEC computers, or ROM if you have an optional Flash or ROM 
option.

• Verify host and gateway communications from the boot monitor with ping. 
If ping does not find the host, verify the host and network computer subne
masks are correctly set.
Network Computer User 5-1



Chapter 5 Troubleshooting

5-2

t 

ot.
• If an error message says the boot file is not found:

– Verify the expected information was obtained from the network

– Verify the boot path is correct. It should contain both the path and the boo
file name.

– Verify that all the files have world read permissions

• If the configuration files are not found:

– Verify the messages to verify which host is being polled for the files

– Verify the primary and secondary paths are correctly set

– Verify the paths and the read permissions on the files

Solving Log in Problems
If your network computer boots, but you are unable to log in:

• If the mouse or keyboard do not respond, check the cables and then rebo

• If an error message is generated saying that the log in failed:

– Retry entering your username and password

– Verify you are connected to a host where you have a login account

• If a message is displayed saying that a connection timed out, restart the 
connection as detailed in Chapter 2, Logging in to the Network Computer.

• Check the Console window for error messages. Refer to The Console 
Window on page 5-4.
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The Console Window
The Console Window is a useful tool to see what is happening with the network
computer. Messages, such as a confirmation that a file was located or that a
command generated an error, are sent to this window. You must explicitly ope
and close the Console window through the Client Launcher.

Opening the Console Window

The Console window is a valuable tool to see messages being generated by 
network computer. You can display this window at any time.

To open the Console window:

1. Select Console from the Client Launcher. If you need a refresher on the 
terminology used in these procedures, refer back to Chapter 1, Terminology.

The Console Window shown in Figure 5-1 appears on your screen.

Figure 5-1 Console Window.

The network computer’s address and name (if defined) appear on the title ba
You cannot add or delete information from the Console. This window is 
updated whenever a confirmation or error message is received by the netwo
computer.

Launcher

Console

Console: IP=134.62.64.14 (baldwin)

Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutRS12.snf   Found
Opening for NFS read:  /host/tekxp/boot/xbcast.10   Found
TekHostMenu:  TDEnet Not Setup;
VMS TDEnet and Cterm lists not available.
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBI18.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBI24.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/misc/6x13.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutBS12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/100dpi/lutRS12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/fonts/misc/olgl12.snf   Found
Opening for NFS read:  /usr/lib/X11/XP/system.launcher   Not Found
Opening for TFTP read:  /home/tekxp/boot/config/system.launcher on host 170.93.13
.43   Found
Using Automatic Configuration Data.
Opening for NFS read:  /host/tekxp/boot/tek220.10   Found
Opening for NFS read:  /host/tekxp/boot/app-defaults/Tekterm   Found
Opening for NFS read:  /host/tekxp/boot/telnet.10   Found
Opening for NFS read:  /host/tekxp/boot/LuV2RT12.pcf.z   Found

E

8049-146
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Using the Console Window

Often there is more information available than will fit in the Console window.
Since the Console window cannot be resized, use the methods listed below 
view additional information. You can also copy and paste information from the
Console to a command window.

• To display the previous screen of messages:

Position the mouse pointer in the scroll bar anywhere above the slider box
and click the Select (left) button.

• To display the next screen of messages:

Position the mouse pointer in the scroll bar anywhere below the slider box
and click the Select (left) button.

• To scroll through the messages one line at a time:

Position the mouse pointer on the up or down arrow (on the scroll bar) an
click the Select (left) button once for each line.

• To clear the contents of the Console window:

Click on the Erase icon. The Console scrolls to just below the last line of 
information. Drag the slider box up to view the Console information.

• To copy information from the Console window and place it in the Console
buffer:

Position the mouse pointer on the first character to copy and click the Select 
(left) button. Drag the mouse to the last character to copy. The selected te
is highlighted. 

• To paste information from the Console buffer into a window:

Position the mouse pointer in the window where you want to paste the 
information and click the Menu (middle) button. Information can be pasted
in Telnet, Cterm, Lat, and xterm windows.

Closing the Console Window

1. Select Console from the Client Launcher.

The Console Window disappears from your screen.

Launcher
Network Computer User
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 A
Special Keyboard Characters

This appendix describes how to work with special characters on different 
keyboards.

• Entering North American Special Characters from International Keyboards 
tells how to enable data processing keys so that you can use the North 
American character set on international keyboards.

• If you are using an LK401/VT200-style keyboard, refer to Compose and 
Diacritical Sequences for information on creating special characters and 
symbols by using compose characters.
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Keyboard Charts
Figures A-1, A-2, A-3, A-4, A-5, A-6, A-7, A-8, and A-9 show examples of the 
standard types of keyboards available with the network computers. Refer to 
Appendix B, Keyboards in the Reference Manual for information about the key 
codes (which are the numbers that appear below the keys in the following 
figures).

Figure A-1 101 with Pause North American Keyboard
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Keyboard Charts
Figure A-2 101 with Setup North American Keyboard

Figure A-3 102 with Pause United Kingdom Keyboard
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Figure A-4 102 with Setup United Kingdom Keyboard

Figure A-5 VT200/LK401–Style North American Keyboard
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ual.
Figure A-6 UNIX Keyboard

Figure A-7 3270 Keyboard

Note: For details about the 3270 keyboard, see the 3270/3179G User Man
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Figure A-8 Sun V Keyboard

Figure A-9 104/105 Windows95 Keyboard
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DP 
es 
Entering North American Special Characters from 
International Keyboards

Some data processing programs require entry of characters from the North 
American keyboard that are not available on all international keyboards. The
characters needed but not always available are: { } [ ] \ @ # * $ |

To permit entry of the full North American character set from all keyboards, 
some international keyboards have one or more keys with dual legends on the
Legends on the left of LK401/VT200 keyboards are typewriter legends and 
legends on the right are data processing (DP) legends. (Legends on the right of 
102-key keyboards are alternate graphic legends.)

You can enable DP legends for the LK401/VT200 keyboards from the Main 
Menu of Setup. The Main Menu displays a DP Mode item when you set 
Keyboard Type to VT200 and Language to one of the international language
When you need these special symbols, enable the DP keys by clicking DP 
Mode to On. Click this item to Off when you need the usual national characters 
of the keyboard. If you want to run TekXpress compose, load the compose 
sequences. For details, refer to the Compose and Diacritical Sequences section 
later in the manual.

If TekXpress compose is enabled, you can also access DP legends from the
keyboard (rather than through Setup) by using Compose sequences. To enter a
DP legend, press the Compose key and then the desired key. So that you ca
enter all ASCII characters, several keyboards have compose sequences for 
keys that do not have DP legends on the keycaps. These compose sequenc
appear in the tables that follow. For more information about Compose 
sequences, refer to Compose and Diacritical Sequences later in this appendix.

When DP mode is off, the two-key sequences for accessing DP characters 
(Tables A-1 through A-9) supersede the three-key compose sequences 
involving the Compose-DP keys.
8 Network Computer User



Entering North American Special Characters from International Keyboards

 

e 
s do 
Tables A-1 through A-9 summarize the DP characters that are sent for each
LK401/VT200-style international keyboard. These tables show both the 
Typewriter Mode and Data Processing Keys mode. As noted, some compos
sequences do not have DP legends. Keyboards not appearing in these table
not offer DP keys.

Table A-1  VT200/LK401 Danish Keyboard.

Mode

VT200
Key

State

DP Keys
Compose–DP 

Keys

§  @
3

Å  [
     ]

Ø  \ 
     #

*
’

(
8

)
9

Typewriter Normal 3 å ø | { }

Shft § Å Ø

Data Processing 
Keys

Normal 3 ] #

Shft @ [ \

LK401
Key 

State
§ @
~

£ #
3

Æ [
{

Å ]
     }

Ø \
|

*
’

(
8

)
9

Typewriter Normal ~ 3 æ å ø | { }

Shft § £ Æ Å Ø

Data Processing 
Keys 

Normal ~ 3 { } |

Shft @ # [ ] \
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Table A-2  VT200/LK401 French Keyboard.

Mode

VT200

Key
State

DP Keys
Compose–DP 

Keys

6
§  [

7
è  ]

%
ù \

@
#

9
ç

0
à

Typewriter Normal § è ù | { }

Shft 6 7 %

Data Processing 
Keys

Normal [ ] \

Shft 6 7 %

LK401
Key

State
6
§  [

7
è  ]

%
ù \

 2
è |

9
ç {

0
à }

@
#

9
ç

0
à

Typewriter Normal § è ù  2 9 0 | { à

Shft 6 7 %

Data Processing 
Keys

Normal [ ] \ è ç à

Shft 6 7 %  |  { }
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Entering North American Special Characters from International Keyboards
Table A-3  VT200 German Keyboard. 

Mode

VT200
Key

State

DP Keys
Compose–DP 

Keys

Ü  \
@ 

Ä  [
]

’
#

(
8

)
9

Typewriter Normal ü ä | { }

Shft Ü Ä

Data Processing 
Keys

Normal @ ]

Shft \ [

Table A-4 LK401 German Keyboard.

Key Cap

Typewriter
Data Processing 

Keys
Compose–DP  

Keys

Normal Shft Normal Shft

, # |

( 8 {

) 9 }

°
^ ¬

^ ° ¬ °  

! ¡
1 1

1 ! 1 ¡ 

"
2 2

2 " 2 "

§ £
3 3

3 § 3 £
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$ ¤ 
4 1/4

1/4 ¤

%      
5 1/2

% 1/2 %

&    
6 3/4

6 & 3/4 &

/   
7 {

7 / { /

( 
8 [

8 ( [ (

) ±

9 ]

9 ) ] ±

= °
O  }

O = } °

? ¿
 β \

β ? \ ¿

` 
´  ¸

´ `  ¸ ` 

Q
@

q Q @ Q

R 
¶

r  R ¶ 

Z ¥ z Z z ¦¥

O Ø o O Ø o

Table A-4 LK401 German Keyboard. (Continued)

Key Cap

Typewriter
Data Processing 

Keys
Compose–DP  

Keys

Normal Shft Normal Shft
12 Network Computer User



Entering North American Special Characters from International Keyboards
P  ρ p P p ρ

Ü ° ü Ü ¨ °

* –
+ 

+ * ~ –

A Æ a A æ Æ

S §   
 β

s S  β § 

D D
δ

d D δ D

F ª f F f ª

; X
,

, ; , X

K & k K k &

Ö
′ 

ö Ö ′ Ö

Ä
^

ä  Ä ^ Ä

´¦
# `

# ´ ` ´

>  
< 

< > 

Table A-4 LK401 German Keyboard. (Continued)

Key Cap

Typewriter
Data Processing 

Keys
Compose–DP  

Keys

Normal Shft Normal Shft
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Y <
y <<

y Y << <

X  >
x  >>

x X >> >

C 
 ¢

c C ¢ 

M º 
µ

m M µ º 

: ÷
. •

: • ÷

Table A-4 LK401 German Keyboard. (Continued)

Key Cap

Typewriter
Data Processing 

Keys
Compose–DP  

Keys

Normal Shft Normal Shft
14 Network Computer User



Entering North American Special Characters from International Keyboards
 

Table A-5  VT200/LK401 Italian Keyboard.

Mode

VT200
Key

State

DP Keys
Compose–DP 

Keys

1
£ @

2
é  #

9
ç  [

0
à  ]

§  \
*

%
ù

=
`

§
$

Typewriter Normal £ é ç à * | { }

Shft 1 2 9 0 §

Data 
Processing

Keys

Normal @ # [ ] *

Shft 1 2 9 0 \

LK401 Key
State

1
£ @

2
é  #

9
ç  [

0
à  ]

§  \
*

%
ù {

=
; }

!
ò |

%
ù

=
`

§
$

Typewriter Normal £ é ç à * ù ; ò | { }

Shft 1 2 9 0 § % = !

Data 
Processing

Keys

Normal @ # [ ] * { } |

Shft 1 2 9 0 \  %  = !
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Table A-6  VT200/LK401 Norwegian Keyboard.

Mode

VT200

Key
State

DP Keys
Compose–DP 

Keys

§ @
3

Å  [
     ]

Æ  \ 
     #

*
’

(
8

)
9

Typewriter Normal 3 å æ | { }

Shft § Å Æ

Data Processing 
Keys

Normal 3 ] #

Shft @ [ \

LK401
Key

State Å  ] 
}

Æ [ 
{

Ø \
|

*
’

(
8

)
9

Typewriter Normal å æ Ø | { }

Shft Å Æ Ø

Data Processing 
Keys

Normal } { |

Shft  ] [ \
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Entering North American Special Characters from International Keyboards
Table A-7  VT200/LK401 Spanish Keyboard.

Mode

        VT200
    Key
  State

DP Keys
Compose–DP

Keys

¡   \
¿ @

ª  [
º  ]

~
ç

(
8

)
9

Typewriter Normal ¿ º | { }

Shft ¡ ª 

Data Processing
Keys

Normal @ ]

Shft \ [ 

LK401
Key

State
¡   \
¿ @

ª  [
º  ]

Ñ }
 {

 ~
ç  |

~
ç

(
8

)
9

Typewriter Normal ¿ º ñ ç | { }

Shft ¡ ª Ñ ~

Data Processing
Keys

Normal @ ] { |

Shft \ [ } ç
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Table A-8  VT200/LK401 Swedish/Finnish Keyboard.

Mode

VT200
   Key
 State

                                           DP Keys Compose–DP Keys

§  @
3

¤  $
4

Å  [
]

Ü  \
#

Ä
(
8

)
9

Typewriter Normal 3 4 å ü { }

Shft § ¤ Å Ü |

Data 
Processing

Keys

Normal 3 4 ] # 

Shft @ $ [ \

LK401
Key

State
§  @
3

$
4

Å  [
]

Ü  \
#

Ö {
  }

Ä |
Ä

(
8

)
9

Typewriter Normal 3 4 å ü Ö ä { }

Shft § $ Å Ü Ö Ä |

Data 
Processing

Keys

Normal 3 4 ] # } ä

Shft @ $ [ \ { |
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Entering North American Special Characters from International Keyboards
Table A-9  VT200/LK401 Swiss/German Keyboard.

Mode

 VT200
    Key
   State

                              DP Keys
Compose–DP
Keys

ç @
4

è  \
ü

é  [
ö

à  ]
ä

£  #
$ 

£  #
$

(
8

)
9

Typewriter
 

Normal 4 ü ö ä $ | { }

Shift ç è é à £

Data Processing
Keys

Normal 4 ü ö ä $ 

Shift @ \ [ ]

LK401
Key

State
ç @
4

è  \
ü |

é  [
ö {

à ]
ä }

£  #
$ 

£  #
$

(
8

)
9

Typewriter Normal 4 ü ö ä $ | { }

Shift ç è é à £

Data Processing
Keys

Normal 4 | { } $

Shift @ \ [ ] #

Table A-10  VT200/LK401 United Kingdom Keyboard.

Mode
Key

State

DP Key

£  #
3

Typewriter Normal 3

Shft £

Data Processing 
Keys

Normal 3

Shft #
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Eurokey Support

NCBridge 3.2, or higher, supports the EuroSign keysym for the various 
keyboard types listed in Table A-11. The EuroSign keysym value is 0x20AC

Compose and Diacritical Sequences 
On LK401/VT200-style keyboards you can use compose characters to type 
special characters and symbols that are not available as single keystrokes. 
These might be common characters, such as the cent sign (¢), or letter form
particular to a certain language, for example, a lowercase “e” with an acute 
accent.

Table A-11 EuroSign Character Support

Keyboard Country Keystroke

102 Setup & 102 Pause,
including support for
Windows95 keyboards

Danish
French
Finnish
German
Italian
Norwegian
Spanish
Swedish
Swiss-German
United Kingdom

AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+E
AltGr+4

3270 French
German
United Kingdom

AltGr+E
AltGr+E
AltGr+4

Sun V French
German
United Kingdom

AltGr+E
AltGr+E
AltGr+4
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Compose and Diacritical Sequences

. 
Network computers directly support compose characters for all X11 clients 
with LK401/VT200 keyboards, other than North American. DEC VMS and 
ULTRIX X applications provide their own compose characters. Refer to your 
DECWindows documentation for information about DEC compose characters

To use DEC compose characters: 

2. Select Setup from the Client Launcher. Select either VT200/LK401 
ULTRIX (ESC) or VT200/LK401 VMS (F11) as the Keyboard Type.

3. Set the Compose Sequences option to No.

4. Use a DEC VMS or ULTRIX X application. 

5. Begin a compose sequence by pressing the Compose key. 

Launcher
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s 
To use TekXpress compose characters:

1. Select Setup from the Client Launcher.

2. Select VT200/LK401 X (ESC-BS-LF) or VT200/LK401 X (F11-F13) as the 
Keyboard Type.

3. Set the Compose Sequences option to Yes. 

4. Select a Keyboard Nationality. (To use North American, use xmodmap to
clear the modifier by entering this command: xmodmap –e "clear mod1")

You can compose TekXpress compose characters in two ways: 

• Press a diacritical key (described under Using the Diacritical Keys later in 
this appendix), and then the character to be combined with it (valid 
combinations are shown in Table A-12 on page A-23).

• Press the Compose key (described under Using the Compose Key later in this 
appendix), and then type the two composing characters (valid combination
are shown in Table A-13 on page A-26).

Note: To enter a special character, your application must support 
8-bit characters and select fonts. If you cannot enter special 
characters, contact your system administrator.

Launcher
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en 
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the 

 

ute 
Using the Diacritical Keys

There are from one to five diacritical keys on all international VT200-style 
keyboards (except North American). These keys do not send characters wh
you press them; rather, they combine with the next character you type to for
a special symbol. 

For example, on keyboards for which tilde (~) is a diacritical mark, you 
compose the ñ Spanish character by pressing the “~” key and then pressing 
“n” key. 

To cancel a diacritical key sequence: 

• Press the Delete key, or 

• Press another diacritical key (if you want to start a new sequence). 

If you type an invalid sequence: the entry is ignored, the bell on the network
computer rings, and the diacritical sequence terminates. 

The Compose light turns OFF when you complete the compose sequence.

The acute accent (´) character is a special case: on the keyboard, it shares its 
visual representation with the apostrophe (’). Depending on the keyboard 
nationality, the keyboard character on the network computer represents an ac
accent (a diacritical mark) or an apostrophe (a character).

Table A-12 shows the diacritical keys available on various keyboards.

Table A-12  Diacritical Keys.

Keyboard Diacritical Keys

Danish/Norwegiana ` ´ ˆ ¨

French ˜ ` ˆ ¨

Germana ˜ ` ´ ˆ

Italian ˜ ` ˆ

North American none

Spanishb ˜ ` ´ ˆ ¨

Swedish ˜ ` ˆ
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a
Two single-quote symbols appear on the keyboard. The one on the top row of 
keys is a diacritical mark and can be thought of as an acute accent (´). The other 
one is not a diacritical mark and can be thought of as an apostrophe (’). 

b
Two single-quote symbols appear on the keyboard. The one on the top row of keys is not a 
diacritical mark and can be thought of as an apostrophe (’). The other one, next to the ñ key, is 
the diacritical mark.

Swiss–German ˜ ` ˆ ¨

United Kingdom `

Table A-12  Diacritical Keys. (Continued)

Keyboard Diacritical Keys
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Variations from DEC Compose Sequences 

The following differences exist between the NCD network computer and the 
DEC VT200 compose sequences: 

• The sequence that generates a double quote on the VT200 generates an
umlaut on the NCD network computer. 

• There is no difference on the VT200 between an apostrophe and an acute
accent. Depending on keyboard nationality, you can treat the acute accent
the keyboard as a diacritical mark (an acute accent). You can access the 
apostrophe symbol on the keyboard through a compose sequence. 

• The NCD network computer provides compose sequences for dollar sign,
small and capital Icelandic eth, small and capital Icelandic thorn, small an
capital y with an acute accent, three-fourths fraction, division sign, 
multiplication sign, acute accent, umlaut, overbar, cedilla, registered sign, 
broken vertical bar, not sign, no-break space, and soft hyphen.

• You access TekXpress and DEC three-key compose characters by pressing 
Compose, rather than holding the Compose key and pressing the spaceba
described for DEC workstations.

• DEC compose sequences do not have the "Compose-DP" sequence.
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t 
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Using the Compose Key

The Compose key starts a three-key compose sequence for all LK401/
VT200-style international keyboards (except North American). For example, t
compose a cent sign, press the Compose key followed by the “c” and “|” key
When you press the Compose key, the Compose light turns ON to indicate th
you are composing a special character. 

To cancel a compose sequence: 

• Press the Delete key, or 

• Press the Compose key (if you want to start a new sequence). 

If you type an invalid sequence: the entry is ignored, the bell on the network
computer rings, and the compose sequence terminates. 

The Compose light turns OFF when you complete the compose sequence.

Compose Sequences

Table A-13 lists all the compose characters and the two- or three-key sequenc
used to form the characters. You can enter the last two keys of three-key 
sequences in any order. The notes in the table refer to:

aTo compose a character with a three-key sequence, press Compose Chara
followed by the two keys shown in this column.

bTwo-key compose sequences are only available on national keyboards tha
support the requisite diacritical marks. 

c You can use either two apostrophes (’ ’ – available on all keyboards) or tw
acute accents (´ ´ – available only on the German, Danish/Norwegian, and
Spanish keyboards) to compose an acute accent.

Table A-13  Compose Sequences for VT200-Style Keyboards.

Symbol Description

Compose Sequence

Three-Key a
Two-Key b

[ Left bracket ( (
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Using the Compose Key
\ Backslash / /

/ <

] Right bracket ) )

{ Left brace ( –

| Vertical bar ^ / ^ /

} Right brace ) –

# Pound sign + +

ˆ Circumflex ^  SP ^ SP

^ ^ ^ ^

˜ Tilde ~  SP ~ SP

~ ~ ~ ~

@ Commercial At sign A A

a a

$ Dollar sign S /

s /

S |

s |

á Apostrophe ’  SP

´  SP ´  
SP

á Small a with acute accent ´ a ´ a

Á Capital A with acute accent ´ A ´ A

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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à Small a with grave accent ` a ` a

À Capital A with grave accent ` A ` A

â Small a with circumflex ^ a ^ a

Â Capital A with circumflex ^ A ^ A

ä Small a with umlaut a "

¨ a ¨ a

Ä Capital A with umlaut A "

¨ A ¨ A

ã Small a with tilde ~ a ~ a

Ã Capital A with tilde ~ A ~ A

å
 

Small a with ring a *

× ° a

Å Capital A with ring A *

×° A

æ Small ae ligature a e

Æ Capital AE ligature A E

ç Small c with cedilla c ,

Ç Capital C with cedilla C ,

 D Capital Icelandic Eth D –

Small Icelandic eth d –

é Small e with acute accent ´ e ´ e

É Capital E with acute accent ´ E ´ E

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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Using the Compose Key
è Small e with grave accent ` e ` e

È Capital E with grave accent ` E ` E

ê Small e with circumflex ^ e ^ e

Ê Capital E with circumflex ^ E ^ E

í Small i with acute accent ´ i ´ i

Í Capital I with acute accent ´ I ´ I

ì Small i with grave accent ` i ` i

Ì Capital I with grave accent ` I ` I

î Small i with circumflex ^ i ^ i

Î Capital I with circumflex ^ I ^ I

ï Small i with diaeresis i "

¨ i ¨ i

Ï Capital I with diaeresis I "

¨ I ¨ I

ñ Small n with tilde ~ n ~ n

Ñ Capital N with tilde ~ N ~ N

ó Small o with acute accent ´ o ´ o

Ó Capital O with acute accent ´ O ´ O

ò Small o with grave accent ` o ` o

Ò Capital O with grave accent ` O ` O

ô Small o with circumflex ^ o ^ o

Ô Capital O with circumflex ^ O ^ O

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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ö Small o with umlaut o "

¨ o ¨ o

Ö Capital O with umlaut O "

¨ O ¨ O

õ Small o with tilde ~ o ~ o

Õ Capital O with tilde ~ O ~ O

ø Small o with slash o /

Ø Capital O with slash O /

ß Small German sharp s s s

p Small Icelandic thorn p p

P Capital Icelandic Thorn P P

ú Small u with acute accent ´ u ´ u

Ú Capital U with acute accent ´ U ´ U

ù Small u with grave accent ` u ` u

Ù Capital U with grave accent ` U ` U

û Small u with circumflex ^ u ^ u

Û Capital U with circumflex ^ U ^ U

ü Small u with umlaut u "

¨ u ¨ u

Ü Capital U with umlaut U "

¨ U ¨ U

´y Small y with acute accent ´ y ´ y

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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Using the Compose Key
´Y Capital Y with acute accent ´ Y ´ Y

ÿ Small y with diaeresis y "

¨ y ¨ y

No-break space SP SP

1/4 Fraction one-fourth 1 4

1/2 Fraction one-half 1 2

3/4 Fraction three-fourths 3 4

1 Superscript 1 ^ 1 ^ 1

2 Superscript 2 ^ 2 ^ 2

3 Superscript 3 ^ 3 ^ 3

± Plus-or-minus sign + –

÷ Division sign – :

× Multiplication sign X X

x x

¤ Currency sign X 0

X O

x 0

x o

£ Pounds currency sign L –

L =

l –

l =

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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A-
¢ Cent sign C /

C |

c /

c |

¥ Yen sign Y –

Y =

y –

y =

´ Acute accentc ’  ’   

´ ´  ´ ´  

` Grave accent ` SP ` SP

` ` ` `

¨ Diaeresis or umlaut " SP

"  "  

¨ SP ¨ SP

¨  ¨ ¨  ¨ 

— Macron or overbar _ _

¸ Cedilla , ,

– Soft hyphen – -

µ Small mu or micro sign / U

/ u

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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Using the Compose Key
° Degree sign ^ 0 ^ 0

SP *

SP °

º Masculine ordinal indicator O _

o _

 ª Feminine ordinal indicator A _

a _

§ Section sign S 0

s 0

S O

s o

¶ Paragraph or pilcrow P !

p !

⋅ Centered dot ^ . ^ .

 Copyright sign C 0

c 0

C O

c o

 Registered sign R 0

r 0

R O

r 0

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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A-
¡ Inverted exclamation mark ! !

¿ Inverted question mark ? ?

« Angle quotation mark left < <

» Angle quotation mark right > >

| Broken vertical bar ! =

¬ Not sign – !

Table A-13  Compose Sequences for VT200-Style Keyboards. (Continued)

Symbol Description

Compose Sequence

Three-Key a
Two-Key b
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Active Window
The window where the input (focus) is directed.

Application Program
Programs such as word processors, transaction processors, and compute
aided drafting, that you run on your network computer. Also know as client
See Client.

Button (on the display)
A small display box that has a raised appearance and contains text. Generally, 
clicking on a button activates a function or performs some action. See 
Clicking.

Button (on the mouse)
The three buttons on the top of the mouse. See Select, Menu, and Custom.

Clicking
Quickly pressing and releasing the Select mouse button without moving th
pointer.

Client
An application program that connects to the server. A client program 
performs a variety of tasks, including window management.

Chroma
A term that describes the saturation or vividness of a color. A chroma of 0
describes a neutral, gray color. Chroma ranges to the most vivid color a 
screen or printer generates for a specific hue and value. See Hue and Value.

Colormap
Consists of a set of entries defining color values. A pixel value indexes into
the colormap thereby producing intensities of red, green, and blue which a
visible on a display.
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Command Line
The line that you type to invoke a program or initiate an action. A command
line usually contains the name of an X client or application program, along
with optional arguments known as command-line options.

Cterm
A user-level protocol which is part of the DECnet Protocol set. Cterm 
provides a Network Virtual Terminal, which allows you to log in to a remote
host on the network as if you are using a terminal directly attached to the 
remote host.

Custom (mouse button)
The factory default defines this as the right mouse button.

Cursor
The visible shape of a pointer on the screen. Defining a cursor for a windo
controls the visible appearance when the pointer is in that window. See 
Pointer.

DAP
See Data Access Protocol.

Data Access Protocol (DAP)
A protocol that provides read and write support for font files, the color 
definition file, or remote configuration files.

Dialog Box
A box where you choose options and enter information. Use the mouse to
move from field to field, click on buttons and position the text cursor. Enter
information with the keyboard.

Display
A device that receives video output from the logic module and displays th
video output on a screen.

Dragging
Pressing and holding down the Select mouse button while moving the 
pointer.
ossary-2 Network Computer User
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Ethernet
An IEEE standard protocol used within various networks, including TCP/IP

Ethernet Address
The factory-defined hardware address of the network computer. Network 
hardware uses the Ethernet address when communicating to the network
This address is on the serial number label on the back of the logic module
You can also display the Ethernet address by viewing the TCP/IP 
Configuration Summary Menu in Setup.

Event
In the X Window System, information sent by the X server to an X client —
for example, notification to the client that you pressed a mouse button.

Factory Default
The value assigned to a parameter as delivered from the factory.

Firmware
Software instructions that are permanently stored in the memory of a 
computer and are not lost when you turn the power off. Also called NVRAM

Hardcopy
A physical copy (typically printed on paper) of a file.

Hardware
The physical parts of a computing device, such as a network computer.

Host Computer
A computer device that controls the exchange of data between itself and 
another network computer. Network computers typically boot from a host.

Hue
A term that describes a color family (for example, red or yellow). Hue is a 
polar coordinate — that is, it moves in a circular motion around the color 
spectrum — and ranges from 0° to 360°, with 0° being red. Hue is measured 
in degrees. See Chroma and Value.
Network Computer User Glossary-3



Glossary

Gl

 

d 

rm 

y 

l 
Index Area
A box on the screen that lets you enter a color index — an integer used to
label a particular color — from the keyboard.

Input Device
A device that allows you to send information to a window. Typical input 
devices include keyboards, mice, tablets, and trackballs. See Pointer and 
Pointing Device.

Interface
A common connection that is used for sending or accepting information an
control between programs and machines.

Internet Address (IP Address)
A system administrator-assigned address for the network computer. This 
address is used under TCP/IP when the network software of the network 
computer generates messages to another host. The IP address is in the fo
nnn.nnn.nnn.nnn where nnn is a decimal number in the range 0 to 255. You 
can display the IP address by viewing the Network Configuration Summar
Menu in Setup.

Internet Protocol (IP)
The network layer protocol for the Internet Protocol Suite. Internet Protoco
is responsible for addressing and routing packets between hosts.

Keyboard
An input device that allows you to communicate with your client program. 

LAN
See Local Area Network.

LAT
See Local Area Transport

Local Area Network (LAN)
The linking together of terminals, network computers, and computers via 
cables and microwave links. This allows you to access more than one 
computer.
ossary-4 Network Computer User
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Local Area Transport (LAT)
A client which provides a connection to a host computer that supports LAT

Local Clients
Programs running on the same host as the server.

Logic Module
A device that gets data from a host, a keyboard, or a peripheral, and 
processes it for viewing on the display. The logic module runs the X serve
and local clients. It can be a separate unit, or integrated into the base of th
monitor.

Memory
A part of a network computer that stores data.

Menu
A list of commands or functions that you select with a pointer. A menu is 
normally displayed in a small window.

Menu (mouse button)
The factory default defines this as the middle mouse button.

Move
Change the location of the pointer on the screen by moving the mouse.

Mouse
An input device that, when moved across a flat surface, causes the pointer
move across a screen. The mouse usually has buttons that you press to s
signals. These signals, in turn, accomplish certain functions. The 
representation of the mouse on the screen is called the pointer. See Pointer.

Network
The physical wires connecting two or more computers. These connection
allow information to move electronically between computers.
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Network Computer
A computer that displays information which usually resides on another 
computer. A network computer consists of a display, a keyboard, a mouse 
other pointing device, a logic module, an X server, and local clients. See 
Display, Logic Module, Mouse, Pointer, and X Server.

Parameter
A variable that is given a specific value. This value is passed to a program
before execution.

Peripheral Device
A device used to input or output data for the network computer. The XPT/A
graphics tablet is a supported peripheral device for network computers.

Pixel
The smallest part of a screen surface that can be addressed.

Pointer
The pointer allows you to make selections in menus, to size and position 
windows and icons, and to select the window where you want to send the
input. The window manager determines the shape of the pointer. See 
Pointing Device.

Pointing Device
Typically a mouse, tablet, or some other device with effective dimensiona
motion. The core protocol defines only one visible cursor, which tracks 
whatever pointing device is attached as the pointer. See Pointer.

Port
A physical connection (such as a multi-pin connector or coaxial connector
and its associated firmware, that permits one computing device to 
communicate data and control information with another computing device o
peripheral device.

Protocol
A set of rules that allows computers to transfer information across a network 
to other computers that speak different computer languages.
ossary-6 Network Computer User
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Read-Only Memory (ROM)
Special firmware in the network computer that allows it to boot without 
being connected to a host computer.

RGB
An additive method of combining percentages of red, green, and blue 
primary colors to form other colors.

ROM
See Read-Only Memory.

Root Weave
The window that fills the screen during an X session. All windows opened
by clients appear on top of the root window. See Stipple Pattern.

RS-232-C
A standard communications interface defined by the Electronic Industries 
Association (EIA) to control data communications using standard voltages
signal lines, and device interactions.

Screen
The monitor. This is where text and graphical information is displayed for 
viewing. See Window.

Select (mouse button)
The factory default defines this as the left mouse button.

Setup Key
A special key on the keyboard, marked Setup. Pressing this key takes you
the Setup program.

Serial Port
One or more optional physical connectors on your network computer. Attac
a serial cable (RS 232) to communicate with a peripheral device such as 
modem or printer.
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Serial Port Session
A session started through one of the serial ports: either Serial Port 0 or Ser
Port 1.

Serial Xpress (SXp)
A serial protocol used for fast serial communications between a host 
computer and a network computer. Can be used with or without a modem

Server
The combination of graphics display, hardware, and server software that 
provides display services for clients. The server also handles keyboard an
mouse input. See Client and X Server.

Setup
A local X client program used to configure the network computer.

Software
A set of instructions that tell the computer to perform a certain task in orde
to obtain a specific result. See Client.

Stipple Pattern
In the X Window System, the underlying pattern displayed (with the X 
cursor) when there are no other windows on the screen. If a window is 
created, the window appears on top of the stipple pattern. See Root Window.

SXp
See Serial Xpress.

TCP
See Transmission Control Protocol.

TCP/IP
See Transmission Control Protocol/Internet Protocol.
ossary-8 Network Computer User
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Telnet
A user-level protocol which is part of the Internet Protocol set. Telnet 
provides a Network Virtual Terminal, which allows you to log in to a remote
host on the network as if you are using a terminal directly attached to the 
remote host.

TekHostMenu
A window showing a list of host computer names and network addresses.
Use the mouse to select a computer where you have a login account.

Terminal
An interactive input/output device used in computer systems or networks.

Text Cursor
The I-shaped pointer which appears in a text input area. Clicking the mous
in a text input area causes the text cursor to appear in that area. Whateve
information you type on the keyboard appears in the text input area 
displaying the text cursor.

TFTP
See Trivial File Transfer Protocol.

Transmission Control Protocol (TCP)
The Internet transport layer protocol which provides a reliable, bi-directiona
byte stream connection between two cooperating user-level processes.

Transmission Control Protocol/Internet Protocol (TCP/IP)
Using the TCP and IP protocols to obtain a reliable, bi-directional byte 
stream connection between two cooperating user-level processes. 
Commonly this refers to the entire Internet Protocol suite, including TCP, IP, 
UDP, ICMP, and other protocols.

Trivial File Transfer Protocol (TFTP)
A protocol used for downloading server images. It is also used for reading 
and writing font files, the color definition file, or remote configuration files.

UNIX
A host operating system.
Network Computer User Glossary-9
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Value
A term describing the lightness or darkness of a color. Value ranges from 
(black) to 100 (white). See Chroma and Hue.

WinDD
A local ICA client that allows you to access Windows NT applications using
your network computer with Microsoft’s Windows NT Terminal Server 
Edition and Citrix Metaframe server software.

Window
In the X Window System, typically a region on the screen of a display 
created by an X client for displaying data. (An X client can create more than 
one window.) For example, the xterm terminal emulator, xfd font displayer, 
and the bitmap graphics editor all create windows. You can use a window
manager to manipulate windows on the screen. See Window Manager.

Window Manager
An X client that allows you to organize and rearrange windows. The window
manager controls the size and placement of windows and can also contro
window attributes such as border size.

Xhost
A host X program that controls access to the server from the host program

X Server
A program that runs locally on a network computer and lets you use the 
screen of the network computer. The X server processes a request (for 
example, a request to create a window), collects input data, and sends 
information (called an event) to clients. See Event.

Xterm
An X client that emulates an ANSI-style terminal for programs that do not 
use the capabilities of windows directly.

X Window System
A set of network protocols developed by MIT for workstations; also called X
or X11.
ossary-10 Network Computer User
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Acrobat Reader

converting PDF to PostScript 4-74
Adjusting

keyboard vii
monitor vii

Analog Video Player 4-42
Audio file information 4-22
Audio Mixer 4-23

saving level settings 4-25
starting 4-23

Audio Player 4-2
Audio Accessories 4-18
audio file information 4-22
DAP access 4-14
External Devices 4-17
file types 4-2
NFS access 4-11
opening and creating a file 4-8
playing an audio file 4-21
recording an audio file 4-19
starting 4-3
tftp access 4-9

B
Boot process 2-2

C
Client Launcher 2-5
color hardcopy printing 4-77
Communication port vii
compose key on VT200 keyboard A-26
Console window 5-3
Cterm 2-13

D
deiconifying a window 3-10
diacritical keys on VT200 keyboard A-23

Digital Video Player 4-26
DAP access 4-34
Multicast 4-38
NFS access 4-32
opening a video file 4-30
playing a video file 4-36
starting 4-27
tftp access 4-31

DP mode keys A-1

F
Flash Control Console 4-79

Before Using 4-80
Starting 4-80

File Bar 4-81
Menu Bar 4-82
Menu Input Area 4-82

Flash Screen 4-85
Font caching 4-76

G
graphs 3-2

H
hardcopy 4-77
HostMenu 2-6

I
icon, moving 3-11
iconifying a window 3-10

K
Keyboard vii
keyboards

compose key A-26
compose sequences A-26
diacritical keys A-23
North American special characters A-8
special characters and symbols A-20
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LAT 2-22
listnx 4-75
locking a window 3-14
Logging in

Cterm 2-13, 2-15
HostMenu 2-6
LAT 2-22
login prompt 2-9
methods 2-3
root weave 2-4
Serial Port 2-19
Telnet 2-11
WinDD 2-15

Logic board vii
Logic module vii
Login prompt 2-9
lowering a window 3-9

M
Manual

conventions v
mouse terminology v
related documentation viii

maximizing a window 3-9
Memory 4-76
Monitor vii
Mouse vii
Mouse buttons v
moving

icons 3-11
windows 3-7

MPEG video file format 4-36
Multicast 4-38

Channels 4-38

N
Network computer

boot process 2-2
memory 4-76
package vii
software vii

P
pictures 3-2
Power switch locations 2-1
printing

color hardcopies 4-77
from the command line 4-78
from the MWM pop-up menu item 4-77
hardcopy of a window 4-77
hardcopy of the screen 4-77

PSXpress 4-69
documentation location 4-75
execution path 4-69
launching Acrobat Reader 4-72
launching applications 4-71
PATH variable 4-69
PostScript resources 4-70
preferences file 4-72
printing with Acrobat Reader 4-74
using Answerbook 4-70
using with other applications 4-75
X resources 4-70

R
raising a window 3-8
Rebooting the Network Computer 3-3
Resetting

Network Computer 3-3
X server 3-3

resizing a window 3-7
Root weave 2-4

S
Serial

communications 2-20
parameters 2-20
port session 2-19
Serial Xpress (SXp) 2-21

Serial Xpress 2-21
server 3-2
Setup key v, 2-4, 2-20, 3-3, 3-5, 3-12
SXp 2-21
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WinDD

about 4-61
configuring 4-65
help menu 4-68
local client 4-61
local client Options menu 4-67
log in 2-15
log in screen 2-17
logoff 2-18
selecting a server 2-16, 4-67
starting with xp.cnf 4-61
starting with xpsh 4-62

window
deiconifying 3-10
iconifying 3-10
lowering 3-9
maximizing 3-9
moving 3-7
raising 3-8
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Window managers 3-4
Windows 3-6

X
X server

see server 3-2
XIE Viewer 4-50

DAP access 4-58
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starting 4-51
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